
1 
 

 

 

 

BrailleSense 

Polaris MINI 

User Manual 
 

ENGLISH MANUAL 

 for Software Version 1.0 

 

 

 

SELVAS Healthcare, Inc. 
 

155, Sinseong-ro, Yuseong-gu, 

Daejeon, Korea 34109 

Phone: +82-42-879-3000 

Fax: +82-42-864-4462 

Email: hims@himsintl.com 

Website: www.himsintl.com 

 

 

mailto:hims@himsintl.com
http://www.himsintl.com/


2 
 

Safety Precautions 
 

For your safety and protection of the BrailleSense Polaris MINI, please 

read and abide by the following safety precautions. 

1.The input voltage of the AC adapter is 100V - 240V, and the output is 

DC 5V / 2A. 

2.When the BrailleSense Polaris MINI is shipped, the battery may be 

packaged separate from the unit to avoid damage. When you use the 

BrailleSense Polaris MINI for the first time, you may need to open the 

package, remove the battery, and insert it into the battery slot at the 

underside of the unit. (See section 1, introduction, for more details on 

inserting the battery.) It is possible that the dealer or distributor from 

whom you purchased the BrailleSense Polaris MINI has already done 

this for you. The battery may not be fully charged when it is shipped. 

Before you use the BrailleSense Polaris MINI, you should ensure the 

battery is fully charged.  

3.When you use the BrailleSense Polaris MINI with the battery for the first 

time, the battery status may not be displayed accurately. To avoid this, 

leave the BrailleSense Polaris MINI connected to the AC adapter for 

about four hours with the unit turned on. If you want to use the 

BrailleSense Polaris MINI immediately, you may use it while it is 

charging. 

4.If you want or need to remove the battery from the unit, power the unit 

off, and then remove the battery. If the unit is connected to AC power, 

before re-inserting the battery in to the unit, make certain that the 

power is off. 

There is a risk of explosion if the battery is replaced by an incorrect 

type. Please make certain to use only battery packs produced 

specifically for the BrailleSense Polaris MINI by SELVAS Healthcare. 

Please dispose of used batteries according to the instructions. 

5.If the usage time is less than 50% as compared to the stated battery 

run time in the product specifications, even after a full charge, it is 

recommended that you replace the battery. 

6.It is recommended to remove and store the battery separate from the 

product during long periods of disuse. 
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7.If you drill into or disassemble the product or battery using a sharp point, 

it may cause electric shock, explosion or fire. 

8.When you are using the BrailleSense Polaris MINI on battery power, 

the status of the remaining battery power is announced when the 

battery charge is low. When the battery’s charge falls below 15 percent, 

connect the AC adapter to the unit for recharging. If the remaining 

battery charge drops to five percent, and the unit is not connected to 

the AC adapter, the BrailleSense Polaris MINI goes in to Sleep mode 

one minute after the announcement of the battery’s status. At 2%, the 

unit shuts down to preserve settings, etc. The amount of battery life 

per charge varies depending on the options you have set and the 

number and type of tasks you are running. 

9.Your BrailleSense Polaris MINI needs to be handled with care. The 

BrailleSense Polaris MINI is a very delicate machine. Please handle 

the unit in a proper, careful manner. The BrailleSense Polaris MINI is 

very sensitive to dust. Make sure to keep it away from dusty 

environments. 

10.The Braille cells are very sensitive, intricate parts. If the Braille cells 

are not working properly due to the presence of dust or for any other 

reason, please contact our repair center, or the dealer from whom you 

purchased the BrailleSense Polaris MINI for support. 

11.You should register your BrailleSense Polaris MINI in order to ensure 

further maintenance, service, and upgrade information. In the US, 

please visit www.hims-inc.com, to register your information. If you 

have any trouble when registering your information, please contact the 

dealer from whom you purchased your BrailleSense Polaris MINI for 

help. International customers should contact their regional dealer for 

information about product registration. 

12.Do not disassemble the BrailleSense Polaris MINI yourself. Do not 

have anyone else who is not authorized by HIMS take apart the 

BrailleSense Polaris MINI. If an unqualified person disassembles the 

unit, serious damage may occur. If an unauthorized person 

disassembles the unit, it is excluded from any free maintenance, and 

the warranty becomes void. If any liquid or external force damages the 

unit, it may also be excluded from free maintenance, even if the 

damage occurs during the warranty period. The BrailleSense Polaris 
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MINI contains a Liquid Contact Indicator sticker that will change color 

if the unit comes in contact with water or other liquids. This indicator 

will not activate under humid or other conditions that fall within the 

product’s normal environmental requirements.  

13.Do not leave your BrailleSense Polaris MINI in closed, high 

temperature environments such as inside a car on a hot summer day, 

as the battery may be damaged or catch fire. Please do 

not let your BrailleSense Polaris MINI remain in such 

environments for long periods of time.  

14.To prevent possible damage to your hearing, do not 

listen to audio at high volume levels for long periods. 

15.This equipment has been tested and found to comply with the limits 

for a Class B digital device, pursuant to part 15 of the FCC Rules. 

These limits are designed to provide reasonable protection against 

harmful interference in a residential installation. 

Operation is subject to the following two conditions. 

1)This device may not cause harmful interference, and 

2)This device must accept any interference received, including 

interference that may cause undesired operation. 

This equipment can generate, use and radiate radio frequency energy 

and, if not installed and used in accordance with the instructions, may 

cause harmful interference to radio communications. However, there 

is no guarantee that interference will not occur in a particular 

installation.  

If this equipment does cause harmful interference to radio or television 

reception, which can be determined by turning the equipment off and 

on, the user is encouraged to try to correct the interference by one or 

more of the following measures: 

- Reorient or relocate the receiving antenna. 

- Increase the separation between the equipment and receiver. 

- Connect the equipment into an outlet on a circuit different from that 

to which the receiver is connected. 

- Consult the dealer or an experienced radio/TV technician for help. 

 

IMPORTANT NOTE: 

FCC RF Radiation Exposure Statement: 
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This equipment complies with FCC RF radiation exposure limits set 

forth for an uncontrolled environment. This transmitter must not be co-

located or operating in conjunction with any other antenna or 

transmitter. Changes or modifications not expressly approved by 

SELVAS Healthcare may void your authority to operate the equipment  
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Congratulations on the purchase of your BrailleSense Polaris MINI! The 

BrailleSense Polaris MINI is capable of doing everything that an ordinary 

tablet can do, and more – all without the need for a screen!  
 

I. Your BrailleSense Polaris MINI packing box should 

contain the following items: 

1) BrailleSense Polaris MINI 

2) Battery 

3) Carrying Case 

4) AC adapter 

5) USB C Cable  

6) Earbuds 

7) Braille Commands Summary 

 

II. How to use this manual 
In this manual you will see references to hot keys and shortcut keys. 

These keys refer to ways to access menus and functions quickly by using 

a combination of keystrokes. Please note that not all hot keys and shortcut 

keys will work from every location on the BrailleSense Polaris MINI. Some 

hot keys and shortcut keys are program specific, thus, they require that 

you be within a specific program for them to work. 

Shortcut keys refer to keystrokes used to quickly activate a function from 

within a menu. Hot keys refer to keys that will activate a function 

regardless of where you are within the program. When functions are 

described in this manual, shortcut keys are shown in parentheses, and 

hot keys are shown in quotes. 

This user manual notes how to press hot keys and shortcut keys in the 

following manner: Keys that are to be pressed at the same time are 

separated by a - (dash). When you see “Space-b (dots 1-2),” this means 

that you should press “Space” and dots 1 and 2 simultaneously. 

If you are unable to find a solution to a problem within the manual, or if 

you need assistance with the BrailleSense Polaris MINI, please email us 

at support@himsintl.com. You may also visit us on the web at 

www.himsintl.com; or, you can call us at +82 42 864 4460. 

mailto:support@himsintl.com
http://www.himsintl.com/
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1. Introduction 

1.1 What is the BrailleSense Polaris MINI? 

The BrailleSense Polaris MINI is a Braille note taker developed and manufactured 

by HIMS, for people who are blind and visually impaired. The BrailleSense Polaris 

MINI has a variety of powerful capabilities, including the following. 

1. Read TXT, BRF, RTF, PDF, EPUB, and Microsoft Word, Excel and PowerPoint 

files. Take notes or create formatted documents and e-mails. 

2. Play media, DAISY books, and FM Radio and YouTube videos. 

3. Organize your Appointments and contacts, and synchronize them with your 

Google account.  

4. Perform scientific calculations, set alarms and explore the Lunar and solar 

calendars. 

5. Use the BrailleSense Polaris MINI as a USB or Bluetooth Braille display with a 

compatible screen reader, such as JAWS, NVDA, SuperNova, System Access, 

VoiceOver for Mac and iOS and TalkBack for Android. 

6. Use the built-in GPS sensor and digital compass to navigate independently 

without the need for external devices.  

7. Download and install 3rd party applications from the Google Play Store. 

8. Utilize Google Services such as Drive, Docs, Sheets, Slides, and Classroom 

via our included screen reader, specially customized for these applications. 

9. Obtain information and perform functions using your voice with the included 

Google Assistant, or third party voice assistants like Amazon Alexa. 
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1.2 Hardware 

To get the most from your BrailleSense Polaris MINI, it is important to become 

oriented to the buttons and ports as well as learning their functions. This section 

will orient you to your Polaris MINI. 

Place the Polaris MINI on a desk or table top with the Braille display nearest you.  

 

1.2.1 The Top Panel 

On the top face of the BrailleSense Polaris MINI is located a 9 key Perkins-style 

keyboard, consisting of Braille dots 1:6, "SPACE", "BACKSPACE", and "ENTER".  

On the same row as the Space bar are Control and Alt, as well as 4 rectangular 

function keys. Moving from left to right, the row contains F1, F2, Control, Space, 

Alt, F3 and F4. 

Below the keyboard is a 20 cell Braille display. Above the Braille display, there 

are cursor routing buttons corresponding to each of the 20 Braille cells. When you 

are editing documents, you can use these keys to route your cursor to the 

character of the corresponding Braille cell. The cursor routing keys also serve as 

shortcut keys for navigating lists and groups of fields in certain places on the unit. 

A dot is placed on each 5th cursor routing button for easier orientation.  

On each side of the Braille display are two capsule shaped keys. These are the 

"UP" and "DOWN" scroll keys. The scroll keys are used to scroll the Braille display 

through menus, fields, lists or text. You can use the scroll keys to scroll by display 
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length, paragraph, line, sentence, or character. You can set the left and right sets 

of scroll keys independently in the "Global Options". (See chapter 3.)  

 

1.2.2 The Right Panel 

Toward the front of the right panel of the BrailleSense Polaris MINI is the USB C 

port. This port can be used for transferring data, charging the unit, and connecting 

to a computer as a USB Braille display.  

Nearer the back of the device is a Micro HDMI port. Use this port to connect to an 

HDMI monitor with a Micro HDMI cable, or with a full-sized HDMI to Micro adapter.  

 

1.2.3 The Left Panel 

Near the front of the unit on the left panel are 2 small buttons for raising and 

lowering the master volume of the unit. Use the button nearer the front to decrease 

the volume, and the button behind it to increase it. 

Behind the volume buttons are located 2 small, round jacks. The one nearest the 

front is the stereo headphone jack, and the one nearer the rear of the unit is the 

stereo microphone jack for connecting a stereo microphone or line level recording 

source.  
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1.2.4 The Front Panel 

On the far left of the front panel is located a 3-position slide switch. This is the key 

"Lock" switch. This switch is explained in more detail in section 2.11 of this 

manual. 

To the right of it is another 3-position slide switch. This is the "Media Mode" switch, 

and determines which type of content the front panel buttons control. This switch 

is explained in more detail in the next chapter. 

To the right of the "Media Mode" switch, are five buttons, with a dot on the center 

one. These buttons control media and DAISY playback as well as providing 

shortcut keys for other areas of the unit when they are set to Application Mode. 

As explained above, the type of content controlled by these buttons depends on 

the position of the "Media Mode" switch. These five buttons are explained further 

in subsequent chapters of this manual. 

To the right of the media buttons is the Power button. To turn on the unit, press 

and hold this button until you hear a beep and feel a vibration. The first time you 

power on the unit, it will take some time to boot up.  

Once the unit boots, you can press the Power button quickly to put the unit in 

standby "screen off" mode. This is similar to locking the screen on a phone or 

tablet. Press it quickly again to unlock it and return to the position at which you 

entered Screen off Mode. Press and hold the Power button to completely power 

down the system.  

 



   22  

1.2.5 The Bottom Face 

The underside of the unit contains the battery compartment, speaker and the 

camera.  

The battery contains a rounded edge along one of the sides of its length. This 

rounded edge should be placed alongside the back edge of the unit's casing. To 

insert the battery, align the side tabs of the battery pack with the side walls of the 

battery compartment. Roll the battery forward until it clicks in to place. 

locate the 2 switches on the underside of the unit near the left and right ends. 

Using your left hand, click the left-most switch to the left when the battery is 

inserted to lock it in to place. When you want to remove the battery, Click this 

switch  to the right to unlock it. Near the right end, is a second, spring-loaded 

switch. Hold this switch to the left to release the battery, then roll the battery away 

from the unit. 

On the inside wall of the battery compartment is a micro SD card slot for additional 

storage. Press the Micro SD card in to the slot until you feel it click in to place. To 

release it, gently press in on the card and release. The card will pop out enough 

for you to grasp it with your fingers and remove it.  

The 13 megapixel camera is located near the center of the underside of the unit. 

Applications for OCR and photo capture can be downloaded from the Google Play 

Store. For best results, hold the Polaris MINI 9 to 12 inches above the paper, with 

the unit centered above the text.  

 Finally, below the label for the serial number, you’ll find a rectangular speaker 

grill for the mono speaker.  

 

Congratulations! You are now familiar with the basic functions of the buttons and 

ports of the BrailleSense Polaris MINI. The rest of the manual discusses each 
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function in greater detail to help you maximize the potential of your BrailleSense 

Polaris MINI. 

1.3 Hardware Specifications  

1. Operating system: Android Lollipop 5.1.1 

2. Internal storage: 64GB. 

3. RAM: 3GB. 

4. CPU: 2.1 GHz SAMSUNG Exynos 7420  

5. Battery: Lithium Ion (detachable), 3400mAh. 

6. Battery running time: 12 to 13 hours (with Braille and TTS, internal speaker at 

mid volume) 

7. Keyboard: 9 key Perkins-Style Braille keyboard, Control and Alt, 4 function 

keys, 20 cursor routing keys, 4 scroll buttons. 

8. Additional buttons and switches: key lock switch, Media Mode switch, 5 media 

buttons. 

9. Braille display: 20 refreshable Braille cells. 

10. Visual display: Micro HDMI, Miracast 

11. Wireless: 802.11 b/g/n/ac Wi-Fi, Wi-Fi Dual-band (2.4GHz and 5.0 GHz), Wi-

Fi Direct; Bluetooth 4.2.  

12. Sensors: GPS, RTC, Accelerometer, Compass, Gyroscope 

13. Camera: 13 MP SAMSUNG Camera 

14. Interface: 1 USB C data and charging port, 1 micro SD card slot 

15. Sound: Internal mono speaker, stereo headphone jack. 

16. Voice recording: Internal stereo microphones, external stereo microphone 

jack, headset microphone.  
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17. Vibrate motor: installed. 

 

1.4 Memory on the BrailleSense Polaris MINI 

The BrailleSense Polaris MINI has 3GB of RAM (random access memory) and 

64GB of flash memory. The RAM is memory reserved for running programs. RAM 

is a temporary storage area for any program files that are running or any currently 

open documents. The data in the RAM area disappears if your battery depletes, 

and the AC adapter is not connected. The RAM data also disappears when 

BrailleSense Polaris MINI reboots for any reason. This means, if you have an 

open document which you have not saved, the unsaved data disappears. 
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2. Basic Functions of the BrailleSense Polaris MINI 

 

2.1 How to Enter Commands 

The commands used to operate the Polaris MINI are comprised of various 

combinations of the Braille and function keys. In this user manual, the "-" (dash) 

is used to indicate that keys should be pressed simultaneously. For example, 

"Space-Z" indicates that the user should press "space" and Z at the same time. 

This manual also contains expressions like "Space-2-4-6". This means that the 

spacebar with dots 2, 4, and 6 should be pressed and released simultaneously.  

In a menu or dialog, when your cursor is placed on your desired command, you 

can execute most commands by pressing "Enter". To cancel a function or close a 

program or menu, and return to your previous location, press "Space-Z". 

 Note: In Android applications, “Space-Z” serves as the “Back” button. You 

can also use “Space-E” or “F4” as the Android “Back” button, used to move 

back one screen, or exit your current function or application.  

 

2.1.1 Basic Alerts and Messages 

There are instances where the Polaris MINI alerts you to events for which you 

have asked it to notify you. For example, by default, the Polaris MINI checks the 

Schedule Manager when you power on, and notifies you of any appointments 

scheduled for that day. When you are notified of an appointment, you can interact 

with the Schedule Manager as you normally would. To exit the Schedule 
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Manager, press "Space-Z" or "Space-E" and you are returned to your previous 

location.  

Other Polaris MINI system messages are displayed and spoken, and 

automatically disappear when any key is pressed, or after a set number of 

seconds. For example, when you connect the AC adapter to the Polaris MINI, the 

Polaris MINI speaks the message "AC adapter connected." When you disconnect 

it, the Polaris MINI says, "AC adaptor disconnected." 

You will also hear alerts from the Android system and applications. You can 

review Android notifications by pressing “Space-1-2-3-4-5-6”, and can delete most 

notifications using “Space-D”. Press Enter on the notification to open the 

associated program. You can control how various notifications and alerts are 

handled in the Global options. (See Chapter 3) 

 

2.2 Menu Concepts 

Menus on the Polaris MINI provide you with a list of programs, actions, or options 

from which you can select. If a menu item has a sub menu, selecting it brings up 

another list of choices. 

When using a program on the Polaris MINI, press "Space-M" or F2 to bring up its 

menu. Press the "Up" scroll key or "Space-1" to move to the previous item, and 

press the "Down" scroll key or "Space-4" to move to the next item.  

To move to the first item in the menu, press "Space-1-2-3." To move to the last 

item in the menu, press "Space-4-5-6." When placed on the first item of a sub 

menu, pressing "Backspace" returns you to the upper Menu. To repeat the current 
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item, press "Space-R". To open a sub menu or execute the current item, press 

“Enter”.  

You can also quickly jump to and execute a menu item by pressing its shortcut 

key, usually the first letter of the item name. Often menu items can also be 

executed instantly, directly from your current position in the program, with a 

hotkey. 

Shortcut keys are displayed in parentheses following the menu names. Hotkeys 

generally consist of a modifier such as "Enter," "Space," or "Backspace", pressed 

simultaneously with a letter or dot combination. These are displayed following the 

shortcut keys. 

For example, if you are in the Word Processor, and press "Space-M" or "F2," then 

press "Enter" on "File," you hear "New (n) Enter-n". The word "New" is the menu 

option. YOU would press the letter N to jump to "New" from within the "File" menu. 

Press "Enter-n" to access the "New" document command from anywhere in the 

Word Processor. The n is the shortcut key and "Enter-n" is the hotkey. It is 

important to note that some hotkey commands are global, thus will work from 

anywhere on the unit, and some are program specific. For example, if you want 

to activate the "new document" option in the Word Processor. You cannot press 

"Enter-n" from the "Program" menu to activate this option. You must be in the 

Word Processor for "Enter-n" to activate the "new document" command. 

However, if you wish to activate the "display time and Date" option in the "Utilities" 

menu, this can be done from anywhere on the unit using "Space-T" as this is a 

global hot key.  
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Let's begin going through the various menus. First, turn the unit on as explained 

in chapter 1. Now, bring up the "Program" menu by pressing "F1". The "Program" 

menu is the main menu of the Polaris MINI. You can access all of the 

programming, option settings, utilities, and help from this menu, as well as the 

Play Store and installed Android apps.  

The "Program" menu consists of 3 programs: File Manager, Word Processor, and 

E-mail; then 7 sub menus: Media, Organizer, Web Tools, Extras, Utilities, 

Settings, and Help. Finally, at the bottom of the menu are the Play Store, and All 

Apps, which brings up a list of all native Android applications installed on the unit.  

The first item in the "Program" menu is "File Manager". If "Space-4" is pressed, 

the next menu item is displayed and spoken. Pressing "Space-4" repeatedly, 

continues your navigational progress down the list of items in the "Program" 

menu. When you reach the bottom of the list, the "All Apps" menu item is 

displayed as it is the last item in the "Program" menu.  

You could also jump quickly to the "All Apps" menu item by pressing "Space-4-5-

6" when "File Manager" is displayed. Press "Space-1-2-3," and the Polaris MINI 

jumps back to the top. Press "Enter" on an item you want to execute or open. If 

you are in a submenu, and wish to return to the main "Program" menu, press 

"Space-E" or F4.  

The "Media" menu contains the "Media Player", "FM Radio" and "DAISY Player".  

The "Organizer" menu contains the "Address Manager" and "Schedule Manager".  

The "Web Tools" menu currently contains only the "Web Browser".  
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The "Extras" menu contains the optional "Sense Dictionary", "Excel Viewer" and 

"Online DAISY".  

The "Utilities" menu contains the "Calculator", "Display time and Date", "Display 

Compass Heading", "Wake Up Alarm", "Stopwatch", "Terminal for Screen 

reader", "Display Network Status", "Display Power status", "Format", "Sleep 

Timer" and "Upgrade BrailleSense Firmware". 

The "Settings" menu contains "Set Time and Date", "Setup Internet", "Bluetooth 

Manager", "Backup/Restore Settings", "Change device Name", “Quick Start 

Guide”, "Password Protection", "Initialize Polaris Options”, “Voice options”, 

"Polaris Global Options", “Android Backup and reset” and “Android System 

Settings”. 

The "Help" menu contains the various sections of the User Manual as well as an 

"Information" section containing general information about your BrailleSense, 

such as firmware version, device name, copyright and service information, and 

Mac address. 

The "Play Store" item opens the Google Play Store where you can search for and 

download native Android apps. 

Finally, the "All Apps" menu displays a list of all native Android apps installed on 

the unit. When the unit ships, this list contains stock Android apps and other 

Google basics like Docs, Sheets and Slides. 
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For more information on a specific program, please see the section of this user 

manual related to that program. For information on using Android apps, see 

chapter 12. 

The "F1" command for accessing the "Program" menu is an example of a global 

hotkey. This means that pressing the "F1" key takes you to the "Program" menu 

immediately from anywhere on the Polaris MINI.  

There are also global quick launch commands for most Polaris MINI programs, 

usually comprised of either F1 or F3 and a letter or dot combination. These quick 

launch commands immediately launch their associated application from 

anywhere on the Polaris MINI. See section 15.2 for a complete list of the quick 

launch commands.  

 

2.2.1 Control Symbols  

The BrailleSense Polaris MINI uses several control symbols to note the type of 

information being displayed: examples are list items, menus, and edit boxes. 

These symbols can appear "Before" or "After" the text, or the appearance of this 

information may be set to "off", determined by the "Control information" setting in 

the "Global Options". For example, if "Control information" is set to "before", and 

you bring up the Word Processor's program menu, The BrailleSense displays, 

"MN File (f) pull down". 

 Note: In the Web Browser, the control symbols are displayed even if the 

"Control information" is set to "off". 
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The following table shows the types of controls and the symbols that are used to 

indicate them. 

 

Name 

Symbol 

Comments 

Menu 

MN 

A menu that has submenus. 

Menu item 

MI 

A menu that does not have a sub menu. 

List item 

LI 

An item that is part of a list. 

Edit box 

EB 

After this symbol, the edit box name is displayed. You can find the edit box after 

the edit box name. In the web browser, the symbol "EB" may be followed by an 
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edit box without an edit box name. Edit boxes that begin with the symbol "EB" are 

one line. 

(Ex: "EB Last name: (cursor)" in the address manager program or "EB (cursor)" 

Multi edit box 

MEB 

This indicates a multi line edit box.  

(Ex: "MEB Subject: (cursor)" in the e-mail program) 

Computer edit box 

CE 

An edit box requiring ASCII Braille input. 

(Ex: "CE To:" in the Email program) 

Combo box 

CB 

Indicates a combo box in which you can choose an item by pressing the up scroll 

button or the down scroll button. 

(Ex: "CB Type:" in the "Open dialog box" of the Word Processor) 

Edit combo box 

ECB 

Choose the desired item by pressing the up or down scroll button, or by directly 

typing in the item name. 
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(Ex: "ECB File name: (cursor) was in the "Open dialog box" of the word processor 

program) 

Prompt button 

PB 

PB follows any question in which you have to choose "Yes" or "No." You can 

toggle between "Yes" and "No" by pressing "Space" or "Backspace" button.  

(Ex: When you exit from the word processor, "PB Save: Yes")  

Static box 

ST 

ST indicates the current status. 

(Ex: "ST noname.hbl/insert mode/write" in the word processor program) 

Link 

LN 

Indicates a link on a web page. 

Anchor 

ANC 

Indicates an anchor on a web page. 

Radio button 

RB 
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Indicates a radio button, cycle among items using up scroll button, down scroll 

button, space, or Backspace.  

(Ex: "RB Attribute: Write" in the "Information dialog box" of the file manager) 

Radio button select 

SRB 

Indicates the currently selected radio button in the web browser 

Radio button unselect 

URB 

It indicates the radio button is not selected. 

Check box check 

SCHB 

Indicates the check box is selected. 

Check box uncheck 

UCHB 

Indicates the check box is not selected.  

 

 Note: Links, anchors, and radio buttons are controls that are only used in 

the Web Browser.  

The symbols enable you to understand what type of input control or menu you are 

working with. For example, if "MN," "MI," or "LI" are displayed, you know you can 
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move from one item to the previous and next items by pressing the "Up" and 

"Down" scroll keys. If "ECB," "EB," "CB," or "MEB" are displayed, you know you 

are in an input area where you must type the. If "BT" is displayed, you can press 

"Enter" to activate the "button". 

 

2.3 Using the Function Keys 

There are four function keys on the Polaris MINI. You can use these function keys 

to open the menus, cancel tasks, and move to other items.  

The "F1" key opens the Polaris MINI "Program" menu from anywhere on the unit, 

and is used in combination with other keys to open various Polaris MINI programs.  

From within Polaris MINI programs, the "F2" key opens the program specific 

menu, similar to pressing “Alt” in Windows.  

 Note: you may also use "Space-M" to perform this function.  

The "F3" key functions as "Tab ("Space-4-5")". "Space-F3" serves as "Shift-Tab 

("Space-1-2")". F3 is also used together with other keys to open Polaris MINI 

programs. 

The "F4" key functions like  the "Escape" key on a PC. You can also use "Space-

E". Please note that "Escape" does not exit a program, as does "Space-Z" but 

rather, exits menus, dialogs, or prompt boxes. It also serves as the Back button 

in native Android apps. 

You can use the function keys in combination to perform various other tasks. 

Pressing "F1" and "F2" at the same time functions as "Page Up". Pressing the 
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"F3" and "F4" keys together serves as "Page Down". "F1" and "F4" together opens 

the task list. Pressing the "F2" and "F3" keys together cycles through the running 

programs; similar to pressing "alt-tab" on your PC. The Task List and task 

switching are explained in greater detail in section 2.9. 

The keys to the left and right of the spacebar are referred to as Control and Alt. 

This is because, in native Android applications, these keys function as Control 

and Alt on a QWERTY keyboard so that you may take advantage of native 

Android keyboard shortcuts when they are present. In BrailleSense specific 

applications, these keys operate similarly to "Space-1" and "Space-4" and provide 

an alternative method for scrolling through menus and lists.  

 

2.4 The Power Adapter and the Battery Pack  

To check the battery power status, press "Space-1-6." The unit displays the 

following 2 items: 

1. Battery power level: expressed as a percentage of the remaining battery power 

compared to a full charge.  

2. Power source (battery or USB power) 

If the battery power level drops under 15 percent, the Polaris MINI displays the 

battery status on the Braille display, and it announces that the battery has less 

than 15 percent of its power remaining. If the battery power level falls below five 

percent, the Polaris MINI gives you a warning indicating that your battery power 

level is under five percent, and the Polaris MINI will be automatically put to sleep 
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in one minute, unless you connect it to a power supply. When the level reaches 2 

percent, the unit automatically shuts down. 

When the Polaris MINI is shipped, the battery pack is not installed. This is done 

to prevent damage during shipping. When you insert the battery in to the Polaris 

MINI for the first time, the unit may display an inaccurate battery power level. 

Before using the Polaris MINI for the first time, please charge the battery for at 

least 3 hours. You may use the unit during the initial charge, however, it is 

recommended if you do, that the unit remain connected to AC power for at least 

3 hours to fully charge the battery.  

When you remove the battery from the Polaris MINI, make sure your unit is turned 

off; especially when the USB power adapter is not connected. If you remove the 

battery while the unit is on and power is not connected, you will lose all data stored 

in RAM, including open documents, emails, and contacts or appointments that 

have not been backed up.  

Polaris MINI can be charged via a USB C cable. It is compatible with Qualcomm 

quick chargers for more rapid charging.  

 

2.5 Controlling the Volume, Speed, and Pitch of the TTS  

Press "Backspace-F4" to increase the voice volume. Press "Backspace-F1" to 

decrease the voice volume. Press "Space-F4" to increase the speech rate. Press 

"Space-F1" to decrease the speech rate. Press "Enter-F4" to raise the pitch and 

"Enter-F1" to lower it.  



   38  

When you press any of the above key combinations, the Polaris MINI announces 

the status of its volume, rate, or pitch. The changes in the characteristics of the 

voice remain in effect until you change them again, or a hard reset is performed 

either manually or due to lack of power to the unit for an extended period of time. 

 Note: the volume of the voice is controlled independent of the Main Volume 

on the unit, thus, you can adjust it above or below the volume of the system 

sounds, media playback, etc using the Voice volume control described 

above. You can control the "Main Volume" of the unit using "Backspace-

Space-F1" to lower it and "Backspace-Space-F4" to raise it. You can also 

use the Volume Up and Volume Down buttons on the left side of the Polaris 

MINI to control master volume.  

 

2.6 Using Speech and Braille  

When using the Polaris MINI, you can choose to read using Braille only or speech 

only. You can also use both Braille and speech simultaneously. However, you 

cannot turn off both Braille and speech as you would have no method of receiving 

information from the Polaris MINI. Use "Backspace-F2" to toggle the speech on 

and off. Press "Backspace-F3" to toggle the Braille on and off. You can also 

control these settings in the Global options. 

 

2.7 Entering Text 

In a document, "edit box" or "multi edit box" on the Polaris MINI, you can enter 

either grade 1 or grade 2 Braille. By default, the unit uses UEB Braille, and you 
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are free to use UEB, even when writing e-mail or Web addresses. However, if 

using the traditional US Braille code, some areas of the unit, such as the "to" field 

of the E-mail program, contain a "computer edit box" requiring you to enter text in 

computer Braille.  

To enter a capital letter in computer Braille, use the upper case indicator (Space-

U" before the letter you want capitalized. For example, if you want to enter H in a 

computer edit box, press "Space-U" then H. If you press "Space-U" twice, caps 

lock is turned on. Press "Space-U" again to turn off caps lock. 

You can also press "Space-Backspace" simultaneously with the letter to capitalize 

it. To input the "at sign," you may either use "Space-U" followed by dot 4, or 

"Space-Backspace-dot 4".  

To enter numbers in contracted or uncontracted Braille, use the "number sign 

followed by the number. However, when using computer Braille, you use no 

number sign and must enter numbers as "dropped" numbers (Nemeth numbers).  

 

2.8 Multi-Tasking 

Polaris MINI can run many tasks at once. For example, you can work with the 

Word Processor while listening to music, and place calculations into a document 

at the same time. To do this, open the Media Player and play a music file. While 

the audio is playing, press the "F1" key to bring up the "Program" menu and launch 

the Word Processor. 

If you try to run a program that is currently running, The Polaris MINI does not 

open a new instance of the program, but rather, returns you to the instance of the 
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program that is already running. For example, while working with a document 

called "Notes" you decide to execute the "File Manager." Next, you navigate to a 

document called "journal" in the file list and press "Enter." The Word Processor 

does not load a second time, but rather, "journal" is opened in the same instance 

of the Word Processor in which "notes" is already loaded. You can switch among 

multiple open documents in a single instance of the Word Processor with F3 and 

Space-F3. Switching documents is explained in more detail in section 5.  

To switch between currently running programs press "F1-F4" to open the Task 

List. The Task List shows all the currently running programs in list form. To return 

to any application, simply navigate to it and press "Enter". To force closing of an 

application in this list, press "Space-D". To close all applications, press “F3” to tab 

to the “Close All” button, and press “Enter”. 

If you have pressed "F1" to bring up the "Program" menu, or "F1-F4" to open the 

Task List and you decide not to access a different application, you can press 

"escape" ("Space-e" or "F4") to return to your previous location on the unit. 

You can use "F2-F3" to immediately cycle among all running programs without 

opening the Task List. This is similar to using "alt-tab" on your PC. If you are 

running three programs and are in the second program, pressing "F2" and "F3" 

moves you to the third program. If you press "F2-F3" again, you are placed in the 

first program. 

In the above case, if you were to press "Space-Z" to close the currently open 

program, you are then placed in the previous program. However, if there is only 
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one program running, pressing "Space-Z" closes the program and places you in 

the "Program" menu.  

 

2.9 Switching Media Modes 

The media buttons on the front panel perform different functions according to the 

location of the "Media Mode" switch. 

If you slide the "Media Mode" switch to the left-most position, the Polaris MINI 

announces, "application mode" and the media buttons control operation of the 

current application. If you place the "Media Mode" switch in the center position, 

the Polaris MINI says, "DAISY mode" and the media buttons control playback of 

DAISY content. If you slide the "Media Mode" switch to the right-most position, 

the Polaris MINI announces, "media mode" and the media buttons control media 

playback. 

It is very important to pay attention to the position of the "Media Mode" switch to 

achieve desired operation of the media buttons. For example, if you are using the 

Media Player, if the "Media Mode" switch is placed in the center position, the 

media buttons on the front panel control operation of the DAISY Player, even 

though your focus is in the Media Player. More detailed explanations of the 

functions of the Media buttons is given in the Mobile Screen Reader, DAISY 

Player, and Media Player sections in this manual. 
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2.10 Switching Key Lock 

You can disable the keys on the Polaris MINI to prevent the accidental pressing 

of keys using the key "Lock" switch on the front panel. 

When the key "Lock" switch is placed in the left-most position, Polaris MINI 

announces, "all keys locked". This means all keys on the unit are disabled 

including the on/off switch. If the key "Lock" switch is placed in the center position, 

Polaris MINI says, "top panel locked". This means you can continue to use the 

buttons and switches on the front panel (media mode switch, media buttons and 

on/off switch), however, you cannot use any of the keys on the top face of the 

unit. If the key "Lock" switch is placed in the right-most position, Polaris MINI 

announces, "unlocked". This indicates all keys are operational. 

To lock and unlock only the keys on the front media panel, press the "Back" and 

"Forward" media buttons simultaneously. The unit announces "Media keys 

locked". If you press the keys again, the unit announces "Media keys unlocked", 

and the media buttons are again operational.  

 

2.11 One-Handed Mode 

Polaris MINI provides a One-handed mode for users restricted to the use of one 

hand for Braille input. To toggle One-handed mode on/off, press “Backspace-1-2-

3”. You can also turn One-handed mode on or off in the "Global Options" dialog. 

When One-handed mode is on, use the following methods to input text:  

1. To type a character, press the dots in any combination or order. When you have 

pressed all dots, press "Space" to complete the entry of the character. For 
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example, if you want to type "h," you press "dot 1" and "dot 2" separately or 

together and then press "dot 5." Finally, press "Space". 

2. To press a command that includes "Space," press "Space" both before and 

after the dot combination. For example, to press "Space-o (dots 1-3-5)," press 

"Space" then press "dot 1", "dot 3" and "dot 5" separately or together in any order. 

Then press "Space" again. 

3. To press a command that includes "Backspace" or "Enter," press "Backspace" 

or "Enter" before the dot combination. Then press keys that make up the dot 

combination. Finally press "Space". For example, to press "Enter-l (dots 1-2-3)", 

press "Enter", and then press "dots 1-2-3." then, press "Space". 

4. To press "Space," "Backspace" and "Enter", press the key twice. For example, 

to press "Space" to create a space between words, press "Space" twice. 

The operation of the scroll keys, function keys, and media buttons remains the 

same as in normal mode.  

If One-handed mode is on, the Polaris MINI announces this each time it is 

powered on, as well as how to return to normal operation.  

 

2.12 Using Typing Mode 

While you are typing in a document, you may wish to turn off the navigation 

keystrokes, especially if you type very fast as you may accidentally navigate when 

you intend to enter text. To turn on "Typing Mode", press "Backspace-Enter-C" 

from within a document. "Start typing mode" is announced and displayed. 
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When using "Typing Mode", if you press "Space-dot 4", instead of moving to the 

next line, the "Space" and "Dot 4" are entered into the document. 

To cancel "Typing Mode", Press "Backspace-Enter-C" once again. "End typing 

mode" is announced and displayed. After "Typing Mode" is canceled, navigation 

commands return to normal operation.  
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3. Customizing your Notetaker 

When you receive your notetaker, one of the first things you will want to do is to 

configure it to act the way you want it to. The "Settings" menu allows you to 

configure and customize your notetaker to meet your specific needs and 

preferences.  

To open the "Settings" menu, press "F1" to bring up the main menu. Press 

"Space-4" until you reach "Settings" and press "Enter". Or, just press S from the 

main menu to quickly jump to and open the "Settings" menu. 

The "Settings" menu contains the following items: "Set Time and Date", "Setup 

Internet", "Bluetooth Manager", "Backup/Restore Polaris MINI Settings", "Change 

Device Name", "Quick Start Guide", "Password Protection", "Initialize Polaris MINI 

Options", “Voice options”, "Polaris MINI Global Options", “Android Backup & 

Reset” and “Android System Settings”. The following sections discuss each of 

these items in detail. 

 

3.1 Set Time and Date 

To set the Polaris MINI's internal clock, press "Enter" on "Set Time and Date" in 

the "Settings" menu. Or press T to open the "set time and date" dialog from the 

menu. You can launch the "Set Time and Date" dialog from anywhere on the unit 

by pressing "F3-T".  

The set time and date is a dialog, consisting of the following: "Time zone", "Time 

format", "Time", "Date Format", "Date", "Synchronize with time server", a 
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"Confirm" button, and a "Cancel" button. You can move among these items by 

pressing “F3” or “Space-F3”. 

When you activate "Set Time and Date", "Time zone?" appears followed by the 

default time zone. You can choose your desired time zone by navigating to it using 

"Space-1" or "Space-4" or by typing the first letter of the time zone. Once done, 

move to the next item using "F3". 

The next item is "Time format", the options for which are 12 hour and 24 hour 

time. You can toggle between the two using "Space-1" or "Space-4".  

The next item is "Time". When typing the time, separate the hour and minute using 

a space or a colon.  

If you select 12 hour clock in the "Time format", A.M. or P.M. is displayed after the 

hour and minute. In the 12 hour clock, you can toggle A.M. it P.M. by pressing 

"Space-X".  

Tab to "Date format". You can choose to display the date in either the "short" or 

"long" format. The short format displays the date numerically, while the long 

format displays the Month spelled out and shows the date as it would appear in 

literary form. Toggle between the two using "Space-1" and "Space-4".  

The next item is "Date". Type the "Date" month, date, and year as mm/dd/yyyy. 

Use 2 digits for the month, 2 digits for the day, and 4 digits for the year, separating 

them by a space or a slash.  

The next item is "Synchronize with time server", used to synchronize time and 

date with a time server on the Internet. This function is extremely useful when the 



   47  

date and time of Polaris MINI is faster or slower than the current time. To execute 

this function, your Polaris MINI must be connected to the Internet. When 

connected, press "Enter" on the "Synchronize with time server" button. After 

synchronization, it displays the synchronized time in the "Time" edit combo box. 

The synchronized date is also displayed in the "Date" edit combo box. 

If you do not wish to enter date and time information directly, you can navigate 

using the following commands: 

When setting time: 

Move forward 1 hour: Space-4 

Move back 1 hour: Space-1 

Move forward 10 minutes: Space-5 

Move back 10 minutes: Space-2 

Move forward 1 minute: Space-6 

Move back 1 minute: Space-3 

When setting date: 

Move to the next day: Space-6 

Move to the previous day: Space-3 

Move to the next week: Space-5 

Move to the previous week: Space-2 

Move to the next month: Space-4 
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Move to the previous month: Space-1 

Move to the next year: Space-5-6 

Move to the previous year: Space-2-3 

When you have completed entering all of the information, press "Enter" to save 

your settings, or "Tab to "Confirm" and press "Enter", and you are returned to the 

"Settings" menu. 

 

3.2 Setup Internet 

The "Setup internet" function is used to configure your Polaris MINI to use a LAN 

or Wireless connection to access the Internet.  

 Note: to use a LAN connection, you will need a USB to Ethernet adapter.  

To activate "Setup internet", press "Enter" on "Setup internet" in the "Settings" 

menu, or press "I". You can open the "Setup Internet" menu from anywhere on 

the unit by pressing "F3-I".  

 

3.2.1 Setup Wireless LAN 

Before setting up a Wireless LAN connection, be sure wireless is turned on in the 

"Global Options" dialog. You can toggle wireless on and off from anywhere on the 

Polaris MINI using "Backspace-1-4-5-6". In addition, when you choose this option, 

if Wireless is not turned on, BrailleSense automatically activates Wireless LAN. 

To connect to a wireless network, navigate to the "Wireless LAN" option in the 

connection types list under "Setup Internet" and press "Enter".  
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The "Wireless LAN" dialog consists of the "access points" list, "Advanced" button, 

"Options" button and "Close" button. You can move among these controls by 

pressing "F3" or "Space-F3". If wireless is not turned on, the "access points" list 

displays "no items".  

When wireless is on, this list shows the wireless "access points" (networks) in 

range of your notetaker. The "Access points" list displays the "access point name", 

"encryption", and "sensitivity" of each item. (Ex: linksys, encryption: WEP, 

sensitivity: good.) If there is more than one access point in the list, you can move 

among them by pressing "Space-1" or "Space-4". Move to the "access point" to 

which you want to connect, and press "Enter". If the access point has no 

encryption, the Polaris MINI announces, "Connecting to (access point name)". If 

connection is successful, the connecting sound is heard. If the network is 

encrypted and requires a network key, when you press "Enter" on the access 

point, the "Network key" edit box is displayed. Type the network key in computer 

Braille in the edit box and press "Enter". If your settings are correct, the unit says, 

"Completed setting profile" and the connecting sound is heard.  

The "Advanced" dialog is used to modify an existing profile, manually add a new 

profile, or check the settings of an existing profile. Pressing "Enter" on the 

"advanced" button, while wireless LAN is turned on, displays a list of the wireless 

profiles saved on the Polaris MINI. 

The "Advanced" dialog has 5 controls: the "profile list", "Connect" button, "Add" 

common dialog button, "Remove" button, "Properties" common dialog button, and 

"Close" button. You can navigate among these controls by pressing "F3" or 
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"Space-F3". Navigate the items in the Profile list using "Space-1" and "space-4". 

Press "Enter" to activate one of the buttons. 

Use the "Add" button: to manually add a profile, specifically where an SSID is 

hidden, and thus does not appear in the "access points" list. The "Add" dialog" 

contains 10 controls. 

1) "Setup IP: Automatic" combo box: You can switch between automatic and 

manual by pressing "Space-4" or "Space-1". If you select "Manual", you must 

enter your IP address, subnet mask, gateway IP address, and DNS IP address. 

You can move among these computer edit boxes by pressing "Space-4" or 

"Space-1". Press "tab (Space-4-5)" to move to the next control. 

2) "Network name (SSID)" computer edit box: Type the network ID in the computer 

edit box. 

3) "Network mode" combo box: You can select among "Infrastructure", and 

"802.11 ad-hoc" mode by pressing "Space-1" or "Space-4". 

4) "Network authentication mode" combo box: Select among "Open", "Shared", 

"WPA-PSK", and "WPA2-PSK" by pressing "Space-1" or "Space-4". 

5) "Data encryption" combo box: Select the data encryption method by pressing 

"Space-1" or "Space-4". If you select "Open" or "Shared" in network authentication 

mode, you can choose among "Disable" and "WEP". And if you select "WPA-

PSK" or "WPA2-PSK" in network authentication mode, either "AES" or "TKIP" can 

be selected in the "Data encryption" combo box. 
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6) "The key is provided automatically" check box: If the "access point" does not 

provide a key for users automatically, uncheck this check box by pressing 

"Space". The default is checked.  

7) "Network key" computer edit box: This is a computer edit box to type the 

network key if the key is not provided automatically. 

8) "Key index" edit box: This is an edit box to type the key number of the wireless 

access point that matches the network key input. 

9) "Confirm" button: Pressing this button applies the changes. 

10) "Cancel" button: You can select this button to cancel the setup. 

 Things to note:  

1) If "Data encryption" has been set as "disabled", press "F3" and you are 

taken directly to the "Confirm" button.  

2) "Network key" and "Key index" is displayed only if you uncheck "The key 

is provided automatically". 

To delete a profile item in the profile list, select the profile item you wish to delete, 

and press R or "Tab" to the "Remove" button and press "Enter".  

To get information about a selected profile item in the profile list, "Tab" to the 

"Properties" button and press "Enter". In the "Properties" dialog, you can 

reconfirm or modify the information for each profile.  

To exit the "Advance" dialog, press "Space-E" or "Space-Z". 
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The "Options" dialog allows you to set how the Polaris MINI scans for and detects 

wireless networks. The "Scanning Always Available" option allows you to choose 

whether Polaris MINI auto scans for available networks, even when you don't 

open the Setup Internet dialog. The "Wi-Fi Frequency Band" determines what Wi-

Fi networks are detected and used. Choose from "Auto", "5GHz" and "2.1GHz". 

Use "Space" to adjust the options in the dialog, and press "Enter" to save your 

settings. 

 

3.2.2 LAN Setup 

Before attempting to set up a LAN connection, connect one end of a LAN cable 

to the Polaris MINI via a USB to Ethernet adapter, and the other to a router or 

direct LAN connection to the Internet. ?. From the list of connection options in "Set 

up Internet", navigate to "LAN" and press "Enter".  

"Setup IP: Automatic" is displayed. If your service provider does not require you 

to use a static IP address, simply press "Enter" on this option for automatic setup. 

For the automatic setup, your host server should provide DHCP service (Dynamic 

Host Configuration Protocol). 

To set up your IP configuration manually, move to "Manual" by pressing "Space-

1", and press "Enter". The following settings are displayed: "IP", "Subnet mask", 

"Gateway", and "Primary DNS". These settings require specific numeric 

addresses. Please contact your Internet service provider for the correct 

addresses. Use computer Braille to type the information for each setting, using 

"Space-1" and "Space-4" to move among the settings. When you have entered 



   53  

the information for each item, press "Enter" to save the settings. The unit 

announces, "Setting completed". And you are returned to "Setup internet". Your 

Internet connection should be active.  

 

3.3 Bluetooth Manager 

The Polaris MINI is Bluetooth capable, or rather, you can connect the Polaris MINI 

to various devices such as keyboards, printers, audio devices, and other 

computers without the need for cables. You can also use Bluetooth to transfer 

files, or to connect the Polaris MINI as a Braille display with a compatible screen 

reader. Bluetooth is the latest in wireless technology and enables wireless 

connectivity via a Personal Area Network (PAN). Unlike a traditional Wireless 

Local Area Network (WLAN), these networks are limited to approximately 30 feet 

or less. Bluetooth enables users to exchange various types of information over 

this wireless connection.  

You can toggle Bluetooth on/off from anywhere on the unit using "Backspace-

dots-3-4-5-6".  

To access the Bluetooth Manager from the program menu, navigate to the 

"Settings" menu, and press "Enter. Then, navigate to "Bluetooth Manager", and 

press "Enter". You can also press "F3-B" to launch the Bluetooth Manager from 

anywhere on the unit. 
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3.3.1 Bluetooth Device List 

When the Bluetooth Manager is activated, you are placed in a dialog with 2 items: 

a paired devices list, and a "Search" button to scan for available devices. For 

example, if you have a computer with Bluetooth enabled nearby, the Polaris MINI 

attempts to find it. It may take 30 to 40 seconds to discover all of the Bluetooth 

devices in range. The Polaris MINI announces and displays, "Scanning for 

devices. Please wait...” Full cells are filled in on the Braille display to indicate 

scanning progress.  

When a Bluetooth device is detected, the Polaris MINI announces "found 

(Bluetooth device name)".  

 Note: while the Polaris MINI is scanning for Bluetooth devices, it cannot 

respond to key presses. In addition, you may not cancel the scan once it 

has begun, but must wait for its completion before the Polaris MINI returns 

to normal operation.  

When the scanning process completes, you are placed in the Bluetooth Device 

List. If the Polaris MINI has found other Bluetooth devices in range, they are 

displayed as "device name (untrusted (or trusted)) xx/yy" where xx is the number 

at which the device appears in the list, and yy is the total number of devices. 

"Trusted" indicates that the service has been authenticated, "untrusted" indicates 

the service has not been authenticated. 

If there are no other Bluetooth devices in range, the Polaris MINI announces, "no 

items". You can press "Space-1" or "Space-4" to move through the list. To select 

a device from the list, press "Enter" on the device name. 
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If the Bluetooth device is trusted, settings for connecting the device are 

automatically saved in the Polaris MINI. If you want to delete this information, 

press "Space-D" on the Bluetooth device name in the list. The Polaris MINI 

announces, "Device settings removed". Removal of the settings applies only to 

the current device. 

From the Bluetooth Device List, you can access the menu by pressing "F2". The 

"Bluetooth Device List menu" contains "Rescan For Devices", "Delete Pair 

Information", "Options" and "Exit". You can navigate among the menu items using 

"Space-1" or "Space-4". 

The first menu item is "Rescan For Device". This option initiates a new scan for 

other Bluetooth devices. To activate this item, press "Enter" on "Rescan for 

Devices" in the menu. Or you can activate it directly from the list by pressing 

"Enter-R".  

The next menu item is "Delete Pair Information". This item allows you to remove 

the connection settings for the current device. To activate this item, press "Enter" 

on "Delete Pair Information" from the menu, or press “Space-D" to activate it from 

the Device List.  

The "Options" item lets you determine if the Polaris MINI is discoverable to other 

Bluetooth devices. Press "Space" to check or uncheck the option. 

The final item in the Bluetooth Device List menu is "Exit". This option exits the 

Bluetooth Manager program. To activate this item, press "Enter" on "Exit" from 

within the menu, or exit the program any time by pressing "Space-Z".  
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3.3.2 Bluetooth Service List 

When you locate a Bluetooth device to which you'd like to connect, press "Space-

1" or "Space-4" to navigate to the device in the Bluetooth Device List, and press 

"Enter" on the device name. The unit announces, "Scanning for services. Please 

wait...” Please note The Polaris MINI does not respond to key presses during the 

scanning process.  

The Polaris MINI supports the following Bluetooth services: FTP, Serial port, USB 

port, and headset. To access any of these functions, be sure that the remote 

Bluetooth device is in Discoverable mode, and that the service you wish to access 

is enabled on that device. It is possible to have certain services enabled on your 

remote Bluetooth device, while disabling others. The Polaris MINI only sees and 

displays services which are enabled on your remote device, even if others are 

available.  

When the Polaris MINI has found all of the available services, the services are 

displayed in a list in the following format: "service name xx/yy" where xx is the 

number at which the service appears in the list, and yy is the total number of 

available services. You can move through the available services by pressing 

"Space-1" or "Space-4". Press "Backspace" to return to the Bluetooth Device List. 

From the Bluetooth Service List, you can access the menu by pressing "Space-

M" or by pressing "F2". The "Bluetooth Service List menu" contains "Open FTP", 

"Disconnect" and "Exit". You can navigate the menu items using "Space-1" or 

"Space-4". 
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The "Open FTP" menu item allows you to quickly open a direct FTP connection 

with a remote Bluetooth device without accessing the Device and Service lists. 

However, you must have connected the FTP service previously for the Polaris 

MINI to allow you to transfer files. If you have not connected the FTP service, and 

you activate this function, the unit announces, "FTP service disconnected".  

You can access "Open FTP” by pressing "Enter" on it from within the menu, or by 

pressing "Enter-T" directly from the Bluetooth Service List. The Polaris MINI says, 

"Connecting service". Detailed information on connecting various service types is 

covered later in this chapter. 

The "Disconnect" menu item allows you to disconnect services with other 

Bluetooth devices. You can access this item by pressing "Enter" on "disconnect" 

from within the menu. Or you can activate it directly from the Bluetooth Service 

List by pressing "Enter-D".  

If there are no services connected and you activate this function, the unit says, 

"There is no service connected". 

 

3.3.2.1 Connecting a Service 

To authenticate a service and connect to it, press "Enter" on the service. The 

Polaris MINI announces, "Connecting service". You are then prompted for a "PIN 

code:" You must use ASCII characters when you type the pin code. This edit box 

only appears when you have not previously connected to a service, and a pin 

code is required by the device. You can exit the edit box or delete text you have 

typed by pressing "Space-Z" and you are returned to the Bluetooth Service List. 
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When you finish typing the pin code, press "Enter". The unit announces, "Please 

wait for authentication". If the remote device is setup correctly, and has not been 

set up to allow this device to always connect, the remote device also asks for a 

pin code. Please be sure to enter the same pin code on both devices. If the remote 

Bluetooth device pin code matches the pin code on the Polaris MINI, the service 

should authenticate. If connection is successful, the unit announces, "PIN code 

authentication accepted".  

You are then prompted, "Please wait. Access permission". If the remote Bluetooth 

device does not give access permission, the unit says, "Connection failed", and 

you are returned to the Bluetooth Services List. If the remote Bluetooth device 

gives you access permission, the Polaris MINI says "Connection succeeded". If 

the connection succeeds, "Connected" is displayed after the service in the 

Bluetooth Service List. Some services may be connected without inputting a pin 

code depending on the Remote Bluetooth device settings. 

 

3.4 Backup/Restore Polaris Settings 

If you hard reset your Polaris or initialize the Polaris Options, the main option 

settings and settings for each program are initialized to the default values. If you 

have created a backup of your settings, you can restore the option settings after 

the hard reset. 

You can run this utility by pressing K from the "Settings" menu. You can also 

launch the "Backup/Restore Polaris Settings" dialog from anywhere on the unit by 

pressing "F3-K".  
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The "backup/restore" dialog contains: the "program option check box list", a 

"Select all" button, a "Backup" button, a "Restore" button, and a "Cancel" button. 

You can move among the check boxes in the "program option check box list", by 

pressing "Space-1" or "Space-4". You can move among the controls in the dialog 

by pressing "F3" or "Space-F3". 

The "program option check box list" contains "Options settings", "File manager 

options", "Word processor options", "E-mail Options", "Media Player options", 

"Radio Options", "DAISY Player options", "Address manager options", "Schedule 

manager options", "Web browser options", “Excel Viewer Options", "Wake Up 

Alarm Options" and “Bluetooth manager options". 

In this list, move to the program options you want to backup or restore and check 

the item by pressing "Space". You can uncheck a checked item by pressing 

"Space" again. To select all of the program options in the list, press "Enter" on the 

"Select all" button.  

After selecting all the options you want to backup or restore, press "Enter" on the 

"Backup" or "Restore" button, or press "Enter-B" to backup or "Enter-R" to restore. 

If you select the "Backup" button, you are prompted to select a path for storing 

the backup file. You can accept the default path, or choose an alternative. 

Navigate to the folder in which to store the backup files using normal file/folder 

navigation commands. Select the folder or drive in which to store the backup by 

pressing "Space", and press "Enter" to start the backup process. If you select the 

"Restore" button, you are prompted for the path from which to restore backup 

files. Again, use normal file and folder navigation to select the folder containing 
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your backup files. If you select a folder in which there is no backup, you receive a 

message indicating there is no backup option file. To restore your settings, select 

the folder containing the backup files by pressing "Space", then press "Enter" to 

initiate the restore process. 

 

3.5 Change Device Name 

The "Change device Name" function allows you to change the Bluetooth/network 

name of your unit. By default, the BrailleSense is named something like "Polaris 

MINI035". You may wish to give it a more personalized name in order to identify 

it more easily when pairing with another device.  

You can access the "Change device Name" dialog by navigating to the "Settings" 

menu, then to "Change Device Name". You can also launch the "Change device 

Name" dialog from anywhere on the unit by pressing "Backspace-Enter-E".  

The "Change device Name' dialog consists of 3 controls: a "Device Name" edit 

box, a "Confirm" button, and a "Cancel" button. Use "F3" and "Space-F3" to move 

among the controls. 

To change your device name, type a new name in the edit box and press "Enter". 

Or, after typing the new name, tab to "confirm" and press "Enter". If you decide 

you do not wish to change your device name, tab to the "Cancel" button and press 

"Enter", or press "Space-E" or "Space-Z". 
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3.6 Quick Start Guide 

The Quick Start Guide runs a getting started wizard that introduces you to Polaris 

MINI and its functions, and lets you set basic preferences. This guide 

automatically launches the first time you start your unit. You can relaunch it at any 

time by selecting the “Quick Start Guide” option in the “Settings” menu. 

When you press “Enter” on this option, you are asked, “Would you like to reboot 

your system and launch the Quick Start Guide?”. Press “Enter” for Yes, or 

navigate to ‘No’ with “Space-4” and press “Enter” to cancel this operation. 

 Note: when you launch the Quick Start Guide, all options are initialized to 

factory defaults, so that they can be reset using this wizard. 

 

3.7 Password Protection 

The Password Protection item allows you to set a password that must be entered 

when the unit is powered on, comes out of Sleep Mode, is upgraded, or the disk 

is formatted. 

WARNING!! It is imperative that you create a password that you can easily 

remember, or that you store in another location for easy retrieval! Due to Android 

security safeguards, we are not able to send unlock codes as has been the case 

with older BrailleSense models. If you set a password using this function, or using 

the Android system settings, and you are not able to remember or retrieve it, it will 

be necessary to send the unit to HIMS/SELVAS for unlocking, during which, all 

data will be lost. As remembering and retrieving personal passwords is the 
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responsibility of the customer, any costs associated with transporting and/or 

unlocking the unit are also the responsibility of the user.  

To open the "Password Protection" settings, from the Main menu, navigate to 

"Settings" and press "Enter". Press A to jump to and open "Password Protection". 

You can open "Password Protection" from anywhere on the unit by pressing "F3-

N".  

The "Password Protection" dialog consists of 4 items: "set/modify Password" 

dialog, "Password Configuration" dialog, "Set Password to factory defaults", and 

a "Close" button. Use "F3" or "Space-F3” to move among the controls in the 

dialog. 

 

3.7.1 Setting and Modifying Passwords 

When you open the "Password Protection" program, you are placed on the "Set 

Password" option. Press "Enter" to open the "Set Password" dialog. The "Set 

Password" dialog consists of 4 controls: "Password" edit box, "Retype Password" 

edit box, "Confirm" button and a "Cancel" button".  

Type the password you wish to use into the "Password" edit box. Tab to the "Re-

type Password" edit box, and type it again. To save the password, press "Enter", 

or Tab to "Confirm" and press "Enter". To cancel saving the password, press 

"Space-Z", or Tab to the "Cancel" button and press "Enter". 

When a password is saved, the "Set Password" option is replaced with "Modify 

Password". Once you have entered a password, you can modify in very much the 

same manner. The "Modify Password" dialog consists of all the same controls, 
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except you must type your current password, before you can type a new one. 

Once you have typed your current password, then the new password, you must 

re-type the new password. Press "Enter" on the "Confirm" button to save the new 

password, or "Enter" on the "Cancel" button to cancel the modification. 

 

3.7.2 Password Configuration 

The "Password Configuration" dialog allows you to define when you are prompted 

to enter the password. When you press "Enter" to open the "Password 

Configuration" dialog, you are prompted to enter your password to gain access to 

this configuration. Type your password, and press "Enter". 

The password configuration settings consist of 4 radio buttons: "Prompt for 

password on boot", "Prompt for password when in Sleep Mode", "Prompt for 

password when formatting" and "Prompt for password when upgrading." Use 

"Space-1" and "Space-4" to toggle these buttons between "Yes" and "no". When 

you have chosen your options, press "Enter" on the "Confirm" button to save your 

settings. If you want to cancel the configuration, press "Enter" on the "Cancel" 

button. 

 

3.7.3 Reset Password to Factory Defaults 

Use this option to reset the password configuration and return your unit to its 

factory state of no password protection. 

When you press "Enter" to open this option, you are prompted, "Do you want to 

initialize the password settings?". Use "Space-1" and "Space-4" to choose 
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between "yes" and "No". If you choose "yes", you are prompted for your current 

password. Type it, and press "Enter". The unit announces, "Password settings 

have been initialized" and you are placed on the "Set Password" option.  

 

3.8 Initialize Polaris Options 

You can use the "Initialize Polaris Options" item to restore the BrailleSense Polaris 

MINI to the factory default settings. 

To launch this function, navigate to it in the "Settings" menu, and press "Enter", 

or press C.  

You are prompted, "Do you want to initialize options?" Use "Space" to choose 

"Yes" or "No". Choosing "Yes" initiates the factory reset process. Choosing "No" 

cancels the function and returns you to the "Settings" menu. You can also perform 

this function by holding the Forward Media key while pressing the Power Button. 

Once you see “HIMS” displayed on the Braille display, you can release the 

Forward key.  

 

3.9 Voice Options 

This dialog allows you to install and set alternative Vocalizer Expressive TTS 

voices. Available voice downloads are available via the “Download” option in this 

menu. To download and install directly from the Polaris MINI, choose the 

“Download” button, and use “Space-1” and “Space-4” to choose the voice you 

want and press “Enter”. The correct folder will be auto created, and the language 

pack will automatically be placed there. 
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You can also download voices manually via the HIMS website. 

When you have downloaded the language pack files, create a folder on your 

flashdisk called “TTSDATA”, and copy the files in to it.  

Once done, open the “Settings” menu, and press “V” to open the Voice options 

dialog. This dialog contains a voices list, a “Download” button, an “Install” button”, 

and Confirm and Cancel buttons. Use “F3” and “Space-F3” to move among the 

controls. 

Press “Enter” on the “Install” button to install any language packs available in the 

“TTSDATA” folder. When voices are installed, an ‘Uninstall” button also appears 

in the dialog.  

When you have installed your voices, use “Space-1” and “Space-4” in the Voices 

list to choose your voice, and press “Enter”. Your speech should automatically 

begin outputting using the voice you chose. 

You can open the Voice options dialog quickly at any time by pressing “F3-V”. 

You are placed in the Voices list, from which you can easily choose a different 

speaking voice. 

 

3.10 Polaris Global Options 

The "Global Options" on the Polaris MINI is a large dialog box for controlling many 

preferences/settings.  Open the "Polaris MINI Global Options" from the main 

menu, by pressing S to open the “Settings” menu, then "O" for the "Global 
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Options". You can also open "Global Options" from anywhere on the notetaker by 

pressing "Space-O".  

The "Global Options" dialog is organized into groups, making it easy to jump to a 

particular section in the long list of settings. You can navigate among the groups 

with "page down ("Space-3-4-5" or "F3-F4")" or "page up ("Space-1-2-6" or "F1-

F2")". When you navigate to a group, you are placed at the position where that 

group of options begins.  

You can navigate among the individual options using "Space-1" and "Space-4" or 

using the scroll keys. You can also use shortcut keys to quickly move to specific 

items.  

 Note: Often, the same shortcut key is used for multiple options. Thus, the 

first press of the shortcut key moves the focus to the first setting that 

matches; pressing the key again moves to the next setting that matches. If 

there are no more settings matching the shortcut, the Polaris MINI wraps 

around to the first match. 

Many of the Global Options also have global hotkeys, allowing you to adjust these 

settings from anywhere on the unit.  

You can toggle an option on or off or cycle through the available values of a setting 

with the "space" and "Backspace" keys. To save your changes, press "Enter" or 

tab to the "Confirm" button and press "Enter". Polaris MINI says, "Saved options," 

and you are returned to your previous position on the notetaker. To cancel without 

saving changes, press the "F4" key, "Space-E" or "Space-Z".  
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3.10.1 Global Options in Detail 

The "Global Options" dialog contains the following settings. For each setting, the 

shortcut key appears in parentheses, and the hotkey, if available, is shown in 

quotes.  

1) Braille display: (B). "Backspace-F3". Toggles the Braille display On/Off. 

2) Braille Cursor: (C). "F4-Up Scroll". Defines how the Braille cursor appears on 

the Braille display: "Always Up", "Blinking" or "Off". Note the cursor appears as 

dots-7-8 in most situations. When selecting text, it notes the end of the selection 

with blinking dots-1-2-3-4-5-6-7-8. 

3) Eight Dot Mode: (E). "F4-Up Scroll". Toggles Eight Dot Mode on/off for ASCII 

text entry. 

4) View/input Braille Grade: (G). "Space-G". Lets you choose what grade of Braille 

you want to use when viewing/entering text: Uncontracted Braille, Contracted 

Braille, or Computer Braille.   

5) Braille Code: (C). "Backspace-Enter-B". Defines the rules by which Braille is 

translated to text and vice versa: "US", "UK", "UEB", or one of several foreign 

language Braille codes. When foreign language codes are set, you can read and 

write Braille according to that language's Braille rules. The Braille language also 

affects lists, combo boxes, and edit boxes. Prompts, menus, buttons and static 

boxes remain in English. 
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6) Message Display Time: (M). defines how the Polaris MINI deals with system 

messages: ignore, stand by until you press a key, or, display for from 1 to 10 

seconds before disappearing. 

7) Voice: (V). "Backspace-F2". Toggles the voice output On/Off. 

8) Punctuation Level: (P). Use this setting to choose how you want the Polaris 

MINI to read punctuation marks and symbols: "All", "Off", "Punctuation," or 

"Symbols".  

9) Keyboard Echo: (K). Defines how Polaris MINI speaks as you type: "On with 

characters and words," "On with characters," "On with words," or "Off".  

10) Capitalization alert: (U). Choose how the Polaris MINI alerts you that a 

character is capitalized, either when typing or when navigating a document or edit 

box by character: "Off", "Say cap," or "Pitch". 

11) Numbers: (N). Defines how Polaris MINI speaks numbers: when set to "On", 

Polaris MINI speaks numbers, and when set to "Off", it speaks digits. 

12) Voice Volume: (L). "Backspace-F1 and Backspace-F4". Raises or lowers the 

volume of the text-to-speech. 

13) Voice Rate: (R). "Space-F1 and Space-F4". Controls the rate of the speech. 

14) Voice Pitch: (T). "Enter-F1 and Enter-F4". Adjusts the pitch of the Polaris MINI 

voice.  

15) Main Volume: (V). "Backspace-SPACE-F1 and Backspace-Space-F4", or the 

Volume Up and Down buttons. Controls the master volume of the unit, including 

system sounds, audio and speech. 
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16) Scroll Voice: (S). Choose whether you want the Polaris MINI to speak while 

using the scroll buttons as you read.  

17) Audio alerts: (A). Choose whether the Polaris MINI alerts you to various 

events using audio signals, vibration signals, both, or no signal. 

18) Battery Alerts: (B). Choose how you are alerted when your battery is low: 

"Message", "Beep", "Final Message" or "Final Beep".  

19) Play Power On/Off Sound: (P). Choose whether you hear a sound when you 

turn on/off the Polaris MINI.  

20) Left Scroll Buttons: (L). Define the operation of the left scroll buttons: "Scroll 

display", "Move by line", "Move by character", "Move by paragraph" and "Move by 

sentence".   

21) Right Scroll Buttons: (R). Define the operation of the Right Scroll buttons with 

the same options as above. 

22) Skip Empty Lines: (E). Choose to have the Polaris MINI alert you to a blank 

line by announcing "Blank" or skip empty lines.  

23) Control Information: (I). Define where information is announced regarding the 

type of control on which you are currently located, a list item, menu, combo box, 

etc. Choose from Before, After and Off.  

24) Hide passwords: (P). Choose whether the characters of a password are 

hidden as you type them.  

25) Hot Key Information: (H). Defines how hot key information is announced: 

"Letters," "Dot patterns," or "Off".  
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26) Announce shortcut keys: (S). Lets you choose whether the Polaris MINI 

speaks the menu shortcut key for a function as you encounter it.  

27) Sleep Mode: (P). Set Polaris MINI to save power by automatically shutting 

down after a certain period of time: "On", "Off", or "Message". (Only active when 

using battery power.) 

28) Sleep Mode Kick In: (K). Use this option to set the time of inactivity before 

entering SLEEP Mode: 10 minutes, 20 minutes, or 30 minutes. 

29) Check Today's Schedule: (S). Set the Polaris MINI to check today's schedule 

for appointments each time you turn it on.  

30) One-Handed Mode: (H). This option allows users with only the use of one 

hand to use the Polaris MINI in a specific mode adapted for that purpose. For 

detailed information about one-handed mode, refer to section 2.14.  

31) Enable Spell-check: (C). You may wish to disable spellcheck in educational 

situations where a student needs to be tested on spelling, etc. 

 Note: If "Enable Spellcheck" is turned off, Automatic Spellcheck cannot be 

used. 

32) Automatic spell-check: (C). Set whether the Polaris MINI automatically checks 

spelling as you type in "multi line edit boxes" in programs such as the Schedule 

Manager, Address Manager, E-mail messages, the Word Processor, etc. If the 

option is "On", and you enter a misspelled word, Polaris MINI emits a beep sound 

to indicate the misspelling.  
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33) Default Document Type: (Q). Set the default document type for new 

documents you create using the word processor: “DOCX document”, "Sense 

document", "Braille document,", "DOC document" or "Text document".  

34) Automatically synchronize with time server: (T). Using this feature, you can 

ensure the accuracy of the time on the Polaris MINI by synchronizing with an 

atomic clock when Polaris MINI is connected to the Internet.  

35) Time Announcement: (T). Set the Polaris MINI to announce the time every 5 

minutes, every 10 minutes, 30 minutes or every hour.  

36) Progress indicator: (P). Defines how the progress of opening a document, 

copying files or opening a webpage is indicated: "Silent," (no progress indication) 

"Beep," (continuous beeps while the task is performed) and "Message" (progress 

is shown as a percentage).  

37) Bluetooth: (B). "Backspace-3-4-5-6". Toggles Bluetooth On/Off.  

38) Wireless LAN: (W). "Backspace-1-4-5-6". Toggles Wireless LAN On/Off.  

39) Screen Reader Hints: (H). Set whether to receive spoken hints about how to 

interact with the screen reader as you navigate the controls of 3rd party programs: 

"On/Off". 

40) Screen Reader Control Information: (I). Determines whether the screen 

reader speaks the type of control or field as you navigate 3rd party applications: 

"On/Off". 

41) Notification alerts: (N). Set whether you receive push notifications from 

Android applications.  
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42) Enable Braille in standby Mode: (N). Set whether status messages are shown 

in Braille while in Sleep Mode.  

 

3.11 Android Backup & Reset 

The “Android Backup & Reset” option opens the Restore and Reset options found 

in the Android System Settings in a more convenient location. Here, you can set 

options for backing up and restoring information related to your Android 

applications and accounts, and you can factory reset your device. WARNING! 

Performing a factory Reset in the “Android Backup & Reset” menu erases all 

personal data, including files, account information, installed applications, etc. This 

is also a long and involved process and should not be undertaken before 

consulting with tech support staff, as you will need special instructions to complete 

it properly. 

 

3.12 Android System Settings 

The “Android System Settings” is the final item in the “Settings” menu. You can 

launch it from anywhere using “F3-E”. 

This option opens the standard Android “Settings” dialog found on stock Android 

phones and tablets. While many settings are duplicated in the Polaris MINI 

interface, the “Android System Settings” contains a standard Android interface, 

and must be navigated in the same manner as Android applications. Use “F3”, 

and “Space-F3” to move among objects on a screen. Use “Backspace-Space-1” 

and Backspace-Space-4” to adjust slider controls. Please see chapter 12 on the 



   73  

Mobile Screen Reader, and chapter 15, Commands Summary,  for more complete 

information on navigating the Android interface. 
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4. File Manager 

 

4.1 Overview 

The functionality and structure of the "File Manager" on the Polaris MINI are 

similar to "Windows Explorer" on a PC. To run the "File Manager", press F from 

the "Program" menu or press "Enter" when your cursor is placed on "File 

Manager". You can launch the "File Manager" from anywhere on the unit by 

pressing "F1-F". Close the "File Manager" by pressing "Space-Z". 

The "File Manager" contains 2 basic areas: an "address window" and the content 

list. You can navigate between them using "F3" and "Space-F3". When you first 

open the "File Manager", you are placed in the drive list. By default, you are placed 

on the internal "flashdisk". If an SD card or USB drive is connected, it also appears 

in the list. You can use "Space-1" or "Space-4" or the scroll buttons to navigate 

the items in the drive list. Press "Enter" on the drive you want to open. The Polaris 

MINI then displays the list of the files/folders on that drive.  

The "address window" contains the path of the current directory or file.  

The "File Manager" contains both menus and hot keys, allowing you to easily 

activate items in the program with a single keystroke as well as to access 

functions through the menus for commands you have not memorized. You can 

bring up the menus by pressing "Space-M" or "F2". For the purposes of the 

directions in this chapter and the rest of this manual, we will use F2. However, 

either keystroke will perform this function. 
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Use Space-1" and Space-4" to navigate among the available menus. To open a 

menu, press "Enter". Again, use "Space-1" or "Space-4" to navigate among the 

items in a menu, and press "Enter" to execute a menu item. 

The File Manager also contains dialogs. You can navigate among the controls in 

a dialog box by using the equivalents of "Tab" on a PC. You can use "F3" or 

"Space-4-5" for "Tab" and "Space-F3" or "Space-1-2" for "Shift-Tab". For the 

purposes of instructions in this manual, we will use "F3" and Space-F3", or you 

will be directed to "Tab" or "Shift-Tab". 

   

4.1.1 Navigating the File List 

The "File Manager" contains two kinds of lists: the "file list" and the "menu list", or 

rather, the list of items contained in the "File Manager" menu. The menus in the 

Polaris MINI wrap. This means, when you reach the end of the list of items in a 

menu, the Polaris MINI automatically brings you back to the top of the list when 

you press "Space-4". However, when you reach the end of a "file list," the Polaris 

MINI remains at the end of the list, even if you press "Space-4". The following is 

a list of the keystrokes used for navigating lists: 

 Note: the following keystrokes can be used to navigate any list on the 

Polaris MINI. 

1. Move to previous item: (Space-1) or up scroll button 

2. Move to next item: (Space-4) or down scroll button 

3. Move to the beginning of a list: Space-1-2-3 
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4. Move to the end of a list: Space-4-5-6 

The following keystrokes are valid only in a "file list". 

1. Jump to folder or file list: Space-5-6 

2. Move between file list and address window: (Space-4-5 or F3) / (Space-1-2 or 

Space-F3) 

3. Enter the selected folder or open the selected file: Enter 

4. Move back a level in the folder structure: Backspace 

5. Jump to the drive list: Space-1-2-5-6 

6. Move to the previous group of 20 items: Page up (space 1-2-6 or F1-F2) 

7. Move to the next group of 20 items: Page down (space 3-4-5 or F3-F4) 

8. Jump to a file or folder by pressing the first character of the folder or file name. 

You must use ASCII characters. 

 

4.1.2 Selecting Folders and Files 

1. Select individual items "Space": * is displayed in front of the item to denote its 

selection. Pressing "Space" again on the selected folder or file cancels the 

selection. 

2. Continuous selection "Enter-b": This selects all of the items from the point 

where this command is executed to the item where the cursor is located. * appears 

in front of the selected items. 



   77  

3. Select all "Enter-a": This selects all the files and folders in the current list. You 

can toggle selection and de-selection of items by pressing "Space". When the 

"Select All" command is executed, the Polaris MINI says the number of selected 

files, and * appears in front of the selected files on the Braille display.  

 

4.2 Working with Files and Folders 

When viewing the contents of a drive or folder, the items in quotation marks are 

folders, and the items without quotation marks are files.  

The items in the list are followed by numbers, such as 1/5 or 2/5. The numbers 

following the items indicate an item's placement in the list and the total number of 

items in the list. For example, "database 1/5," indicates "database" is the first 

folder in a list containing five items. 

 

4.2.1 Entering and Exiting Folders 

There are several ways to open a folder.  

1. Bring up the menu by pressing "F2". Select the "Open" option from the list and 

press "Enter".  

2. Press the hot key "Enter-O" to activate the "Open" command and open the 

desired folder. 

3. Finally, as described above, you can simply press "Enter" on the selected 

folder. 
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To exit the current folder, use the "Backspace" key. You are returned to the 

previous level in the folder structure.  

 

4.2.2 Ejecting USB Drives and SD Cards 

The Android operating system requires that drives are ejected properly before 

removing them. If not done, re-inserting them in to the Polaris MINI or connecting 

to other mobile devices or computers may result in all files appearing as though 

they have no data, or have a size of 0 bytes. Before disconnecting a USB drive or 

SD card, press “Backspace-Enter-U” or “Backspace-Enter-3-6” to    it 

from the system. If your drive is showing files with no data, please re-insert it in to 

the Polaris MINI, and press the Unmount key to eject it properly, and the data 

should, be visible once again. 

 

 

4.3 The File Menu 

To open the "File" menu, press "F2" to bring up the menu, and press "Enter" on 

"File". Use normal list commands to navigate to your desired option and press 

"Enter". 

The Polaris MINI supports the following file formats:  

1. Document files: hbl, brl, txt, brf, rtf, doc/docx, XLS/XLSX, PPT/PPTX, PDF and 

unprotected EPUB. 

2. Web formats: url, and html.  
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3. Media formats: ac3, asf, asx, m3u, mp2, mp3, MP4, ogg, pls, wav, wax, wma, 

wmv and flac.  

4. DAISY formats: DAISY 2.0, 3.0, BookShare.  

5. programs: APK. Press “Enter” to install. 

 

The menu contains the following items. Shortcuts are placed in parentheses, and 

hotkeys are in quotes. 

1) Open: (O) "Enter-O". Opens the selected file in the associated application for 

its file type.  

2) Open New Word Processor: (W) "Backspace-W". Appears only for supported 

document files. Launches a second instance of the Word Processor instead of 

opening the file in a currently open Word Processor. 

3) Open With: (E) "Enter-E". Allows you to choose a compatible application with 

which to open the selected file. 

4) Zip (Z) "Enter-Z". Compresses the current file or folder. 

5) Unzip (U) "Enter-U". Appears only for compressed files, extracts the current 

file.  

6) Send To: (S) "Enter-S". Lets you send the current file or folder to a different 

location. 

7) Rename (R) "Enter-R". Rename the current file or folder. 
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8) New Document: (N) "Enter-N". Create a new document using DOCX, DOC, 

TXT, BRL, or HBL. 

9) New Folder: (F) "Enter-F". Creates a new folder. 

10) File Conversion: (T) "Enter-T". Converts selected document files to TXT, BRL, 

or HBLIND. 

11) Find File: (F) "Space-F". Search the current drive or folder for a specific file 

by name. 

12) Find Text: (F) "Backspace-F". Search Word, Text, and Braille files on the 

current drive or folder for specific text strings.  

13) Merge Files: (M) "Enter-M". Select 2 or more text or Braille files to merge 

together. 

14) Split Files: (P) "Enter-P". Split text or Braille files by paragraph or word count, 

by size, or into a certain number of files of equal size.  

15) Information: (I) "Enter-I". Provides basic properties of the current file or folder. 

16) Exit: (Z) "Space-Z". Closes the File Manager. 

  

4.4 The Edit Menu 

The Edit Menu contains the following items: 

1) Copy: (C) "Enter-C". Copies the selected files or folders to the clipboard. 

2) Cut: (X) "Enter-X". Cuts the selected files or folders to the clipboard.  
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3) Paste: (V) "Enter-V". Pastes the files or folders on the clipboard to the current 

location. 

4) Delete: (D) "Space-D". Deletes the selected files or folders. 

5) Select All: (A) "Enter-A". Selects all the files and folders in the current list. 

 

4.5 The View Menu 

The View Menu contains the following options: 

1) Sort Files By: (G) "Enter-G". Determines in what order files and folders are 

displayed. 

2) Set File Info: (L) "Enter-L". Determines what information is displayed about 

each file or folder in the list.  

3) Display Only Files of Type: (W) "Enter-W". Filters files by file type. 

4) Hide System Folders: (H) "Enter-H". Hides Android system folders that do not 

contain user content. These are hidden by default. 

 

4.6 Using the Address Window 

This edit box lets you type the direct path of the file name you want to open. This 

window also contains the history list for easily accessing recently opened files or 

directories.  

When you are in a file or folder list, you can press "tab (Space-4-5)" to navigate 

to the address window. The Polaris MINI displays the current path including the 

current drive name, such as "flashdisk/download/". The address window is only 
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visible when you are in a file or folder list. When you are in the drive list, the 

address window is not available. 

You can edit the text by relocating the cursor with a cursor routing key, the Polaris 

MINI inserts the text at the cursor location. If you know the exact path and file 

name, you can type in the path and file name to open the file with the appropriate 

application. For example, if you type in "flashdisk/download" in the address 

window and press "Enter," the Polaris MINI displays the list of the files in the 

download folder. If you type "flashdisk/My Documents/sample.txt" in the address 

window, and press "Enter," the Polaris MINI loads the Word Processor, and opens 

the file "sample.txt".  

Use "Space-1" or "Space-4" in the Address Window to review the history list (a 

list of file and folder paths you have recently opened). To open a file in the history 

list, press "Enter". The file opens with the appropriate application. (See section 

4.2.3). 
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5. Word Processor 

You can launch the "Word Processor" in a couple of ways: 

Press "F1" to open the main "Program" menu. Navigate to "Word Processor" 

using "Space-4" and press "Enter". You can also press W from the main menu to 

quickly jump to and open the "Word Processor. 

You can launch the "Word Processor" from anywhere on the unit by pressing "F1-

W". 

When you launch the Word Processor on the Polaris MINI, it places you in a new, 

blank document. You can activate all the functions of the Word Processor via the 

Word Processor menu or by using hot keys. The menu in the Word Processor 

consists of File, Edit, Go To, Read, and Layout. To access these menus, press 

"Space-M" or "F2". Select a menu item using "Space-1" or "Space-4", and press 

"Enter". Or, you can press "Space-M or "F2" followed by the shortcut for the 

corresponding menu item.  

Use "Space-1" and "Space-4" or the Up and Down scroll keys to navigate menus, 

settings or file lists. Use "Space-4-5" and "Space-1-2" or "F3" and "Space-F3" to 

tab among controls in a dialog.  

Press "Enter" to execute an item. 

 

5.1 File Menu 

The File menu contains the following options: 
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1) Open New Word Processor: (W) "Backspace-N". Opens a second instance of 

the Word Processor to more easily switch between documents. 

2) New: (N). Creates a new document, by default named "noname". Choose the 

default document type in the Global Options. You can create a DOCX, DOC, TXT, 

BRL or HBL document. 

3) Open: (O) "Enter-O". Opens an existing file. Supported file types include DOC, 

DOCX, PPT, PPTX, PDF, EPUB, XML, RTF, TX, BRL and BRF. *Note: these files 

can be read, but all file types cannot be saved. 

4) Save: (S) "Enter-S". Save the current file. Tab between name, location and file 

type. Use normal file management navigation to choose a different folder.  

5) Save As: (A) "Space-S". Save the current file under a different name, as a type 

or in a different location. 

6) Print: (P) "Space-P". Emboss the current document. Inkprinting must be done 

via native Android apps. 

7) Settings: (E) "Enter-E". Dialog to set various document options. Tab among 

settings list, location Info check boxes, Default folder, and Confirm and Cancel 

buttons. Settings list includes View Format Characters, Reading unit for Space-1 

and Space-4, Read Only On/Off, Automatic Save Interval, Auto Scroll Speed, 

Apply Settings to All Documents, Home/End movement unit, Math Braille Code, 

and new Document default name. Use “Space-1” and “Space-4” to move among 

the settings in the Settings list, and Space or Backspace to change the value of 

the setting. 
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8) File Open Setting: (T) “Backspace-Enter-O”. Determines how a document is 

loaded: Choose “Load completely” to open the document in whole before reading, 

choose “Load in Background” to start reading after the first page is loaded, and 

continue loading in the background. 

9) Dictionary: (D) "Backspace-Enter-D". Opens the Sense Dictionary installed, 

and inserts the word under the cursor in the lookup edit box.  

10) Exit: (Z) "Space-Z". Closes the Word Processor. 

 

5.2 Edit Menu 

The Edit Menu contains the following items: 

1) Start Selection: (B) "Enter-B". Marks the beginning of the selection. The end of 

the selection is marked by the current cursor position.  

2) Copy: (C) "Enter-C". Copies selected text to the clipboard. 

3) Cut: (X) "Enter-X". Cuts the selected text to the clipboard. 

4) Paste: (V) "Enter-V". Pastes text from the clipboard to the current location. 

5) Delete: (D) "Space-D". Deletes selected text. 

6) Delete Blank lines: (L) "Backspace-E". Deletes blank lines from the selected 

text area. 

7) Add to clipboard: (P) "Enter-P". Appends selected text to the clipboard without 

deleting the prior selection. 

8) Clear clipboard: (E) "Enter-D". Empties the clipboard. 
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9) Select All: (A) "Enter-A". Selects all the text in the document.  

10) Check spelling: (K) "Enter-K". Opens the Check Spelling dialog, and begins 

checking the document for errors. Use “F3” and “Space-F3” to move among the 

controls, and “Space-1” and “Space-4” to move through lists of options. You can 

also use the following hot keys: 

 A. Skip Once: Backspace-S. 

 B. Skip All: Backspace-I. 

 C. Modify Current: Backspace-C. 

 D. Modify All: Backspace-M. 

 E. Add to User Dictionary: Backspace-A. 

 

5.3 Insert Menu 

1) Set Mark: (M) "Enter-M". Sets a bookmark at the current cursor position. 

2) Jump to Mark: (J) "Enter-J". Jumps to a previously set mark. 

3) Delete Mark: (D) "Backspace-D". Deletes a previously set mark. 

4) Insert from File: (I) "Enter-I". Inserts information from another file. 

5) Insert Date: (W) "Enter-W". Inserts the current date. 

6) Insert time: (T) "Backspace-W". Inserts the current time. 
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5.4 Go to Menu 

1) Find: (F) "Space-F". Opens Find dialog where you can enter a text string to 

search, choose whether to match case, and choose the search direction.  

2) Find Next: (H) "Enter-F". Finds the next instance of the previously searched 

string. 

3) Find Previous: (V) "Backspace-F". Finds the previous instance of the search 

string from your current position. 

4) Find and Replace: (R) "Enter-R". Dialog to search for a text string and replace 

with an alternative string. Choose search direction, match case, and whether to 

replace one instance or all. 

5) Go To Location: (L) "Enter-L". Go to a location in the document according to 

page, paragraph, line or percentage. 

6) Go To Previous Sentence: (E) "Space-2-3-6". Moves back one sentence. 

7) Go To Next Sentence: (X) "Space-3-5-6". Moves forward one sentence. 

8) Go To Previous Page: (B) "Space-1-2-6). Moves back one page. 

9) Go To Next Page: (G) "Space-3-4-5". Moves forward one page. 

10) Go To Previous Document: (P) "Shift-Tab". If multiple documents are open, 

moves to the previous document in the order the files were opened. 

11) Go To Next Document: (N) "Tab". If multiple documents are opened, moves 

to the next document in the file open order.  
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5.5 Read Menu 

1) Read Selected Text: (B) "Backspace-B". Reads the selected block of text. 

2) Read beginning of Selected Text: (U) "Enter-U". Reads the first line of a 

selected text block. 

3) Read from Beginning to Cursor: (T) "Backspace-G". Reads from the beginning 

of the document to the current cursor position. 

4) Read from Cursor to End: (Q) "Enter-G". Reads from the current cursor position 

to the end of the document. 

5) Auto Scroll: (A) "Up/Down Scroll". Starts and stops the auto scroll function. Set 

the speed of the auto scroll in the Settings under the File menu.  

6) Read Current Sentence (E) "Space-1-4-5-6". Reads the current sentence. 

7) Read Current Line: (L) "Space-1-4". Reads the current line. 

8) Read Current Word: (W) "Space-2-5". Reads the current word. Press twice to 

spell. 

9) Read Current Character: (C) "Space-3-6". Reads the current character. Press 

twice to hear the military alphabet equivalent. 

10) Read Cursor Position: (R) "Space-1-5-6". Reads current cursor position as 

page, paragraph, word, and line. 

11) Read Status: (S) "Space-3-4". Reads title of document and indicates Insert or 

Overwrite mode. 
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12) Read Character and Space Count: (I) "Backspace-I". Reads the current and 

total character count, and the current and total space count of the current 

document. 

13) Read Font info: (F) “Backspace-Enter-N”. Provides font, style, and formatting 

information for the text at your current position. 

 

5.6 Layout Menu 

1) Font: (F) "Enter-backspace-F". Opens the font settings dialog. Acts on selected 

text. 

2) Braille Paragraph Layout: (B) "Backspace-1-2-4-6". Determines the Braille 

format of the current paragraph. 

3) Braille Document Layout: (P) "Backspace-P". Determines Braille document 

format for embossing. 

4) Print Paragraph Layout: (C) "Backspace-2-3-4-6". Determines the print format 

and style of the current paragraph.  

5) Print Document Layout: (T) "Backspace-T". Determines the format of the pages 

of a printed document. 

 

5.7 Miscellaneous Functions 

The following commands can also be used in the Word Processor: 

1) Insert Tab: Backspace-Space-Enter-I. 

2) Insert Page Break: Backspace-Space-Enter-P. 
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3. Center current line: Backspace-Space-Enter-C. 

4) Start/End Math Mode: Backspace-M. 

5) Insert math symbol: Press Space-H in Math Mode, and press Enter on the 

symbol in the list. 

6) Next slide in PowerPoint file: Space. 

7) Previous Slide in PowerPoint file: Backspace. 

8) Go to slide in Power Point File: Enter-L. 

9) Move back by double carriage return: Backspace-Space-2-3. 

10) Move forward by double carriage return: Space-Enter-5-6. 
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6. E-mail  

To use the e-mail program, you must have an e-mail account, provided to you by 

your Internet service provider or sign up for a free account such as Gmail or 

Hotmail. Your e-mail account needs to support POP3 (Post Office Protocol 3) or 

IMAP (Internet Message Access Protocol) and SMTP (Simple Mail Transfer 

Protocol) to be accessed with the Polaris MINI.  

Before you use the e-mail program, you must also configure the Polaris MINI to 

access the Internet, (see section 3.2 "Internet Setup"). 

 Note: The menus in the Polaris MINI's e-mail program are specific to the 

task you are performing: for example, when checking the "Inbox" in the e-

mail program, the menu items are different from the available items when 

you are writing an e-mail or viewing mailboxes. Generally, the available e-

mail program menus are "File", "Edit", "Tools" and "Message". 

To access these menus, press "Space-M" or "F2". Select a menu item, and press 

"Enter". Use "Space-1" and "Space-4" or the Up and Down scroll keys to navigate 

menus, settings or file lists. Use "Space-4-5" and "Space-1-2" or "F3" and "Space-

F3" to tab among controls in a dialog.  

 

6.1 Executing E-mail  

To use the e-mail program, you must configure the Polaris MINI to access each 

of your e-mail accounts by entering your e-mail account information.  

To execute the e-mail program, navigate to "E-mail" in the "program" menu, by 

pressing "Space-1" and "Space-4" and press "Enter", or just press E from the 
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main program menu. You can launch the "E-mail program from anywhere on the 

unit by pressing "F1-E".  

When you launch the e-mail program for the first time, the Polaris MINI says, "You 

must create at least 1 mail account from the accounts manager in the Tools 

menu". Then, the "Inbox" is opened.  

The "Inbox" is the main window of the E-mail program. When you run the e-mail 

program for the first time, this "Inbox" is empty and the Polaris MINI displays "no 

items". 

If there are e-mail messages in the "Inbox", "Opening inbox." is announced; and 

"xx% processed" is displayed on the Braille display. Once progress has reached 

100%, the "Inbox" is opened and displays the received e-mail in the message list.  

Press "Shift-Tab (Space-1-2)", and you are placed in the mailbox list. By default, 

the Polaris MINI contains the following mailboxes:  

1) Inbox: received mail that has not been deleted or saved to a different folder. 

2) Sent: sent messages you have chosen to store  

3) Outbox: messages waiting to be sent, either when you save mail in "Outbox" 

or sending mail fails. 

 

6.2 Setting Up an Account 

To access the "Accounts Manager", Open the menu with "F2", navigate to "Tools" 

and press "Enter". "Accounts Manager" is the first item in the "Tools" menu, thus, 
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you can just press "Enter" again to open it. You can also launch the "Accounts 

Manager" from anywhere in e-mail by pressing "Enter-M".   

"Account name: no items" is displayed.  

The "Accounts manager" dialog contains the following 6 items: "Accounts" list, 

"Information" button, "Add" button, "Modify" button, "Delete" button and "Close" 

button. 

 

To add an e-mail account, follow these steps: 

1) From the "Accounts Manager", press "F3", to move to "Add" and press "Enter". 

2) The dialog is opened and "Server Type" is displayed. This is a combo box in 

which you can choose to manually setup your account, or ask BrailleSense to 

auto fill in server information from known server types like Gmail and iCloud. Use 

"Space-1" and Space-4" to navigate the Server types. If your server is not in the 

list, select "Manual". Press F3 to move to the incoming server type. 

3) "Default mail server" is displayed. Use Space to choose between POP3 and 

IMAP. Press "F3" to move to the account settings list. 

4) "Account name:" is displayed. Type the name by which you want to identify the 

e-mail account: (example, "Gmail" or "work e-mail"). 

5) Press "Space-4", to move to "Display name". Type the "Display name" in the 

edit box. This name is the name people will see when they receive an e-mail from 

you. 
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6) Press "Space-4", to move to "Logon username". Type the "Logon username" 

in the edit box (using computer Braille if writing in US Braille). (Ex: Sense or 

sense@himsintl.com). 

  Note: some providers require you to use the entire e-mail address as the 

username, while others may use the part of the address before the at-sign. 

BE sure you type the username correctly for your e-mail provider. 

7) Press "Space-4", to move to "Password". Type the "password" in the edit box 

(computer Braille if using US Braille).  

 Note: By default, the password is hidden, and thus displays as asterisks. 

Be sure to type carefully as you cannot review your password unless you 

choose not to hide passwords in the "Global Options".  

8) Press "Space-4", to move to "E-mail address". Type your "E-mail address" in 

the edit box (again, use computer Braille if entering US Braille). (Ex: 

sense@himsintl.com) 

9) Press "Space-4", to move to "Incoming Server?". If you have selected "IMAP" 

as your incoming server type, "Incoming IMAP server?" is displayed. If you have 

chosen "POP3" as your incoming server type, "Incoming POP3 server" is 

displayed. Type the "Incoming server" in the edit box (in computer Braille for US 

Braille). (Ex: imap.himsintl.com, or pop.himsintl.com). Check with your account 

provider for your specific incoming server name.  
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10) Press "Space-4", to move to "Outgoing SMTP server". Type the "Outgoing 

SMTP server" in the edit box (computer Braille if using US Braille). Check with 

your account provider for the exact name of your outgoing SMTP server.  

11) "Tab to the "Confirm" button and press "Enter". 

12) The Polaris MINI exits to the "Account name list" and shows the added 

account name (Ex: Account name: Polaris MINI 1/1). 

13) When you finish adding accounts, press "Space-Z" to return to the "Inbox". 

 Note: Many e-mail service providers use secure servers with different port 

numbers. If your service provider requires you to use encryption, you must 

set these options in the "Advanced" dialog explained below: 

 Note: If you are not using UEB, several of the fields for setting up an e-mail 

account require you to use computer Braille. To type your ID, Password, 

and address,  

 

While adding your account, you can create a signature and set advanced options 

in the "Advanced" dialog.  

1) Open the "Accounts Manager" as described previously.  

2) If you're creating a new account, "Tab to the "Add" button and Press "Enter". If 

you need to add advanced settings to an account you've already created, Tab to 

the "Modify" button and press "Enter". 

3) When you have filled in everything in the main account settings list, press "F3" 

to move to "Advanced" and press "Enter". 
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4) Polaris MINI displays "Use secure POP3 (or IMAP) (POP-SSL)". The default 

value of this check box is unselected. If the POP3 or IMAP server uses "SSL", 

select the check box by pressing "Space". 

5) Press "F3" to move to "POP3 (or IMAP) port number": POP3 is set to 110 by 

default, and IMAP is set to 143 by default. Type a different POP3 or IMAP port 

number in the edit box if your provider requires a different port number.  

 Note: if you check "SSL" above, the pop port number is automatically 

changed to 995 and the IMAP port to 993, as most servers with SSL 

require.  

6) Press "F3" to move to "SMTP encryption type". The setting values are "None", 

"SSL" and "TLS". If your Outgoing SMTP server uses "SSL" or "TLS", change the 

value by pressing "Space". 

7) Press "F3" to move to "SMTP port number": set to 25 by default. If you have 

chosen "SSL" as the encryption type, the default port number is set to 465 as is 

most commonly used for SMTP servers using SSL. If you have chosen TLS, the 

default SMTP port number is set to 587. Type a different value in the edit box if 

your provider uses a different SMTP port number.  

8) Press "F3" to move to "SMTP username". If your Internet account provider 

requires you to use a different SMTP username, enter it in this edit box. 

9) Press "F3" to move to "SMTP password". Type the password that corresponds 

to the above ID (using computer Braille if entering US Braille). If your SMTP 

username and password are not different, leave these items blank.  
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10) Press "F3" to move to "Use as default send-from account" To use the 

username and password that were set in steps 7 and 8, select the check box by 

pressing "Space". 

11) Press "F3", move to "Use signature". The default value is "No". To attach a 

signature to your mail, press "Space" to change "No" to "Yes". 

12) If you chose yes, press "F3", to move to "Signature" and press "Enter".  

13) You are placed in the "Signature:" multi edit box. Type the information for the 

signature you want to attach to your e-mails.  

14) Tab to "Confirm" and press "Enter".  

15) Tab to the "Confirm" button and press "Enter" to save the settings in the 

"Advanced" dialog. 

16) Tab to the "Confirm" button one more time to save the settings in the main 

"Account information" dialog. 

 

6.3 Managing Accounts 

To view the information about a stored e-mail account, open the "Accounts 

Manager" as described previously. Navigate to the account for which you want 

information and press "Enter" or Tab to "Information" and press "Enter". 

In this dialog you can read all information associated with an e-mail account. Use 

"Space-1" and "Space-4" to navigate the list of settings for the account. Press 

"Space-E" to return to the accounts list.  
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To modify the information for an e-mail account, open the "Accounts Manager" 

and navigate to the desired account in the list. When the desired account is 

displayed, press "F3" to move to the "Modify" button, and press "Enter". Or, press 

Enter-M to activate the "Modify" button.  

You are placed in the "Account name" edit box. You can now make changes to 

the information presented. The "Modify" dialog is exactly like the "Account setup" 

dialog, except that all the information is already filled in. Use normal editing and 

navigation commands to navigate to the information and make your desired 

changes.  

When you have finished making modifications, press "F3" to move to "Confirm" 

and press "Enter".  

 

Use the following steps to delete an E-mail account. 

1) Open the Accounts Manager in the manner previously described. 

2) Press "Space-4" or "Space-1" to move to the desired account in the account 

list. 

3) When the desired account is displayed, press "Space-D" Or, press "F3" to 

move to the "Delete" button, and press "Enter". 

4) Polaris MINI prompts, "Are you sure you want to delete the (added account 

name) account? Yes".  

5) Press "enter" To delete it. Press "Space-Z" to cancel the deletion. 
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6.4 Receiving E-mail 

To check for new mail, press "Enter-N". You can also choose "Check for New 

Mail" from the "Message" menu. For POP3 accounts, the Polaris MINI displays 

"There are xx messages to receive. Now receiving." "x/y mail received;" 

"Successfully received x out of y message" is displayed. When the e-mail 

messages are downloaded from the server, the e-mail message list is displayed 

in the "Inbox".  

To cancel the download, press "F3" to move to the "Cancel" button, and press 

"enter", or press "Space-E".  

When receiving messages via an IMAP server, you can both check the newest 

mail, according to the number of messages you have it set to automatically 

receive in the "Set options" dialog, or you can ask the Polaris MINI to load older 

e-mail messages. To receive the newest e-mail messages, press "Enter-N" from 

the message list of the mailbox on which you are located. To receive previous 

mail, press "Backspace-P". You can also access "Get new mail" and "Get 

Previous mail" from the "Message" menu.  

In addition, when using IMAP, as you navigate the various mail boxes in an 

account, new mail is automatically received for each mail box as you open it.  

 

6.5 Reading Messages 

E-mail messages are displayed in the Inbox and other mailboxes with the 

following information: "Subject", "Date", "From" (Sender), "CC", "Message" (main 
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body of the e-mail) and "Attach" (displayed only for an e-mail with one or more 

attached files) you can move among the items by pressing "F3" or "Space-F3". 

If there is a file attached to the e-mail, an A is shown before the subject, and the 

number of attachments is announced as you navigate the message list. The 

Polaris MINI also indicates which e-mail messages have been read, and which e-

mail messages are unread. E-mail messages that have not yet been read have a 

dash placed in front of the subject.  

"Date" shows the date and time when the e-mail was received in the following 

order: day, month, date, and year. The time is displayed in the following order: 

hour, minute, and second using 24 hour time format.  

"From" shows the sender information; "From: (sender's e-mail address) you can 

save the e-mail id of the sender to your contacts in the "Address Manager" using 

the following steps: 

1) Press "Enter-I" when the sender is displayed. 

2) The "add address" dialog is opened, and "Name: (sender's user name or e-

mail address)" is displayed. 

3) Type the sender's name, or, if what is automatically filled in is acceptable, press 

"F3" to move to "confirm", and press "enter". The contact is saved, and you are 

returned to your previous position in the message list. 

You can also save the e-mail id of the carbon copy recipient (CC) to the Address 

Manager using the process described above. 
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You can move to the body of a message by pressing "F3". Or, you can press 

"enter" when "Subject", "Date", or "From" is displayed. When you press "enter", 

the entire message is automatically spoken. To interrupt reading, press 

"Backspace-enter". Navigate the message as you would a document in the "Word 

Processor". To return to the "Subject", press "Space-E".  

 Note: Messages in the Polaris MINI are opened as plain text. If you receive 

an html e-mail, you can access the links and other HTML content by 

viewing the message in the Polaris MINI's Web Browser. Open the 

message with the Web browser by pressing "Backspace-O", or by selecting 

"Open Message in Web Browser" from the "Message" menu.  

You can find and download attached files by tabbing to "Attach" on messages 

containing attachments.  

To save an attachment, move to the desired file name in the attachments list and 

press "Enter". You are prompted, "Attachments will be saved to 

/flashdisk/download. Do you want to change this location? No". Press "enter". The 

selected file is saved in the "download" folder on the "flashdisk". If you have more 

than one attachment you want to download, you can press "Enter-A" to select all 

attachments in the list, or press space on any number of individual files to select 

them.  

To change the download path: When you are prompted, "Attachments will be 

saved to /flashdisk/download. Do you want to change this location?", navigate to 

"Yes" and press "Enter". You are placed in the file list of the "Downloads" folder 

on the "flashdisk". Use normal file and folder navigation to locate the folder into 
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which you want to save the attachments. Press "Space" to select the folder in 

which to save the attachments, and press "Enter". * Note: when using IMAP, the 

message must be opened before you can navigate to the attachments.  

You can delete e-mail messages individually, or you can select multiple messages 

and delete them simultaneously. Press "Space-D" to delete the current message, 

or select multiple messages with "Space", then press "Space-D" to delete all of 

them.  

When you delete messages, they are automatically moved to the "Trash" folder, 

where they remain until you delete them from there, or until you empty the "Trash" 

folder. You can empty the "Trash" folder at any time by pressing "Enter-

Backspace-Q" or choosing 'Empty Trash' from the "Edit" menu.  

 Note: When messages are deleted from the "Trash" folder, they are 

permanently disposed of, and cannot be retrieved. 

6.6 Writing E-mail 

To write a new message, choose "Write New Message" from the "File" menu, or 

press "Enter-W" from the message list. "To:" is displayed on the Braille display. If 

you wish to use a different account from the default, Shift-Tab to the "Account" 

combo box, choose your desired account, and Tab back to the "To" field.  

Type the e-mail address of the recipient, or rather, the person to whom you are 

sending the message. If using US Braille, you must use computer Braille. To send 

to multiple recipients, place a semicolon between the e-mail addresses. 
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You can also add recipients from the address list by selecting "Look up Address" 

from the "File" menu or pressing "Enter-L". Type the last name of the desired 

recipient, and press "enter".  

Addresses matching your search are displayed. If you press "enter" without typing 

in the desired name, all of the addresses in your address list are displayed. If 

there is no matching address, "No match" is announced. Move to the desired 

address, and press "enter". You can select more than one address by pressing 

"Space", then enter to input all of them.  

When you are finished entering recipients in the "To" field, press "F3" to move to 

"CC:" and "BCC", and input any copy or blind copy recipients as described above. 

If you do not need to carbon copy anyone, you can skip to the next step. 

Press "F3" to move to "Subject", and type the subject of the e-mail message. 

Finally, press "F3" to move to "Message body:", and type the text of your e-mail 

message. Use the same input and editing methods as are used in the Word 

Processor.  

When you have finished writing your e-mail message, select "Send" from the "File" 

menu, or press "Enter-S" directly from your message. When the e-mail is finished 

sending, "Successfully sent new message" is displayed. If sending fails, the 

Polaris MINI displays "Unable to send message", often with a specific error 

explaining the reason for the inability to send the message. If this occurs, the e-

mail is saved in the "Outbox". 

To cancel e-mail message creation or sending, press "Space-E" or "Space-Z" and 

you are returned to the "Inbox". 
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6.6.1 Attaching a File 

To attach a file to a message, select "Attach File" from the "File" menu, or press 

"Enter-F" while writing an e-mail message. Use normal file and folder navigation 

keys to locate the file or files you want to attach.  

Press "enter" on the desired file to attach it. To attach more than one file, press 

"Space" to select each file you want to attach. * is displayed in front of the selected 

file names. Press "enter" To attach the selected files. Now, the "Attach" item is 

displayed in the tab order after the "Message body".  

 

6.6.2 Saving E-mail to the Outbox 

Messages are saved in the "Outbox" under 2 conditions: 

1. The user manually saves the e-mail to the "Outbox" for later sending. 

2. An e-mail is automatically saved to the "outbox" after it fails to send due to a 

network error or other reason. 

While writing a message, you can save by selecting "Save Mail in Outbox" from 

the "File" menu, or pressing "Space-S". A default file name is shown titled with 

the subject of the email. Press "Enter" to save the e-mail under the current file 

name, or type a new file name and change the path where the file is stored using 

the same method as in the "Save As" dialog of the Word Processor. 

 Note: If you choose to save the e-mail in a location other than 

"flashdisk/email/outbox", you cannot access the e-mail message in the 
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"Outbox". Thus, you cannot send the e-mail unless it is returned to the 

"Outbox" folder. 

While creating a "message", press "Space-E" or "Space-Z" To cancel writing the 

e-mail. The Polaris MINI displays "Currently writing mail. Save? Yes". Press Enter 

to save the message in the Outbox. To return to the "Inbox" without saving the e-

mail, press "Space" to change "Yes" to "No", and press "Enter". 

To send a message from the Outbox, "Shift-Tab" to the mailbox list, navigate to 

the Outbox, and Tab to the message list.  Press "Space-1" or "Space-4", to move 

to the message you want to send. 

If you want to send all the e-mails in the list: Press "Enter-a (dot 1) to select all. If 

you want to send individual messages, use normal selection commands to select 

them. Press "Enter" on "Send" from the "File" menu, or just press "Enter-S" from 

the outbox, and the messages are sent.  

 

6.7 Navigating Accounts and Mailboxes 

There are two ways to move to an account or mail box.  

You can access the accounts list or mailbox list by moving through the tab order 

until you reach "mailboxes" or "Accounts". Use "Space-1" or "Space-4" to move 

among the items in the list, and press "F3" to open the Account or mailbox.  

You can also use the following hot keys to navigate accounts and mailboxes: 

Go to next mailbox: Enter-3-4-5. 

Go to previous mailbox: Enter-1-2-6. 
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Next account: Backspace-dots-3-4-5. 

Previous account: Backspace-1-2-6. 

 Note: These hot keys are not available from the account list or mail box list.  

 

6.7.1 Managing Mailboxes 

You can create additional mailboxes in the "E-mail" folder for sorting and storing 

your messages.  

To create a new mailbox, from the Mailbox list, open the "Edit" menu and select 

"Create New Mailbox", or press "Enter-N" to activate this function directly. Type 

the mailbox name you want to create, and press "Enter".  

The Polaris MINI does not allow you to delete the "Inbox", "Sent", or "Outbox". 

However, you can delete folders/mailboxes you have created. 

To delete a folder/mailbox, navigate to the mailbox you want to delete in the 

Mailbox list, open the "Edit" menu and choose "Delete Mailbox". You can also 

delete the current mailbox in the list by pressing "Space-D".  

You can also rename mailboxes you have created. To do this, from the mailbox 

list, navigate to the mailbox you wish to rename. Open the Edit Menu and select 

"Rename mailbox", or press "Enter-R" to open the "rename mailbox" dialog 

directly. Type the new name for the folder mailbox, and press "Enter".  
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6.7.2 Copying and Moving to Mailboxes 

You can copy and move e-mails using the "Copy to Mailbox" or "Move to Mailbox" 

commands in the "Edit" menu. 

The "move/Copy dialog" contains the following: 

1) "Folder" list. 

2) "Create mailbox" Button 

3) "Delete mailbox" Button 

4) "Rename mailbox" Button 

5) "Confirm" Button 

6) "Cancel" Button 

 

To copy and move an e-mail to another folder, follow these steps: 

1) Select individual e-mails by pressing "Space", select a continuous group with 

"Enter-B" or select all with "Enter-A".  

2) Open the "Edit" menu, and press "SPACE-4", to move to "Copy to Mailbox" or 

"Move to Mailbox" and press "Enter". You can activate these functions directly 

from the message list by pressing "Backspace-C" for "Copy" and "Backspace-X" 

for "Move to".  

3) Polaris MINI displays "Folder list".  

4) Press "Space-4", to move to the folder into which you want to copy or move 

messages and press "Enter0.  
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5) The e-mail is moved or copied to the selected folder, and you are returned to 

the mailbox from which you activated the "Move" or "Copy" command. 

 

6.8 Advanced Message Features 

 

6.8.1 Reply and Reply All  

When you reply to an e-mail, you can edit or add a message to the original 

message, or add another recipient. Choosing "Reply" sends en e-mail to only the 

original sender. Choosing "Reply To All" sends an e-mail back to the original 

sender as well as all other recipients of the original e-mail.  

 1) From "Subject", "Date", or "Message body" of a message in the "Inbox", select 

"Reply" or "Reply All" from the "Message" menu, or press "Enter-R" or 

"Backspace-R" respectively. 

2) You are placed in the message body, which already contains the original 

message body of the received e-mail; below "--- Original Message ---".  

3) You can type additional text, edit the original message, and/or edit any of the 

fields associated with the message including the subject and recipient fields. 

4) When you have finished, press "Enter-S" to send the e-mail. 

You can save replies just as you can save new messages in the "Outbox" for 

sending later. 
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6.8.2 Forwarding a Message 

"Forwarding" refers to sending an e-mail you received to another person.  

1) From the "Subject", "Date", or "Message body", open the "Message" menu and 

select "Forward", or press "Enter-F". 

2) Polaris MINI displays "To:". Input the e-mail address of the new recipient, or 

multiple recipients, using computer Braille. 

3) Press "F3", to move to "CC", "BCC", and "Subject" and edit them as you wish. 

The subject will appear as "FW: (original subject)". 

4) "Tab" to the message body. The original e-mail message is shown following, "-

---- Forwarded Message -----". 

5) Type any additional text you wish to add to the message, or make any edits to 

the forwarded text, and press "Enter-S" to send.  

If you don't want the e-mail to appear in the same message body as the e-mail 

you are writing, you can also forward the current e-mail as an attachment. Use 

"Backspace-W" to send the current e-mail as an attachment, then use the process 

described above. 

 

6.8.3 Saving an E-mail  

There may be times when you wish to save a received message as a file. Please 

note that there is a small difference between IMAP and POP3.  

1) Using Pop3: when placed on one of the fields of an e-mail message you want 

to save, select "Save as Text" from the "File" menu, or press "Space-S". 
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2) Polaris MINI displays "File name: (subject of e-mail being read.txt".  

3) Press "Enter" to save the message under the current file name. If you wish, 

you can rename the file using the same method as in the "Save As" dialog of the 

"Word Processor".  

If you are using IMAP, you must first navigate to and open the message before 

you can save it. Otherwise the steps are exactly as those above. 

 

6.8.4 Finding Messages 

The "Find" command is used to search for messages in the current mailbox. The 

"Find" function looks for text that matches the text you enter in "Subject", "Date", 

and/or "From". This function only works in the "Subject", "Date", or "From" 

controls. Use "Space-F" to open the "Find" dialog, or open the "Edit" menu and 

press "Enter" on "Find".  

Use "F3" and "Space-F3" to move among the controls. Type the text to search in 

the Edit box. Choose what parts of the message to "Search". Choose the direction 

to search, and press "Enter".  

The "Find Again" command finds the next occurrence of the text according to the 

search text and direction specified in the "Find" dialog. As with "Find", the "Find 

Again" function only works in the "Subject", "Date", or "From" fields. Open the 

"Edit" menu and press "Enter" on "Find Again", or press "Backspace-F" from the 

message list. 
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6.8.5 Move to Next Unread Message 

The "Move To Next Unread Message" command allows you to move to the next 

unread message. If you use this function on the last unread message in a list, you 

are taken to the first unread message in the list.  

To activate this function from the "Subject", "Date", or "From" field, open the "Edit" 

menu and select "Move to next Unread Message" or press "Enter-U" to activate 

this function directly.  

 

 

6.9 Using the Tools Menu 

In addition to the "Accounts Manager", the "Tools" menu contains options for 

setting the save path, spam filters and other e-mail options.  

 

6.9.1 Set Path 

"Set Path" sets the default download path where file attachments and e-mail are 

stored. To set the download path, open the "Tools" menu and press "Enter" on 

"Save Path", or press "Enter-P" from the message list. 

The "Set Path" dialog contains three settings: 

1) Save attachments path 

2) Send attachments path 

3) Disk to save mail in 
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You can move among these items by pressing "Space-4" and "Space-1". Each 

item consists of "Path", "Modify", and "Close". At "Path", the default path is 

displayed. You can move among this information by pressing "F3" or "Space-F3". 

If you choose to modify any path, use normal file management navigation to locate 

your desired folder, and press "Enter". 

 

6.9.2 Set Options  

To open the "Set options" dialog, press "Enter" on "Options" from the "Tools" 

menu, or press "Enter-O" to activate this item directly. 

The first item in the "Set options" dialog is "Default server?” You can set the 

default server to "IMAP" or "POP3". Use "Space" to change the value of the 

setting. 

The next item in the "Set Options" dialog is "Use inbox as default mailbox when 

using POP3 server? Yes.". If you want the e-mail program to always place you in 

the "inbox" when starting e-mail using POP3, leave this setting as is. If you would 

like to use a different mailbox, press "Space" to change this option to "no".  

The next option in the dialog is "Get the number of mail at once when using IMAP". 

The default is set to 64. Use "Space" or "Backspace" to cycle through the various 

options. The available values are All, 32, 64, 96, and 128. 

When you have finished adjusting the settings, press "Enter" to save the options, 

or tab to the "Confirm" button and press "Enter". If you do not wish to save your 

changes, tab to the "cancel" button and press "Enter" or press "Space-Z".  
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6.9.3 Spam Settings 

When the Polaris MINI downloads e-mail from the e-mail server, there may be a 

number of e-mail messages that are spam. In this case, you can avoid 

downloading these spam e-mail messages by identifying specified words in the 

subject or specifying e-mail addresses you know are from spammers. 

The spam e-mail messages that are identified by your "Spam Settings" are not 

downloaded into the Polaris MINI, and remain on the e-mail server. 

Use the following steps to set spam e-mail filters: 

1) Open the "Tools" menu and select "Spam Settings", or press "Enter-E" to 

activate this item without accessing the menus. 

2) The "Spam Settings" dialog contains 6 items: "Type" combo box, "List", "Add" 

button, "Modify" button, "Delete" button, and a "Close" button. 

3) "Type" can be set to 1 of 3 options: "Subject", "E-mail address string", and 

"Host". You can move among these options by pressing "Space-1" or "Space-4". 

The "list" is displayed according to the "Type" you choose. 

— If you have selected "Subject", the list is displayed as "Subject: (Registered 

word) 1/xx". If you selected "E-mail address string", it is displayed as "E-mail 

address string: (Registered e-mail address string) 1/xx". It is displayed as "no 

items" if there is no registered word or e-mail address string. 

 

How to register Spam Settings: 
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1) Press A when "Type: Subject 1/3" is displayed. Or, press "F3" to move to the 

"Add" button, and press "enter". 

2) The "add dialog" is opened and "Subject add:" is displayed. 

3) Type the words, by which you want to identify spam messages and press 

"Enter". Or, "Tab" to the "Confirm" button, and press "enter".  

4) "Successfully added spam data". is announced and you are returned to the 

"list". "Subject: (registered word) 1/1" is displayed. 

By adding the word in the manner just described, if there are e-mail messages 

that include the words you entered in the subject of the message, the Polaris MINI 

downloads those e-mails from the e-mail server, but deletes them automatically.  

You can also avoid receiving e-mail messages from a specific sender or host by 

registering it in the same manner. 

To cancel setting spam filters from the "Add dialog", press "F3" to move to the 

"Cancel" button, and press "Enter". Or, press "Space-E" or "Space-Z".  

 

To modify a spam filter you have set, do the following: 

1) Access the "Spam Settings" dialog as described previously, and navigate to 

the "Type" of spam setting you want to modify by pressing "Space-1" or "Space-

4".  

2) Press "F3" to move to the list of registered items in that category.  

3) Navigate to the item you want to modify using "Space-1" or "Space-4".  
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4) Press M, or press "F3" to move to the "Modify" button, and press "Enter".  

5) Make the modifications in the edit box. 

6) Press "F3" to move to the "confirm" button, and press "Enter" to save the 

changes.  

 

You can also delete an item that has been registered in the spam list.  

1) Access the "Spam Settings" dialog as described previously, and navigate to 

the "Type" of spam setting you want to delete by pressing "Space-1" or "Space-

4".  

2) Press "F3" to move to the list of registered items in that category.  

3) Navigate to the item you want to delete using "Space-1" or "Space-4".  

4) Press D or press "F3" to move to the "Delete" button, and press "Enter". 
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7. Media  

The "Media" menu on the BrailleSense Polaris MINI consists of programs related 

to media playback: specifically music, videos, and DAISY content. The "Media" 

menu contains 3 items: "Media Player", "FM Radio", and "DAISY Player".  

You can open the "Media" menu by pressing "F1" to bring up the main "Program" 

menu, then navigating to "Media" using the DOWN scroll key and pressing 

"Enter". Or, you can quickly jump to and open the "Media" menu by pressing M 

from the main menu. 

 

7.1 Media Player 

You can use the Media Player to play audio files as well as listen to the audio for 

some video file formats. The Media Player plays the following formats, ac3, asf, 

asx, m3u, mp2, mp3, MP 4, mpa, mpg, ogg, pls, wav, wax, wma, flac, midi and 

wmv.  

You can control the playing of media files using either Braille keyboard commands 

or the media buttons on the front panel of the Polaris MINI. To launch the "Media 

Player", navigate to it in the "Media" menu and press "Enter". Or, launch it from 

anywhere on the unit by pressing "F1-M". 

 

7.1.1 Using the Media Buttons 

Near the center of the front panel on the Polaris MINI is a group of 5 buttons. 

These buttons can be used to control the Media Player. Moving from left to right, 

the buttons are: "Back", "Record", "Stop", "Play/Pause", and "Forward".  
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The media buttons can control media playback, DAISY content playback, or 

application operation, depending on the position of the Media Mode switch, 

located to the left of the media buttons. Slide this switch to the right-most position, 

"Media Mode", to control media playback.  

If the "Play/Pause" button is pressed while you are using another program on the 

Polaris MINI, the unit opens the Media Player and begins playing the files in the 

most recently played list. If there are no files in the playlist, the Polaris MINI says, 

"There are no items to display". "Back", "Stop", and "Forward" are available after 

audio playback is started.  

 Note: As the Polaris MINI is able to multi-task, initiating audio playback with 

the "Play/Pause" button does not close the program you were running when 

you pressed it. To return to your former position, press "F2-F3" to cycle 

through the running programs until you reach your former location.  

A playlist can contain only 1 file, or many files. If there is more than one file in the 

playlist when you press the "Play/Pause" button, the Polaris MINI plays all the 

files in the list one after another. If you press the "Play/Pause" button during 

playback, audio playback is paused. To resume playing, press the button again. 

If you press the "Play/Pause" button while you are in the "Record" dialog, the most 

recently recorded file is played.  

If you press the "Forward" button, the next file in the playlist is played, and 

pressing the "Back" button plays the previous file. If you press the "Forward" 

button (while the last file in the list is playing, (or the "Back" button (while the first 

file in the list is playing), it has no effect, as there is no file to navigate to.  
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You can use the "Record" button to create a recording using the internal 

microphone or an external microphone from anywhere on the unit provided the 

Media Mode switch is set to the right-most position. Pressing the "Record" button 

once opens the "Record" dialog. Press the "Record" button again to start 

recording. Press the "Record" button while you are recording to pause recording. 

Resume recording by pressing the "Record" button one more time. Press the 

"Stop" button to stop and save your recording. The recorded file is saved in the 

"flashdisk/music/record" folder.  

The "Stop" button is located in the center of the group and has a dot on it. It is 

used to stop playback or recording.  If you press "Stop" during audio playback, 

the next time media playback is launched, the Polaris MINI starts playing the first 

file in the playlist. If you press this button while recording, the Polaris MINI stops 

and saves the recording. If you press the "Stop" button in the "Record" dialog 

when not recording, the dialog closes. 

 

7.1.2 Media Player Layout 

You can use the Braille keyboard to perform the same functions as the media 

buttons as well as more advanced features in the Media Player.  

The playback dialog contains two information tabs: "playback information" and 

"playlist". Press "F3" or "Space-F3" to move between these tabs. 

The "playback information" tab displays the track number, the file name, and the 

current playback status: (play, pause, or stop). If there are no files in the playlist, 
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the Polaris MINI displays "Title: There are no items to display". If you press 

"Space-4", the Polaris MINI displays playback time information.  

When in the Playback tab, you can use the cursor routers to jump to specific areas 

of the media file. For example, if you want to move to a place near the middle of 

the file, press cursor router 16 or 17. If you want to move to a place near 75%, 

press cursor router 24 or 25. 

The "playlist" tab displays all the files in the playlist. For each file in the playlist, it 

displays the track number, file name, the location of the file in the list, and the total 

number of files in the list. If there is no file in the playlist, the Polaris MINI displays 

the message "no items". 

The Polaris MINI's Media Player supports the viewing of lyrics for MP3 files which 

contain them. The "Lyrics tab appears in the tab order only if the file you are 

playing contains lyrics in its file information. The lyrics are displayed in a multi edit 

box which you can read and navigate using normal document navigation 

commands.  

The Media Player menu contains five items: "File", "Play", "Record", "Position", 

"Mark" and "Settings".  

To open the Media Player menu, press "Space-M" or "F2". Select a menu item 

using "Space-1" or "Space-4" and press "Enter". Or, you can press "Space-M or 

"F2" followed by the shortcut for the corresponding menu item. For example to 

open the Record menu, press "Space-M" or "F2" to open the menu, and press R.  
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The Media Player also contains various lists and dialog boxes. Use "Space-1" and 

"Space-4" or the Up and Down scroll keys to navigate menus, settings or file lists. 

Use "Space-4-5" and "Space-1-2" or "F3" and "Space-F3" to tab among controls 

in a dialog. For the purposes of these instructions, we will generally refer to using 

"F3" and "Space-F3" or simply "Tab". However, in these instances, "Space-4-5" 

and "Space-1-2" can also be used. Press "Enter" to execute an item. 

 

7.1.3 The File Menu 

1) Open File: (O) "Enter-O". Opens a media file and creates a new playlist. 

2) Open Folder: (F) "Enter-F". Creates a new playlist with all the media files in the 

selected folder. 

3) Add File: (A) "Backspace-O". Adds the selected files to the current playlist. 

4) Add Folder: (I) "Backspace-F". Adds all the media files in the selected folders 

to the current playlist. 

5) Save Playlist: (S) "Space-I". Saves the current playlist. 

6) Save As Playlist. Saves the currently playing files as a playlist. 

7) Delete Item: (D) "Space-D". Deletes the current item from the playlist. 

8) Tag Information: (T) "Enter-T". Opens the properties for the current media file. 

9) Open URL: (U) "Enter-U". Opens a website for streaming playback. 

10) Exit: (Z) "Enter-Z". Exits the Media Player. 
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7.1.4 The Play Menu 

1) Play (P) "Enter". Initiates playback. You can also press the "Play" button. 

2) Previous Track: (B) "Dot-3". Moves back 1 track. You can also press the "Back" 

button. 

3) Next Track: (N) "Dot-6". Moves forward 1 track. You can also press the 

"Forward" button. 

4) Back 5 Tracks: (D) "Dots-2-3". Moves back 5 tracks. 

5) Forward 5 tracks: (U) "Dots-5-6". Moves forward 5 tracks. 

6) First Track: (T) "Dots-1-3". Moves to the first track in the playlist. 

7) Last Track: (E) "Dots-4-6". Moves to the last track in the playlist. 

8) Volume Up: (H) "Space-Up Scroll". Increases the volume. 

9) Volume Down: (L) "Space-Down Scroll". Decreases the volume. 

10) Speed Up: (K) "Dots-3-4-5". Increases the playback speed. 

11) Slow Down: (M) "Dots-1-2-6". Decreases playback speed. 

12) Pause: (A) "Space". Pauses playback. Press again to resume. You can also 

use the "Play" button. 

13) Stop: (S) "Backspace". Stops playback. You can also use the "Stop" button. 
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7.1.5 Making Recordings  

1) Record: (R) "Enter-R". Places you in standby mode. Press again to initiate 

recording. Press "Space-Z" when finished. You can also use the "Record" button 

to start recording and the "Stop" button to finish. 

 

7.1.6 The Position Menu 

1) Mark Position: (M) "Enter-M". Marks the current position for later use. 

2) Delete marked Position: (D) "Enter-D". Unmark the marked position. 

3) Jump to Marked Position: (J) "Enter-J". Go to the position previously marked. 

4) Go to Time: (G) "Enter-G". Go to a specific time in the file.  

5) Go to Percent: (E) "Backspace-P". Move to a place in the file according to it's 

percentage. 

6) Set Start Point: (L) "Enter-P". Set a start point for repeat play. 

7) Release Point: (R) "Space-E". Set the end point for repeat playback. 

 

7.1.7 The Mark Menu 

1) Set Mark: (S) "Backspace-M". Bookmark a specific point the media file.  

2) Jump to Mark: (M) "Backspace-J". Move to a previously set mark. 

3) Previous Mark: (P) "Backspace-dot-3". Moves back one mark from your current 

position. 

4) Next Mark: (N) "Backspace-dot-6". Moves to the next mark after your current 

position. 
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5) Delete Mark: (D) "Backspace-D". Deletes a mark. 

6) Mark Manager: (K) "Backspace-K". View and modify all marks in the current 

file. 

 

7.1.8 The Settings Menu 

1) Configuration: (C) "Backspace-C". Lets you configure file information display, 

and exit position saving. 

2) Playback Settings: (P) "Enter-S". Settings for Repeat Shuffle and other playlist 

settings.  

3) Record Settings: (R) "Backspace-S". Choose recording source, file type, 

sample rate, bitrate, etc. 

4) Effect Settings: (E) "Enter-E". Set Equalizer and bass boost. 

   

7.2 FM Radio 

To use the "FM Radio" on the Polaris MINI, you must connect headphones to the 

headphone jack on the unit, as the headphone cord serves as the antenna, and 

without it, radio reception will be poor to nonexistent.  

From the Media menu, use the scroll buttons to navigate to "FM Radio" and press 

"Enter". You can also press R to quickly jump to and launch the "FM Radio". You 

can launch the "FM Radio" from anywhere on the unit by pressing "F1-R".  



   124  

When the FM Radio is launched, your Polaris MINI announces the radio 

frequency. If you have used the FM Radio program previously, the Polaris MINI 

tunes to the frequency that you last listened to. 

 Note: the frequency range of the FM Radio is 87.5MHz to 108MHz. 

 

7.2.1 Listening to FM Radio via the Internal Speakers 

When you execute the FM Radio after connecting headphones, sound from the 

radio is directed through the headphones. As previously explained, it is necessary 

to connect the headphones to provide an antenna for radio reception. However, 

there may be times when you wish for the sound from the radio to output through 

the speakers on the Polaris MINI. To listen to the radio through the internal 

speakers, press X, to toggle internal speaker output on/off.  

You can adjust the radio volume using Space with the Up and Down scroll buttons.  

 

7.2.2 Frequency Control 

To tune to another frequency, use the following commands: 

Press "dot 5" to scan forward for the next radio station, and "dot 2", to auto scan 

backward. Press "dot 6", to increase the frequency by0.1MHz, and "dot 3", to 

decrease the frequency by0.1MHz. Press "Space-F" to input the frequency 

directly. Type the frequency in numbers in the edit box and press "Enter".  

You can also use the media buttons on the front panel to control the FM Radio. 

The Media mode switch should be moved to the left-most position, "Application 
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Mode." Pressing the "Back" button scans backward, and pressing the "Forward" 

button scans forward. 

You can also activate frequency movement commands from the "Frequency" 

menu. 

 

7.2.3 Adding and Navigating Presets 

To add the currently selected frequency as a preset, select "Add Preset" from the 

"Presets" menu, or press "Enter-S".  

The "add preset" dialog is opened and "Frequency: (current frequency)" is 

announced. "Tab" to the "Label" edit box. Type the name by which you want to 

identify the preset. Press "Enter" to save the preset. 

To add a frequency other than the one you're currently listening to, you may type 

the number of the frequency you wish to add in the "Frequency" edit box of the 

"add preset" dialog.  

You can navigate your presets by using "dot 1" to move back, and "dot 4" to move 

forward a preset.  

To delete a preset, navigate to the preset and press "Space-D".  

 Note: when this command is executed, the preset is deleted instantly 

without any warning or verification.  

You can also add and delete presets using the Preset Manager dialog. Select 

"Preset Manager" from the "Presets" menu, or press "Enter-M".  
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The Preset Manager dialog contains the "Preset list", an "Add" button, a "Delete" 

button, a "Modify" button and a "Close" button.  

Pressing "Enter" on the "add" button opens the "add preset" dialog explained 

above. The "Modify" dialog lets you change the label of the current preset in the 

list. Use the "Delete" button to delete a preset from the preset list. To exit the 

Preset Manager" dialog navigate to the "Close" button and press "Enter" or press 

"Space-E".  

You can also use the media buttons on the front panel to add and move among 

presets. Press the "record" button for more than 2 seconds, to open the "add 

preset" dialog. To move to the previous preset, press the "Back" button for more 

than 2 seconds. Pressing the "Forward" button for more than 2 seconds moves to 

the next preset. Pressing the "stop" button for more than 2 seconds deletes the 

selected preset. 

 

7.2.4 Recording from the FM Radio  

To record the audio of the radio station to which you are currently listening, Select 

"Record" from the radio's menu, or press "Enter-R". The "record" dialog is opened 

and the Polaris MINI begins recording. 

While recording the radio, "Tab" to the "Pause" button and press "Enter", or press 

A to pause recording. The name of this button is changed to "Continue". Activate 

the "Continue" button or press G, recording resumes. To stop the recording, press 

S. Or, "Tab" to the "Stop" button and press "Enter".  
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To check the duration of the current recording press "Space-4". The unit 

announces the current recording run time and total possible recording time.  

Recorded files are saved in the "flashdisk/music/radio" folder. The files are named 

according to the preset label and frequency. If you are recording a radio station 

that is not in your preset list, the recording is named "radio" followed by the 

frequency.  

You can also instantly start recording by pressing the "record" button on the front 

panel. Press the "Stop" button to stop and save the recording. Press the "Record" 

button again to pause and resume recording. Pressing the "Back" and "Forward" 

buttons moves among the controls in the "record" dialog.  

 

7.2.4.1 Changing record folder 

To change the folder where recorded files are saved, select "Recording Settings" 

from the "File" menu or press "Backspace-S". 

You are placed in the "Recording Settings" dialog on the first item, "Recording 

type: mp3". "Tab" to the "Record folder" setting. 

"Record folder: /flashdisk/music/radio" is displayed. Press "Enter". Use normal 

folder navigation to locate your desired folder for storing recorded files. Press 

"Space" to select it and press "Enter", and you are returned to the "Record 

Settings" dialog. Press "Enter" again to save the settings and exit the dialog.  
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In the Record Settings dialog, you can also set recording type, sample rate, and 

bit rate. To change the recording type, press "Space" to toggle between "wav" 

and "mp3". 

 

7.2.5 Additional Features 

1) Sensitivity adjustment 

If the Polaris MINI cannot tune to the broadcast frequency you desire, adjust the 

scanning sensitivity. Open the "Settings" dialog. Press "Space-4" to navigate to 

"Sensitivity" and press "Space" or "Backspace" to adjust the sensitivity. Higher 

values increase the scanning sensitivity of the radio. If the sensitivity is increased, 

you can fine tune to more frequencies. 

2) Mute 

While listening to the radio, press "Space" to mute the audio. Pressing "Space" 

once again unmutes the radio. You can also mute the radio by pressing the "stop" 

button on the front panel, and unmute by pressing the "play" button.  

 

7.3 DAISY Player 

Using the DAISY Player on the Polaris MINI, you can listen to files and read books 

that use the DAISY format. DAISY is an acronym for (DIGITAL ACCESSIBLE 

INFORMATION SYSTEM). One advantage to DAISY books is that you can listen 

to the audio as well as read the associated text with the audio in DAISY books 

where both text and audio are present.  
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The Polaris MINI supports DAISY books that are version 3.0 or earlier. The DAISY 

Player supports the following book types: 

DAISY 2.0/2.02/3.0, DAISY XML/Digital Talking Book. 

ANSI/NISO Z39.86 2002, 2005. 

Bookshare.org DAISY content,  

NIMAS 1.1  

DRM: supports 2006 PDTB2 authentication.  

 

7.3.1 Arrangement of the DAISY Player 

To launch the DAISY Player, press "Enter" on "DAISY Player" in the Polaris MINI 

"Media" menu. You can also launch the DAISY player from anywhere on the unit 

by pressing "F1-D".  

When you launch the DAISY Player, you are placed in Polaris MINI's drive list. 

Press "Enter" on the drive containing the DAISY book you want to open. 

Use normal folder navigation to locate the folder containing a DAISY book you 

want to open. Press "Space" to select it, then press "Enter" to open it. You must 

first select the folder containing the book, because a DAISY book contains 

multiple files, thus, Polaris MINI needs to know exactly from which folder to get all 

the book text and information.  

If you replay a book that you have listened to before, playback resumes from the 

location where you last exited. To stop playing a DAISY book, press "Space-Z". 
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A prompt box appears asking if you would like to exit the DAISY Player. Select 

"Yes" or "No" with "Space" or "Backspace" and press "Enter".  

You can also control DAISY playback using the media buttons on the front panel. 

The Media Mode switch must be set to the center position, "DAISY Mode". Start 

DAISY playback by pressing the "play" button on the front panel. Press "play" 

again to pause playback. Press the "Back" button to move back 1 navigational 

element, and press the "Forward" button to move forward by1 navigational 

element. Use the "Record" button to set the navigational element by which the 

"Back" and "Forward" buttons move.  

Open the DAISY Player menu by pressing "Space-M" or "F2". The menu contains 

"File", "Document", "Mark", and "Heading". You can navigate the menu items 

using "Space-1" and "Space-4". To activate a menu item, press "Enter".  

Or, you can press "Space-M or "F2" followed by the shortcut for the corresponding 

menu item. For example to open the "Heading" menu, press "Space-M" or "F2" to 

open the menu, and press H.  

The DAISY Player also contains various lists and dialog boxes. Use "Space-1" 

and "Space-4" or the Up and Down scroll keys to navigate menus, settings or file 

lists. Use "Space-4-5" and "Space-1-2" or "F3" and "Space-F3" to tab among 

controls in a dialog. For the purposes of these instructions, we will generally refer 

to using "F3" and "Space-F3" or simply "Tab". However, in these instances, 

"Space-4-5" and "Space-1-2" can also be used. Press "Enter" to execute an item. 
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While playing DAISY content, you are placed in a dialog in which four 

controls/components are available: "heading", "Information", "Play" and "Pause". 

"Tab" through this information using "F3".  

"Heading" shows you a prefixed heading or navigation element as well as the text 

under that element if text exists. In "information", you can find the current page, 

level, phrase, elapsed time, and running time. You can move among these items 

with "Space-1" or "Space-4". You can press "Enter" on "Pause" or "Play", to pause 

or play the audio. From anywhere in the dialog, you can also toggle play/pause 

with "Space". 

 

7.3.2 The File Menu 

1) Open DAISY: (O) "Enter-O". Calls the "Open DAISY" dialog. 

2) Voice Settings: (S) "Enter-S". Set auto playback settings as well as rate, pitch 

and volume of the reading voice. 

3) Book Info: (I) "Enter-I". Obtain information about the currently playing DAISY 

book. 

4) Exit: (Z) "Space-Z". Closes the DAISY Player. 

 

7.3.3 The Document Menu 

1) Play/Pause: (P) "Space-P". Pause and resume playback. You can also use the 

"Play" button. 

2) Previous Page: (U) "Dots-1-2-6". Moves back one page. 
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3) Next Page: (D) "Dots-3-4-5". Moves forward one page. 

4) Go To Page: (G) "Enter-G". Enter the number of the specific page you want to 

go to. 

5) Move by Previous Movement Unit: (H) "Dot-3". Move back by specified 

movement type. 

6) Move by Next Movement Unit: (L) "Dot-6". Move forward by specified 

movement type. 

7) Change to Previous Movement Unit: (I) "Dots-2-3". Cycle backward one 

movement type.  

8) Change to Next Movement Unit: (E) "Dots-5-6". Cycle forward one movement 

type. 

 

7.3.4 The Mark Menu 

1) Set Mark: (M) "Enter-M". Bookmark a position. 

2) Jump to Mark: (J) "Enter-J". Move to a previously set mark. 

3) Delete Mark: (D) "Space-D". Delete a previously set mark. 

 

7.3.5 The Headings Menu 

1) Headings List: (L) "Enter-H". Open the list of headings in the book. 

2) Scan for Next Heading: (N) "Enter-N". Move to the next available heading. 
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3) Read Current Heading: (W) "Enter-W". Read the heading under which the 

current text is located. 

4) First Heading: (T) "Dots-1-3". Move to the first heading. 

5) Last Heading: (B) "Dots-4-6". Move to the final heading of the book. 

6) Find: (F) "Space-F". Search for text. 

7) Find Again: (R) "Enter-F". Find the next instance of the search string you 

specified in the "Find" dialog. 

 

7.3.6 The Memo Menu 

1) Insert Memo: (M) "Backspace-M". Insert an annotation. 

2) Read Memo: (R) "Backspace-R". Read the current memo. 

3) Previous Memo: (P) "Backspace-P". Move back one memo from your current 

position. 

4) Next Memo: (N) "Backspace-N". Move to the next memo from your current 

position. 

5) Delete Memo: (D) "Backspace-D". Delete the current memo. 
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8. Organizer. 

The "Organizer" menu contains items to help you organize and synchronize 

appointments and contacts. It contains the "Address Manager", and the "Schedule 

Manager".  

Open the "Organizer" menu by navigating to "Organizer" in the main "Program" 

menu, or just by pressing "O from the main menu. 

 

8.1 Address Manager 

The "Address Manager" is a program you can use to keep track of your contact 

information for friends and colleagues, such as company addresses, home 

addresses, e-mail addresses, as well as other information. You can also 

synchronize your contacts with your Google account under Accounts in the 

Settings menu of All Apps. 

The "Address Manager" consists of two main dialogs: "Add Address" for entering 

contact information, and "Search Address" for retrieving this information.  

In the "Organizer" menu, you can quickly jump to an open the "Address Manager" 

by typing "a" or by navigating to the "Address Manager" and pressing "Enter".  

When the "Address Manager" is opened, the "Search Address" dialog is 

displayed. The Polaris MINI prompts, "Last name:"  

You can use the menus to conveniently browse and execute all of the available 

commands. To open the menu, press "Space-M" or "F2". Select a menu item 

using "Space-1" or "Space-4”, and press "Enter". Or, you can press "Space-M or 
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"F2" followed by the shortcut for the corresponding menu item. Use "Space-1" 

and "Space-4" or the Up and Down scroll keys to navigate menus, settings or file 

lists. Use "Space-4-5" and "Space-1-2" or "F3" and "Space-F3" to tab and Shift-

Tab among controls in a dialog.  

 

8.1.1 Adding an Address 

This dialog allows you to enter new contacts. Select "Add Address" from the 

menu, or press "Enter-I" directly from in the "Address Manager". 

The "Add address" dialog contains a list of 22 input fields, the "Memo" field, a 

"Confirm" button, and a "Cancel" button. In the input fields, enter the information 

corresponding to the 22 fields of a record. You can move from one field to the 

next using "Space-1" and "Space-4" or the up and down scroll keys. You do not 

have to fill in all the fields, simply leave blank those you do not need to use.  

If using US Braille, you can enter telephone numbers using computer Braille 

(without a number sign) or regular grade 1 Braille (with or without a number sign). 

To enter a dash, press "Space" or "dots 3-6". To put an extension number after 

any phone number, enter the phone number as described above, and then type 

a comma (,), followed by the extension number, as in "000-000-0000,100." In this 

case, Press "dot 6" to enter the comma in computer Braille or "dot 2" in grade 1 

Braille. When you enter a home page address or an e-mail address, you should 

also use computer Braille.  
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After filling in the desired information, Tab to the "Memo" field. You can type in 

multiple lines of text in the "Memo" field. If you do not wish to enter a memo, leave 

it blank.  

When you have entered all the relevant information, Tab to the "Confirm" button 

and press "Enter". Or, just press "Enter" from any field. To cancel the contact 

entry, Tab to "Cancel" and press “Enter". After canceling or adding an entry, you 

are placed in a new blank record.  

 

8.1.2 Setting Add Address Fields 

There are 22 fields in a record, but you may not want to enter information in every 

one of the 22 fields. You can use "Set Address Fields" to select only the fields that 

you need. 

To use this function, Select "Set Address Fields" from the menu, or, press "Enter-

O" from the "Add Address" dialog. On the right side of each field name, "used" or 

"unused" is displayed. The default value is set to "used". To toggle the value, 

press "Space". 

After setting all the fields you want to change, Tab to "Confirm" and press "Enter". 

To cancel changes, press "Space-E".  

 

8.1.3 Searching For an Address 

The "Search Address" dialog enables you to search for specific records in the 

"Address Manager". The "Search Address" dialog is opened automatically when 

the "Address Manager" is launched. To open "Search Address" from "Add 
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Address", you can either select it from the menu, or press "Enter-S" from the "Add 

Address" dialog. "Last name" is displayed as this is the first field in the address 

data.  

Type a last name to search for and press "Enter". Press "Enter" without entering 

text to search, and all records are shown. To search by a different field, navigate 

to it using "Space-4", type the search text in the edit box, and press "Enter".  

You can move among found records using "Space-1" and "Space-4". Press F3 on 

the record you wish to view. The information appears in a multi-line read box 

which you can navigate using normal text navigation commands. 

If a record contains an e-mail Address, you can press "Enter" to launch the e-mail 

program and send an e-mail to that person. If a field contains a web page, you 

can press "Enter" on it to open the page in the Web browser.  

When you enter text to be searched, you do not have to type the entire content of 

a field. For example, to find a record about "Edward", type in "ed" in the "search 

name" field. Then, all the records whose name field contains "ed" are found. 

 

8.1.4 Setting Searching Address Fields 

This option enables you to select the fields that you want to search. Select "Set 

Address Search Fields" from the menu, or press "Enter-O" from the "Search 

Address" dialog. 

All the address fields are displayed. Press "Space", to toggle the value of a field 

between "used" and "unused".  
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8.1.5 Backing up and Restoring the Address List 

If you perform a hard reset, or if your battery dies, all of the data in the "Address 

Manager" is lost. Thus, it is very important that you make a backup file every time 

you make a change to the address list. Select "Backup Address List" from the 

menu, or press "Enter-U" from anywhere in Address Manager.  

If you already have a backup file, you are prompted, "Backup file already exists. 

Continue to backup? Yes". If you have made changes to your address list, press 

"Enter" to create a new backup file. To keep the previous backup file press 

"Space-4", to move to "No", and press "Enter". When you create a backup file in 

your address list, you will have a new backup file in the database folder on the 

Flashdisk. 

To restore the address list after a hard reset, select "Restore Address List" from 

the menu, or press "Enter-R" from anywhere in Address Manager. 

If you already have an address list, you are prompted, "Address file already exists. 

Which do you prefer? Append". If you press "Enter", the backup address list is 

appended to the current address list. If you press "Space-4" once and press 

"Enter" on "Overwrite", the new backup file is restored, erasing the old backup 

file. 

You can backup your address list automatically using the "Set Backup Options". 

Select "Set Backup Options" from the menu, or press "Enter-E".  

The "Backup mode" has three radio buttons: "Always backup changes when 

exiting", "Manual backup", and "Prompt backup changes when exiting". Move 
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through the radio buttons using "Space" and "Backspace". Press "Enter" to save 

your setting. 

 

8.1.6 Importing from CSV 

"CSV" is the acronym for Comma Separated Value. A CSV file is used for the 

digital storage of data structured in a table form, with the information in the various 

columns separated using commas. The "Address Manager" can import a CSV 

contact file created using MS outlook or some cell phones. You can also export a 

CSV file of your contacts for use on other devices. 

To import the data from a CSV file, select "Import from CSV" from the menu, or 

press "Backspace-I" from anywhere in the Address Manager. Type the name of 

the file you want to import in the edit box. To browse for a file, "Shift-Tab to the 

path search list, and use normal file navigation commands to choose your file and 

press "Enter".  

When the CSV file is imported, "Last name: unused 1/xx" is displayed. You can 

choose whether the data from the CSV file for each field should be imported. 

Some CSV files may contain data that is not equivalent to any of the fields in the 

"Address Manager", or you may simply not wish to import certain pieces of 

information.   

This dialog contains all the fields in the "Address Manager", a check box for 

allowing fields in the first record, and "Confirm" and "Cancel" buttons. Tab and 

Shift-Tab among these items.  For each "Address Manager" field, there is a list 

box containing "Unused" and all of the fields of the CSV file being imported. Use 
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"Space-1" and "Space-4" to move among the fields. If there is no equivalent field 

in the CSV file for an "Address Manager" field, select "unused".   

Often, the first set of fields in a CSV file represent field titles. For this reason, there 

is a check box for allowing fields in the first record to be imported or not. If the first 

set of fields does contain title data, make sure that the "allow fields in first record" 

item is not checked.  

To complete the import, Tab to "Confirm" and press "Enter". You are prompted, 

"Address file already exists. Which do you prefer?" The default value is 

"Overwrite". The setting values are "Overwrite" and "Add". You can either replace 

the existing file with the data imported from the CSV file, or you may add it to the 

existing address list. To change the setting value, press "Space", and press 

"Enter" to save the data. 

 

8.1.7 Exporting to CSV 

To export address data to CSV, select "Export to CSV" from the menu, or press 

"Backspace-X". Type a file name for the exported data and press "Enter". To 

change the location where the file is stored, Shift-Tab to the file list and use normal 

file and folder navigation to select the location.  

 

8.1.8 Editing, Saving, and Deleting Addresses 

To edit information in a record, find the desired address by using the "Search 

Address" function. Select "Modify Address" from the menu, or press "Enter-M" to 

activate this command directly. You can now enter new information in any of the 
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fields. When you have modified the information, press "Enter". The Polaris MINI 

saves the changes, and you are returned to your previous position. You can press 

“Space-E” to cancel the modification. 

To delete the record you are currently reading, select "Delete Address" from the 

menu, or press "Space-D" while viewing the record. You can also delete more 

than one record at a time by first selecting individual records with "Space", or by 

selecting all records with "Enter-A". 

You can also save selected records to a file. Select "Save addresses As File" from 

the menu, or press "Enter-T" from the "Search Address" dialog. The "file save" 

dialog is displayed and you are asked to enter the file name and select a file 

format. After you type the file name, and select one of the available file formats, 

press "Enter" on "Confirm", and the selected records are saved.  

 

8.1.9 Syncing Contacts 

Contacts entered or imported into the Polaris MINI can be synchronized with your 

Google Account, and thus also, any other accounts that synchronize with your 

Google Account. 

You can set your sync preferences in the Android System Settings, under the 

accounts item, then Google. All of your Google accounts are listed and identified 

whether Sync is enabled. Press Enter to open a dialog in which you can choose 

what items you would like to have synced. If you choose to sync your contacts, 

they are automatically synchronized when you make changes. You can also 

manually “Sync Now” in the More options menu of the Accounts dialog. 
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Note: if you make too many changes, such as when importing a CSV, or 

synchronizing many new contacts, you may receive “Sync Errors”. If this occurs, 

press Space-1-2-3-4-5-6 to open the Notification Shade, and press Enter to open 

the error. From there, you are given options as to how you would like to handle 

the errors. 

 

8.2 Schedule Manager 

The "Schedule Manager" is a program used to manage information about 

appointments, anniversaries, and events. It can also inform you of appointments 

at a specified time using alarms. You can start the "Schedule Manager" from the 

"Organizer" menu, by navigating to it with "Space-4" and pressing "Enter". You 

can launch the "Schedule Manager" from anywhere on the unit by pressing "F1-

S".  

The "Schedule Manager" has two main dialogs: "Add appointment" and "Search 

appointments". In "Add appointment", you can enter information for a new 

appointment. Using "Search appointments", you can look for information about a 

specific appointment and edit or delete the information.  

When the "Schedule Manager" is opened, the "Search appointments" dialog box 

is displayed. You are prompted for a "Find date:" with the current date filled in as 

the default. To add a new appointment, select "Add appointment" from the menu, 

or press "Enter-I" from the "Search appointments" dialog. 

 Note: Due to the nature of appointments, it is very important that dates and 

times are entered correctly to ensure that your schedule is accurate and 
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you are alerted to your appointments at the proper times through the 

"Check Today's SCHEDULE" option as well as the alarms that can be 

associated with appointments. Please be sure your time and date are set 

correctly. (See section 3.1)  

 

8.2.1 Adding an Appointment 

To add a new appointment, press "Enter-I" from the "Search appointments" 

dialog. The "Add appointment" dialog has a set of input fields, a "Confirm" button, 

and a "Cancel" button. Use "F3" and "Space-F3" to move through the controls. 

When you start "Add appointment", you are prompted to choose the appointment 

type. Use Space-1 or Space-4 to choose between “Anniversary” or “Appointment”. 

The next field is the "Start date" edit box. To use the date displayed, Tab to the 

next field. To enter a new date, type month/day/year.  

 Note: If you have not searched for an appointment, or have searched by 

subject, the default "Start date" is today's date. If you have searched 

appointments by date, it is the last date for which you searched. 

Tab to the "Start Time" field. By default, this field shows the current time. Enter 

the time as hhmm or use navigation keys to select your appointment time. If you're 

using "12 hour" format, press "Space-X" to change between am and pm. 

The next field is the end date. By default, the end date is the same as the "Start 

date". To use this date, Tab to the next field. To enter a new date, type 

month/day/year. 
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By default, the end time is the same time as you set in the "Start time" field. To 

change the time, type the time as hhmm. 

The next field is the subject of the appointment. If you do not enter anything in this 

field, you cannot save the record. If you press "Enter" after typing in the subject, 

the record is saved, leaving the "Location" and "Memo" field empty, and the 

"Alarm time" field set to its default value ("Time of appointment"). Type your 

subject and Tab to the next field. 

Type the location of your appointment. Press “Enter" to save the appointment, or 

Tab to the next field. 

In the "Memo" field, you can enter detailed information about an appointment. 

This is a multi-line edit box, meaning you can type more than one line of text. You 

can use most of the editing commands that are used in the "Word processor". You 

can leave this field blank if you wish. 

The "Alarm time" function allows you to set when you are reminded about an 

appointment. The alarm is set relative to the appointment time. For example, you 

may want the alarm to sound 30 minutes before your appointment, so that you 

are not late. The default value for this field is set to "Time of appointment".  

The time can be set anywhere from one minute to two weeks before the 

appointment. Use the same navigation keys as when setting the time and date. If 

you do not wish to have an alarm reminder, press "Space-1" to "Alarm off". After 

setting the "Alarm time", press "Enter" to save the appointment.  
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8.2.2 Setting a Recurring Appointment 

Set this option when the appointment you are creating recurs at regular intervals. 

If it is unchecked, the appointment is set to occur once. To set a recurring 

appointment, check this box with "Space", then Tab to the resulting combo box 

for setting the recurrence pattern. You can select from "Daily", "Weekly", 

"Monthly" and "Yearly". 

If you select "Daily", Tab to the "Recurring interval of day" edit box. You can type 

a number between 1 and 999 to represent the number of days between 

recurrences. If you enter 1, the appointment recurs every day, and if you enter 2, 

it recurs every other day. Be sure the difference between the start and end date 

is shorter than the recurring interval value.  

Tab to the "Set recurrence end date" check box. By default, it's unchecked, which 

indicates that the appointment recurs indefinitely. If you check this box, an edit 

combo box for entering the end date appears in the tab order. 

If you set the "Recurrence" to weekly, Tab to the "Recurring interval" edit box, and 

type the number of weeks between appointments in numbers from 1 to 999. As 

with daily, the appointment duration should be shorter than the recurring interval.  

Tab to a list box where you can select the day of the week on which the 

appointment recurs. To select or unselect the current item, press "Space". You 

can make more than one selection, thus the appointment recurs on more than 

one day during the week. If you don't select a day, it is set to the today's week 

day.  
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If you set the "Recurrence to monthly", Tab to the "Recurring type" combo box. 

You can set the recurring type as "Date" or "Day of the week". "Date" is used 

when you want to set an appointment recurring on the same day of a month, for 

example, on the 17th of every month, or every other month. On the other hand, 

"Day of the week" is used when you want to set an appointment recurring on the 

same week and day of the week of a month, for example, on Wednesday of the 

second week of every month. After selecting the "Recurring type", Tab to the 

"Recurring interval", and type a number of months between appointments in 

numbers from 1 to 999.  

Different fields are shown in the Tab order depending on what you have selected 

in "Recurring type". If you set the "Recurring type" to "Date", an edit box appears 

for typing the day of the month for the recurrence. By default the "Start date" is 

shown. Tab to "Set recurrence end date" and make your choices. 

If you set the "Recurrence" to "Yearly", Tab to the "Recurring type" combo box. 

Select either "date" or "day of the week". If you set the "Recurring type" to "Date", 

you can set the month and the day of the month when the appointment recurs. If 

you set it to "Day of the week", you can set the month, the week, and the day of 

the week when the appointment recurs every year. After setting "Recurring type", 

Tab to the "Month for recurrence" combo box. Select the month of the year using 

"Space-1" or "Space-4". From here, different fields appear in the tab order 

depending on how you have set the "Recurring type".  

If you have set the "Recurring type" to "Date", the focus moves to "Day of 

recurrence" edit box. You can type a number between 1 and 31. Then, Tab to the 
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"Set recurrence end date" check box. If the "Recurring type" is set to "Day of the 

week", you have to set "recurring week" and "Day of week for recurrence".  

 

8.2.3 Search Appointments 

When you start "Schedule Manager", the "Search appointments" dialog is 

opened. You can also open this dialog from the "Add appointment" dialog, by 

pressing "Enter-S" or selecting "Search appointments" from the menu. There are 

two methods for searching an appointment: "searching by subject" and "searching 

by date".  

When "searching by subject", you can find an appointment using keywords in the 

subject field. When "searching by date", you can find appointments according to 

a specified date. To toggle the search mode, Select "Toggle Search Mode" from 

the menu, or press "Enter-F". The last search mode you used is saved when you 

exit the Schedule Manager.  

When you search by date, by default, the Polaris MINI searches for appointments 

occurring today. To search for another date, type the date in the format 

"mm/dd/yyyy", or use the "move by date" hotkeys. Press "Enter", and the 

appointments occurring on the chosen day are shown. If there is no appointment 

on that day, the unit announces, "There is no appointment registered".  

The first appointment is announced in the form of "date, time, and subject". If the 

appointment lasts for more than one day, "continuous schedule" is announced. If 

the appointment recurs, "recurring schedule" is announced. If you scheduled 

more than one appointment for that day, move among the appointments using 
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"Space-1" or "Space-4". To move to the first appointment, press "Space-1-3", and 

to move to the last appointment on that day, press "Space-4-6".  

To move to the appointments on another day, press "Space-2" or "Space-5". The 

previous/next appointment occurring within four months is displayed. To move to 

the first appointment stored in the Schedule Manager, press "Space-1-2-3", and 

to move to the last appointment stored in the Schedule Manager, press "Space-

4-5-6". To obtain details on an appointment, press "Enter".  

To search by subject, type in the keywords to search and press "Enter". All 

appointments with the keywords are displayed. If you press "Enter" without typing 

text, Polaris MINI displays all appointments in the “Schedule Manager". 

To move to the next or previous appointment, press "Space-4" or "Space-1" 

respectively. Pressing "Space-1-3" and "Space-4-6" move to the first and last 

items in the appointment list. 

For recurring appointments and multiple day appointments, the Polaris MINI only 

shows the appointments of the first day if you search the schedule by subject. 

Press "Enter" on an appointment to read the details. Press "Space-E" to return to 

the appointment list. To search other keywords, Tab to the "Search subject" edit 

box, and type new search text. 

 

8.2.4 Editing, Saving, and Deleting Appointments 

To modify an existing appointment, move to the appointment and select "Modify 

Appointment" from the menu, or press "Enter-M" from the search results list. If the 

appointment is a recurring schedule, a prompt, displaying "Recurrence 
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appointment. Open type?" appears. Choose whether you want to modify the 

recurring appointment or the appointment for a specific day. If you select "This 

occurrence", your changes affect the appointment of the day, but the recurring 

appointments on other days are not changed. If you select "The series", your 

changes affect all the recurrences.  

The "Modify appointment" dialog contains the same controls as in the "Add 

appointment" dialog. The only difference is that each field has the value entered 

previously. If you have made changes you wish to save, tab to "Confirm" and 

press "Enter".  

To delete an appointment, move to the appointment in the search results list. 

Select "Delete Appointment" from the menu, or press "Space-D" from the search 

results list. If the selected appointment is a recurring appointment, you are 

prompted, "Recurring appointment. Delete type?" is displayed. You can choose 

whether you want to delete the recurring appointment, or just the appointment for 

that day. If you select "This occurrence", only the current appointment is deleted. 

If you select "The series", all recurrences of the appointment are deleted.  

To completely initialize the Schedule Manager, select "Delete All Appointments" 

from the menu, or press "Backspace-Enter-q" from anywhere in the Schedule 

Manager.  

You can also save selected appointments as a document. Select "Save 

Appointments as File" from the menu, or press "Enter-T" from the search results 

list. The Polaris MINI asks you to specify the beginning and end dates of the 

appointments to be saved. After setting the beginning and end dates, press 
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"Enter", and you are prompted to enter the name and the format of the file to be 

saved. This dialog is the same as the "Save As" dialog in the "Word processor".  

 

8.2.5 Backing up and Restoring Your Appointments 

If you perform a hard reset, or your battery dies, all of the data in the Schedule 

Manager is lost. Thus, it is very important to create a backup file each time you 

change your schedule. To backup your schedule, Select "Backup Appointments" 

from the menu, or press "Enter-U" to activate this function directly. 

If you already have a backup file, you are prompted, "Backup file already exists. 

Backup anyway? Yes". If you have made changes to your schedule, press "Enter" 

to create a new backup file. To keep the previous backup file, press "Enter" on 

no. If you make a backup file again in the Schedule Manager, a new backup file 

is created with the extension DAT, and another file is created with the extension 

BAK containing your previous backup file.  

To restore your schedule after a hard reset, Select "Restore Appointments" from 

the menu, or press "Enter-R" to activate this function directly. 

If you have an existing schedule, you are prompted, "Schedule file already exists. 

Which do you prefer? Append" or, press "Space-4" to move to "Overwrite". If you 

choose to append, and the backup file contains appointments that also exist in 

your current file, you will have redundant appointments. If you choose to overwrite 

and your current schedule contains appointments the backup file does not, these 

appointments are lost.  
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You can back up the schedule automatically by activating the "Set Backup 

Options" function. Select "Set Backup Options" from the menu, or press "Enter-

E".  

The "backup Options" dialog has three controls, "Backup mode" radio button, a 

"Confirm" button, and a "Cancel" button. To move between the radio buttons, 

press "Space and Backspace". 

The options are: "Always backup changes when exiting", "Manual backup", and 

"Prompt backup changes when exiting". 

If you select the "Always backup changes when exiting", a new backup file is 

created automatically if you have modified or added to your schedule.  

If you select the "Manual backup", a new backup file is not created, even if there 

are changes to your schedule. If you select this option, you can only create a new 

backup file by using the "Backup Schedule" function. 

If you select "Prompt backup changes when exiting", you are prompted, "Backup 

changes? Yes" if you have modified or added to your schedule. Press "Enter" on 

"Yes", and a new backup file is created before exiting the Schedule Manager.  

Choose your setting, and press "Enter". 

 

8.2.6 Multiple Accounts and Syncing 

BrailleSense Polaris MINI allows you to use multiple calendars, and automatically 

makes associations with any Google account connected to Polaris MINI. To view 
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available calendars, choose the “Calendar Settings” option from the Schedule 

Manager menu. 

By default, there is an account called “BrailleSense Polaris MINI”. In addition, any 

Google account you have signed in to with Polaris MINI is also available in this 

list. 

The dialog contains two settings: “calendar to add appointment”, and “Calendar 

to print appointments”. This allows you to set appointments in multiple calendars, 

and view, add and output appointments from your chosen calendars. This can be 

useful for creating separate calendars for work and personal use. 

In addition, you can synchronize these calendars with Google using the 

“Accounts” dialog of the Android Settings under All Apps. See section 8.1.9 for 

more information on syncing using the Android System Settings. 

Note: as with the Address Manager, if too many items are changed, added or 

deleted, you may experience sync errors. If you receive a Sync Error notification, 

press Space-1-2-3-4-5-6 to open the Notification Shade, and press Enter on the 

Sync Error to see your options. 

 

8.2.7 Setting Alarm Options 

You can open the "Set Alarm Options" dialog by pressing "Enter-O" or by pressing 

"Enter" on "Set Alarm Options" in the menu. Alarm option fields include "type of 

echo", "Alarm duration", "Alarm repeat interval" and "Repeat". You can move 

between these fields using "Space-1" or "Space-4".  
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The "type of echo" option lets you set what type of alarm you would like to use to 

alert you to your appointment: Choose from several audio alarm types, including 

a media file, the FM Radio, or 1 of 3 alarm melodies. You can also choose a 

vibration, or both (All). Press "Space" to cycle among the options. 

You can change the duration of the alarm sound. You can set this option to a 

value that is between 5 and 600 seconds. The default value is set to 30 seconds.  

When the alarm goes off, if you do not stop it with "Backspace-Enter", the Polaris 

MINI keeps giving you a notice about the appointment after a specified time 

interval. The "Alarm repeat interval" option allows you to change this interval. You 

can set the value anywhere from 1 to 60 minutes, the default value is set to 5 

minutes.  

The "Repeat" field allows you to decide how many times the alarm will sound. You 

can set the value from 1 time to 10 times; the default value is set to 3. To change 

the value, type a number between 1 and 10.  

Press "Enter" on the "Confirm" button to save your settings. Cancel saving the 

alarm options by pressing "Enter" on "Cancel" or pressing "Space-e". 
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9. Web Tools 

The "Web Tools" menu consists of programs used to assist in the searching and 

downloading of web content. Currently, this menu contains only the Web Browser.  

 

9.1 Web Browser 

You can use the "Web Browser" to read pages on the web, as well as to read html 

documents you have saved to disk. You can also download files and stream audio 

content.  

To launch the "Web Browser, from the "Web Tools" menu, navigate to "Web 

Browser" and press "Enter". Or, press B. You can launch the "Web Browser" from 

anywhere on the unit by pressing "F1-B". The Polaris MINI opens the "Web 

Browser" and connects to the "home page".  

You can also launch the Web Browser" by using the global hot key for opening a 

web page: Press "Space-W" from anywhere on the unit. The Polaris MINI, opens 

up a computer edit box into which you can type in the URL you want to go to and 

press "Enter". The Browser is launched, and takes you to the web page you 

requested. 

You can access the Web Browser's functions using hot keys, or via its menus. To 

access these menus, press "Space-M" or "F2". Select a menu item using "Space-

1" or "Space-4", and press "Enter". Or, you can press "Space-M or "F2" followed 

by the shortcut for the corresponding menu item. Use "Space-1" and "Space-4" 

or the Up and Down scroll keys to navigate menus, settings or file lists. Use 

"Space-4-5" and "Space-1-2" or "F3" and "Space-F3" to tab among controls in a 
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dialog. For the purposes of these instructions, we will generally refer to using "F3" 

and "Space-F3" or simply "Tab". Press "Enter" to execute an item. 

 

9.1.1 The File Menu 

1) Open URL: (U) "Enter-U". Type the web address of the page you wish to go to 

and press "Enter". 

2) Open: (O) "Enter-O". Open an HTML file or URL stored on your Polaris MINI. 

3) Save As: (S) "Space-S". Save the current webpage to your Polaris MINI. 

4) Copy URL: (D) "Backspace-D". Copy the URL of the current page to the 

clipboard. 

5) Copy Link: (C) "Backspace-L". Copy the address of the focused link to the 

clipboard. 

6) Page Information: (I) "Enter-I". Opens a dialog of general information about the 

current webpage. 

7) File Download Dialog: (L) “Backspace-3-4”. Opens a dialog to show current 

download progress as well as file download history. 

8) Exit: (Z) "Space-Z". Closes the Web Browser. 

 

9.1.2 The Edit Menu 

1) Start Selection: (B) "Enter-B". Begin selecting a block of text. The end of the 

selection is determined by your cursor position. 

2) Copy: (C) "Enter-C". Copy selected text to the clipboard. 
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3) Add to clipboard: (P) "Enter-P". Append selected text to the clipboard. 

4) Select All: (A) "Enter-A". Select all the text on the current page. 

 

9.1.3 The Go To Menu 

1) Go To Home page: (S) "Backspace-H". Return to your home page. 

2) Go To Previous Page: (P) "Backspace-P". Go to the page you were viewing 

before the current one. 

3) Go To Next Page: (N) "Backspace-N". Move forward one page in your viewing 

history. 

4) Go To Previous Heading: (U) "Backspace-B". Move back one heading. 

5) Go To Next Heading: (D) "Backspace-F". Move forward one heading. 

6) Go to Previous Text: (B) "Dots-2-4-6". Go to the block of text before your current 

position. 

7) Go To Next Text: (P) "Dots-1-2-4-5-6". Go to the next block of text below your 

current position. 

8) Refresh: (R) "Enter-R". Reload the current page. 

9) History: (H) "Enter-H". Open a list of pages you have recently viewed. 

10) Find: (F) "Space-F". Find text on the current page. 

11) Find Again: (E) "Enter-F". Search for the next instance of the text string you 

entered in the "Find" dialog. 

12) Links List: (I) "Backspace-I". Displays all the links on a page in a list view. 
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13) RSS Feed list: (J) "Enter-J". Displays any RSS feeds on the current page.  

 

9.1.4 The Read Menu 

1) Read from Beginning to Cursor: (T) "Backspace-G". Reads the text from the 

top of the page to your current position. 

2) Read from Cursor to End: (G) "Enter-G". Reads the text from your current 

position to the bottom of the page. 

3) AutoScroll: (A) "Up and Down Scroll". STARTS and stops the auto scroll 

function.  

 

9.1.5 The Favorites Menu 

1) Set Current as Home Page: (S) "Enter-S". Set the current page as your home 

page. 

2) Add to Favorites: (A) "Backspace-A". SAVE the current page as a favorite. 

3) Favorites List: (L) "Enter-L". Open the list of favorites you have saved 

previously. 

 

9.1.6 Options 

Use the "Options" dialog to manage Web browser preferences. Navigate the 

settings with "F3" and "Space-F3". 

 1) User Agent: use "Space" to choose between Mobile and desktop. 

2) Show visited links: Use "Space" to choose On or Off. 
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3) Default Download Folder: Press Enter to open folder list and choose desired 

download folder. 

4) Clear Cookies: press "Enter" to clear all cookies. 

 

9.1.7 Navigating Page Elements 

On a web page, there are links, controls, and other various elements, as well as 

text. To read web pages properly, the "Web Browser" should classify each 

element, and notify the user with its information. 

When reading a web page by moving with "Space-4" or "Space-1", one element 

is displayed on one line. The links and controls are displayed with their respective 

symbols so the user can distinguish each element. To move among controls 

without viewing the text between them, use "F3" and "Space-F3". 

A control is a link, an edit box, a radio button, or a combo box. Each control has 

different purposes. Therefore, the user has to know exactly what type of control 

is being used.  

When you find controls in web pages, the Polaris MINI displays control symbols 

ahead of the contents of the control. The following is a list of control symbols. 

Control name 

Symbol 

Link 

LN 

Visited link 
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LNV 

Anchor 

ANC 

Edit box 

EB 

Multi edit box 

MEB 

List Box 

LB 

Combo box 

CB 

Radio button select 

SRB 

Radio button unselect 

URB 

Check box check 

SCHB 

Check box uncheck 

UCHB 

Button 
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BT 

To change a selection in the combo box, press "Backspace-Space-4" or 

"Backspace-Space-1". You can move to the next item by pressing "Space-4". The 

page is renewed automatically when you change a selection in a combo box. 

To select or unselect a checkbox or radio button, press "Space". 

You can move to the previous form field: with Space-1-2-3-4-6, and to the next 

form field: with Space-1-3-4-5-6. 

Move to the previous frame with Space-3-4-6, and to the next frame with Space-

1-4-6. 

 

9.1.8 Table Navigation 

At the beginning position of the table, the Polaris MINI shows the table number, 

and the number of rows and columns on the table. 

For example, there are two large tables (we call these "upper level tables") on one 

web page. Each table has 3 sub tables (we call these "lower level tables") with 3 

rows and 2 columns on each. In this case, when the Polaris MINI shows the first 

sub table on the second large table, it displays "table 2-1 3 rows, 2 columns". At 

the end of the sub table, the Polaris MINI displays "table 2-1". 

If the table consists of only 1 row and 1 column, or empty space that has only 

border or background, such tables are not considered tables in the Polaris MINI. 

The Polaris MINI provides a way to move table by table, and cell by cell, in order 

for the user to comprehend the structure of the table. To move cell by cell, the cell 
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position and contents of the cell are displayed. However, the position information 

is only announced with speech. 

For example, if you have move to a cell that is positioned on the second row and 

third column, and the content of the cell is "news", the Polaris MINI announces, 

"row 2 cell 3 news". In this case, "row 2 cell 3" is announced with speech only, 

while "news" is displayed in Braille. 

If a table is included in the cell, the Polaris MINI announces "table cell". If there is 

not a table in the cell, you hear "empty cell". 

In the "table cell", To move to any cell within the lower level table, press "Space-

4" to move to the beginning line of the lower level table.  

Moving by cell is only valid in the table. If this command is executed outside of the 

table, a warning sound is played. 

1. Move to the previous table: Space-3-4-5-6 

2. Move to the next table: Space-1-4-5-6 

3. Move to the previous cell: Space-2-3 

4. Move to next cell: Space-5-6 

5. Move to upper cell: Space-3-5 

6. Move to lower cell: Space-2-6 

7. Read current cell: Space-2-3-5-6 

8. Move to the previous cell in the upper level table: Backspace-2-3 

9. Move to the next cell of the upper level table: Backspace-5-6 
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10. Move to the upper cell of the upper level table: Backspace-3-5 

11. Move to the lower cell of the upper level table: Backspace-2-6 

12. Check the current position: Space-1-5-6 

 

9.1.9 Playback of Streaming Audio Files 

While navigating a web page, if you come across a link for a streaming audio file, 

you can simply press "Enter" on it. The Media player program is launched with 

lists of address inside of the streaming file, and the streaming audio file on the 

first address is played. The supported streaming file formats are "m3u", "pls", 

"asf", "asx". 

For other formats, if you press "Enter" the "Web Browser" program plays the 

streaming audio file directly. When you play the streaming audio file in the "Web 

Browser", the "Add To Favorites" dialog appears. You can add the streaming 

address to the "Favorites list" and the streaming file is saved with "ASF-WAS" at 

the beginning of the file name. "ASF" denotes that the link is a streaming audio 

file. 

While you play a streaming audio file in the "Web Browser", if you exit the "Web 

Browser" program or you lose the internet connection, the streaming audio file 

stops playing. 

You can use the following playback commands in the "Web Browser" while 

playing a streaming audio file. 

1. Play: "play" button on the front panel 
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2. Stop: "stop" button on the front panel 

3. Turn up the volume: Space-up scroll button 

4. Turn down the volume: Space-down scroll button 

Playback of a streaming audio file does not stop if you switch to another program, 

unless you press the "stop" button on the front panel after returning to the "Web 

Browser".  

 Note: Real Audio files are not supported in the "Web Browser". 
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10. EXTRAS 

 

10.1 Excel Viewer 

The "Excel Viewer" allows you to read and navigate XLS and XLSX files by cell, 

column, row, group, worksheet, etc. To open the "Excel Viewer", from the Main 

menu, press X to open the "Extras" menu, then press X again to open the "Excel 

Viewer". You can launch the "Excel Viewer" from anywhere on the unit by 

pressing "F1-X".  

When the "Excel Viewer" is launched, you are placed in an "Open File" dialog. 

Use normal "File List" navigation commands to locate the XLS or XLSX file you 

wish to open, and press "Enter". When the file is loaded, you are placed at the top 

of the first worksheet. Cells are displayed with the coordinates followed by the text 

of the cell. For example, the first cell in a column containing the date might appear 

as "a1 Date".  

 

10.1.1 General Navigation  

Use the following commands to navigate an Excel file in the "Excel Viewer".  

Move to next row: Space-Dot-4  

Move to previous row: Space-Dot-1  

Move to next column: Space-Dot-6  

Move to previous column: Space-Dot-3  

Move to beginning of row: Space-Dots-1-3  



   165  

Move to end of row: Space-Dots-4-6  

Move to top of column: Backspace-Dot-2  

Move to bottom of column: Backspace-Dot-5  

Move to top of worksheet: Space1-2-3  

Move to bottom of worksheet: Space-4-5-6  

Move to next worksheet: Space-3-4-5  

Move to previous worksheet: Space-1-2-6  

Move to next group: Backspace-Dot-5-6  

Move to previous group: Backspace-Dot-2-3  

Move to next group in row: Space-Dot-5  

Move to previous group in row: Space-Dot-2  

Move to next group in column: Space-Dot-5-6  

Move to previous group in column: Space-Dot-2-3  

You can access functions of the Excel Viewer using hot keys, or via its menus. 

To access these menus, press "Space-M" or "F2". Select a menu item using 

"Space-1" or "Space-4", and press "Enter". Or, you can press "Space-M or "F2" 

followed by the shortcut for the corresponding menu item.  

The Excel Viewer also utilizes lists and dialogs. Use "Space-4-5" and "Space-1-

2" or "F3" and "Space-F3" to tab and shift-tab among controls in a dialog. For the 

purposes of these instructions, we will generally refer to this as "Tabbing".  
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Use "Space-1" and "Space-4" or the Up and Down scroll keys to navigate menus, 

settings or file lists. Press "Enter" to execute an item. 

 

10.1.2 The File Menu 

1) Open: (O) "Enter-O". Open Excel Viewer compatible files. 

2) Open Hyperlink: (H) "Enter-H". Open a link contained in an Excel file in the 

Web Browser. 

3) Set User Table: (T) "Enter-T". Set the parameters for columns and rows in order 

to get accurate information for headers and rows of subtables. 

4) Cell Properties: (I) "Enter-I". View format information for the cell.  

5) Quick Setup: (Q) "Enter-X". Operates similar to the "Set User Table" function, 

except instead of defining the boundaries manually, the beginning cell is 

automatically set as the cell at your current cursor position, and the end cell is 

automatically set as the last cell containing data. 

6) Save As: (S) "Space-S". Lets you save an Excel file as a CSV or TXT separated 

by tabs or commas. 

7) Exit: (Z) "Space-Z". Close the Excel Viewer. 

 

10.1.3 The Edit Menu 

1) Start Selection: (B) "Enter-B". Begin selection of a text block. The end of the 

selection is determined by your current cursor position. 

2) Select All: (A) "Enter-A". Select all the data on the current sheet. 
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3) Copy: (C) "Enter-C". Copy the selected text to the clipboard. 

 

10.1.4 The Go To Menu 

1) Find: (F) "Space-F". Search for text on the current sheet. 

2) Jump to Cell: (G) "Space-J". Move to a cell using its coordinates. 

3) Next Sheet: (N) "Space-Dots-3-4-5". Move to the next sheet in the workbook. 

4) Previous Sheet: (P) "Space-Dots-1-2-6". Move to the previous sheet in the 

workbook. 

5) Sheet List: (L) "Enter-L". Bring up a list of all the sheets in the workbook. 

6) Set Mark: (M) "Backspace-M". Bookmark your current position. 

7) Jump to Mark: (J) "Backspace-J". Move to a previously marked position. 

8) Delete Mark: (D) "Backspace-D". Delete a previously set mark. 

9) Move to Previous Group: (R) "Space-dots-2-3". Move to previous data filled 

area. 

10) Move to Next Group: (E) "Space-dots-5-6". Move to next data filled area. 

 

10.1.5 The Read Menu 

1) Sheet Title: (T) "Space-Dots-1-5-6". Read the name of the current sheet. 

2) Read from Beginning of Row to cursor: (P) "Backspace-Dot-3". Read from the 

left most cell to the current position. 
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3) Read from cursor to end of Row: (N) "Backspace-Dot-6". Read from your 

current position to the right-most cell. 

4) Read from Top of Column to Cursor: (U) "Backspace-Dot-1". Read from the 

top of the column to the current cursor position. 

5) Read from Cursor to Bottom of Column: (D) "Backspace-dot-4". Read from your 

current position to the bottom of the column. 

6) Read Current Row: (C) "Space-dots-1-4". Read all cells in the current row from 

left to right. 

7) Read Current Column: (R) "Space-Y". Read all cells in the current column from 

top to bottom. 

8) Read Header Cell of Row: (Y) "Backspace-Y". Read the title of the current row. 

9) Read Header cell of Column: (X) "Backspace-C". Read the title cell of the 

current column. 

10) Read File Name: (F) "Space-dots-3-4". Read the name of the workbook. 

 

10.1.6 The View Menu 

1) Set Time and Date: (D) "Enter-D". Determine how time and date are displayed. 

2) Show Hide Hidden sheets: (S) "Enter-S". Toggle whether hidden sheets are 

viewable. 

3) Show Hide Hidden Rows: (R) "Enter-R". Toggle whether hidden rows are 

viewable. 
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4) Show Hide hidden Columns: (Y) "Enter-N". Toggle whether hidden columns 

are viewable. 

5) Cell Activation: (A) "Enter". Opens the cell as a static box so you can review or 

select text. 

 

10.2 Online DAISY 

The Online DAISY program allows patrons of the Canadian National Institute for 

the Blind and Vision Australia libraries to access and download DAISY books 

available through their online bookshelf.  

To execute the Online DAISY program, Open the "Extras" menu, navigate to 

"Online DAISY" and press "Enter".  

When you execute the Online DAISY program for the first time, you are asked for 

your login information. Use "Space-1" and "Space-4" to navigate to the server you 

wish to log in to. Once done, Tab to the iD field and enter it in computer Braille. If 

accessing the CNIB library, type "CNIB_" followed by your user number in the ID 

field. For Vision Australia, type just your user ID number. Tab to the "Password" 

field and type it in computer Braille. Press "Space" to toggle the check boxes for 

"Remember Me", and "Save password". When you have chosen your login 

settings, Tab to "Login" and press "Enter". 

You are presented with a combo box with 3 items: "Expired", "New", and "Issued". 

Press "Tab (F3 or Space-4-5)" to access the list in your desired category. You can 

navigate the book list using "Space-1" and "Space-4". 
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To download a book, navigate to it and press "Enter". The unit announces 

"Download start" and shows progress indicators to let you know the progress of 

the download process. When the book is finished downloading, you may play it 

using the DAISY Player.  

Books downloaded using the Online DAISY program are available in the "Online 

DAISY" folder from the "Open DAISY" dialog of the DAISY Player. For reasons of 

copy protection, these books are only visible from the DAISY Player and cannot 

be accessed from the File Manager. 

Vision Australia users can also download BRF books. When a BRF book is 

downloaded, you have the option of opening it in the Word Processor, from which 

you can copy the text to another document, or save it to a different location where 

it can be more easily accessed. 

When you wish to return a book, navigate to it in the list, and press "Enter-R" This 

returns the book to the virtual library so that others can be issued to you. 

 

10.3 Sense Dictionary 

The Sense Dictionary is an add-on piece of software for the Sense notetakers 

available for purchase from HIMS. The basic package includes the New Oxford 

American Dictionary, and the Concise Oxford American Thesaurus. You can also 

purchase additional bilingual dictionaries for English/Spanish, English/French, 

English/Italian and English/German.  

 Note: If you have not purchased the dictionary package containing the 

dictionary data and license key, pressing "Enter" on the Sense Dictionary 
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option in the "Extras" menu results in the message, "Authentication failed". 

For pricing and purchasing information, please contact HIMS or your 

BrailleSense dealer.  
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11. Utilities 

The "Utilities" menu provides several special functions and settings for the Polaris 

MINI. Move among the items in the "Utilities" menu using "Space-1" and "Space-

4" and press "Enter" to open an item.  

You can access functions for each program using hot keys, or via that program's 

menus or dialogs. If a program has menus, press "Space-M" or "F2" to open the 

menu. Select a menu item using "Space-1" or "Space-4", and press "Enter". Or, 

you can press "Space-M or "F2" followed by the shortcut for the corresponding 

menu item.  

In dialogs, use "Space-4-5" and "Space-1-2" or "F3" and "Space-F3" to tab and 

shift-tab among controls. For the purposes of these instructions, we will generally 

refer to this as "Tabbing".  

Use "Space-1" and "Space-4" or the Up and Down scroll keys to navigate menus, 

settings or file lists. Press "Enter" to execute an item. 

 

11.1 Calculator 

Using the calculator on the Polaris MINI, you can do simple math equations as 

well as complex scientific calculations. The results and expressions are displayed 

in Braille, and spoken by the Polaris MINI.  

To use the calculator, press C from within the "Utilities" menu. You can launch the 

"Calculator" from anywhere on the unit by pressing "F3-C". When the calculator 

is opened, 0 is displayed in computer Braille. 
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You may type using computer Braille, UEB, or Nemeth Braille when inserting 

expressions. Press "Backspace-G" to cycle the Braille codes. Clear the calculator 

with "Backspace-C". If you insert numbers or a function into a result, the result 

disappears; and if you enter operators, you move to the next step. In addition, you 

can keep your result in the calculator's memory, and recall it later. You can 

activate the functions and operators via the calculator menu or you can use the 

hot keys associated with the various functions.  

 

11.1.1 General Functions 

To access general mathematical operations, open the menu by pressing "Space-

m or "F2" and press "Enter" on "General Functions". From the calculation line, 

access the "General Functions" by pressing "Enter-G".  

"General functions" is a dialog box that contains the "general function list", a 

"Confirm" button, and a "Cancel" button. You can navigate the operators using 

"Space-1" or "Space-4". Or, you can press the first letter of the operator you want 

to access.  

Select your desired operation and press "Enter" to perform it. You can also use 

hot keys to quickly execute operations. Press "Space-H" for a list of hot keys in 

the Calculator.  

To enter negative numbers type minus (dots 3-6) and the number in parentheses. 

For the percent operation, type the numbers first followed by the percent sign. 

Immediately after you type the percent sign (%), the number you have typed in is 

converted into a percent value.  
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11.1.2 Fractional Arithmetic  

The Polaris MINI can perform fractional operations such as simplifying and 

multiplying fractions as well as converting fractions to decimals.  

You can also convert fractions to decimals, decimals to fractions, improper 

fractions to mixed numbers, or mixed numbers to improper fractions. When your 

result is fractional, you can bring up the "fraction options" by pressing "Space-3-

4". Press "Space-1" and "Space-4" to move among the available options. If the 

fraction is a simple fraction, your options are ""fraction to decimal" and "return 

original fraction". If the fraction is an improper fraction, you also have an option to 

return "improper fraction to mixed number". If your fraction is a mixed number, the 

"mixed number to improper fraction" appears. Finally, if your result is a decimal 

and you press "Space-3-4", the decimal is converted to a fraction.  

 

11.1.3 Memory Functions 

The "Memory Functions" act on stored answers and calculations in memory. To 

access these functions, press "F2" to open the menu, and press "Enter" on 

"Memory Functions".  

"Recall Items" is a dialog, containing "Variable list", "Delete", "Display detail", 

"Confirm", and "Cancel". You can access the dialog by pressing "Backspace-R" 

in the calculation line or by selecting it from the "Memory Functions" menu...  

The "Variable list" displays "item name: value". Insert the value into your 

calculation by pressing "Enter" on the item name. You can also copy items in the 
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"Variable list". Press "Space" to select an item in the "Variable list". Then, press 

"Enter-i" to copy the selected items to the clipboard.  

The "Display detail" shows the item name and its result with the default set to 

"No". To review the detailed information, press "Space" to switch to "Yes". Then, 

it displays "item name: the expression = its result value" in Braille.  

"Delete" is used to remove a variable item from the list.  

You can delete all of the saved items stored in the "Recall Items". Select "Delete 

All Saved Items" from the "Memory Functions" menu, or press "Enter-D" from the 

calculation line. 

"Save Items" is a dialog that allows you to define variables according to the current 

expression or result in the calculator and save them for future use. The dialog 

contains an edit box for typing in the variable name, a "Confirm" button and a 

"Cancel" button. SELECT "Save Items" from the "Memory Functions" menu, or 

press "Backspace-S" from the calculation line.  

When the dialog is opened, the "item name" edit box is focused. Type a name for 

the variable, and press "Enter" or move to "confirm", and press "Enter". The 

current expression or result is then saved under the variable name you just 

specified. 

If you type names under variables which have already been created, you are 

prompted, "Replace variable xx with current value? Yes". If you type function 

names like "sin", "cos", or "pi" as a variable name, you are warned, "Invalid item 

name", as you cannot use these functions in variable names.  



   176  

You can also define variables directly from the calculation line by typing 

"variable=expression" and press "Enter" to save the variable.  

 

If you select the Statistics function, a dialog opens, which consists of a list box 

containing all the stored variables and their values, a list box displaying the results 

of several functions, and a "Close" button. Press "Backspace-T" to activate this 

function from the calculation line,  

Press "Space" to select each variable in the list that you want included in the data 

set for which the statistics are calculated. TAB to the "result" list to view the sum, 

average, variance, and standard deviation of the selected variables. You can also 

select items from the result list and copy them to the clipboard.  

 

11.1.4 Sine Functions 

Select "Sine Functions" in the Calculator's menu, or press "Enter-S" in the 

calculation line. The "sine function" list consists of "Sine", "Arc sine", and 

"Hyperbolic sine". If you press "Enter" on one of the three functions you can insert 

it into your calculation.  

 

11.1.5 Cosine Functions 

Select "Cosine Functions" from the Calculator's menu, or press "Enter-I" from the 

calculation line. The "cosine function" list consists of "Cosine", "Arc cosine", and 

"Hyperbolic cosine". If you press "Enter" on one of the three functions, the 
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calculation is performed. Or, you can activate one of the three cosine functions by 

pressing the first letter of each from the list. 

 

11.1.6 Tangent Functions 

You can open the "Tangent Functions" by pressing "Enter-T" from the calculation 

line, or by selecting "Tangent Functions" from the Calculator's menu. The "tangent 

functions" list consists of "Tangent", "Arc tangent", and "Hyperbolic tangent". If 

you press "Enter" on one of the three functions, the calculation is performed.  

 

11.1.7 Logarithm Functions 

You can open the "Logarithm Functions" by pressing "Enter-L" from the 

calculation line, or by selecting "Logarithmic Functions" from the Calculator's 

menu. 

The "Logarithm Functions" is a dialog, which contains a "function list", a "Confirm" 

button, and a "Cancel" button. The function list consists of "Common logarithm" 

and "Natural logarithm". If you press "Enter" on one of the logarithm functions, the 

calculation is inserted into your calculation line.  

 

11.1.8 Convert Unit  

The "Convert Unit" dialog allows you to convert measurements of mass, area, 

volume, distance, and temperature from metric measure to imperial measure as 

well as other standards of measurement and units of measurement within the 
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same system. It also converts several units of measurement related to 

programming and computers. 

To open the "Convert Unit" dialog, Select "Convert Unit" from the Calculator's 

menu, or press "Enter-U" from anywhere in the Calculator.  

The "Convert Unit" dialog contains the following items: "Unit Category" combo 

box, "Current Unit" combo box, "Change Unit" combo box, "Input Number" edit 

box, "Convert" button, "Cancel" button and the "Result" static box. You can move 

among the controls in the dialog using "Tab (F3 or Space-4-5)" or "Shift-Tab 

(Space-F3 or Space-1-2)". Use "Space-1" or "Space-4" to move among the items 

in the combo boxes.  

The available unit categories are Distance, Area, Mass, Volume, Temperature, 

Data, numbers and Text. When you have chosen your measurement category, 

the "Current Unit" and "Change Unit" combo boxes will contain measurement 

units according to your chosen category. The available distance units are: 

Millimeters, Centimeters, Meters, Kilometers, Inches, Feet, Yards, and Miles. The 

available units of area are: Square Meters, Are, Square feet, Square Yards, 

Acres, and Hectares. The available units of mass are: Grams, Kilograms, Tones, 

Grains, Ounces, and Pounds. The available units of volume are: Deciliter, 

Milliliter, Liter, Cubic Centimeter, Cubic Meter, Cubic Inch, Cubic Foot, Cubic 

Yard, Gallon, Fluid oz, Cups and Quarts. The available units of temperature are: 

Celsius, Fahrenheit and Kelvin.  
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The available data units are bit, byte, kilobyte, megabyte and gigabyte. The 

available numeric units are Hex, Dec and binary. Finally, the text conversion 

allows you to discover the ASCII equivalent to any text character. 

Choose your unit to convert from in the first combo box. Choose your unit to 

convert to in the "Change" combo box. Type the number of the measurement you 

want to convert in the "Input Number" edit box. Finally, to convert the 

measurement, Tab to the "Convert" button and press "Enter". If you wish to cancel 

the conversion, Tab to the "Cancel" button and press "Enter". When you activate 

the "Convert" button, the conversion result is displayed in the "Result" static box.  

 

11.1.9 Copy to Clipboard 

The "Copy to Clipboard" function is used to copy your expression or result to the 

clipboard for pasting your expression or result in a document. You can also access 

up to 20 lines of calculation history and copy them as well. Press "Enter" on the 

"Copy to Clipboard" option in the menu, or press "Enter-C" in the calculation line 

to copy the current expression. You can now paste the calculation to a document 

in the Word Processor or to another application on the unit.  

To access the cumulative calculation history, press "Enter-H". You can then use 

normal selection commands to select the lines of the history you wish to copy. 
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11.1.10 Return Formula  

There may be times, after viewing a result, that you wish to be reminded what 

expression you used to obtain that result. The "return formula" function allows you 

to return the expression you just entered 

When your result is displayed, press "Enter-R", or select "Return Formula" from 

the menu.  

The expression you entered to obtain your current result is displayed. 

 

11.1.11 Option Settings 

You can activate the "Option Settings" by pressing "Enter" on the menu option, or 

from your calculation line, press "Enter-O".  

The "Option Settings" dialog contains a "setting list", a "Confirm" button, and a 

"Cancel" button. The "setting list" consists of "Angle Unit" and "Calculator Braille 

Code". You can navigate among the 2 options by pressing "Space-1" or "Space-

4". Use "Space" to change the value of each setting. 

When setting the angle unit, if you select "Radian", you can get the PI value while 

using the trigonometric function. If you select "Degree" and activate PI, you will 

get a wrong answer as this is not a valid calculation.  

You can set the Calculator Braille code to computer Braille, Nemeth or UEB math 

Braille as described previously. You can use "Space-G" to change this setting 

from anywhere in the calculator. 
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11.2 Display Compass Heading 

Use this option to display the direction of the compass on the Polaris MINI. You 

can display the compass heading from anywhere on the unit. 

To display the compass heading, press "Space-F3-F4" from anywhere on the 

Polaris MINI. 

The current status of the compass is displayed. 

You can also access compass status in the "Utilities" menu. Move to "Display 

Compass Heading" with "Space-4" and press "Enter".  

As you change direction, to check the current compass status, press "Space". 

The current direction is announced. To exit this function, press "Space-E" or 

Space-Z".  

 Note: It will take about 15 minutes to initialize the unit should the following 

situations occur: 

1. The unit discharges a great distance from the location where the 

compass was last used. 

2. The unit remains discharged for more than a month. 

 

11.2.1 Options of Gyrocompass 

There are 2 option settings available when viewing compass status: "Refreshing 

time" and "Compass display type".  

Refreshing time is the interval of the automatic announcement of the compass 

status. To set this option, from the compass status, "Tab" to the "Refreshing time" 
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edit box. Type the number of seconds between compass status announcements. 

By default, it is set to 0. You may type a number between 0 and 120. 

You can set the Compass Display Type by tabbing to this option from the compass 

status. The setting values are "cardinal and degrees", "cardinal only" and 

"degrees only". By pressing "Space", you can change the value of the setting. By 

default, it is set to "cardinal and degrees". 

 

11.3 Display Time and Date 

Use this function to check the current date and time. Navigate to "Display Time 

and Date" in the "Utilities" menu, and press "Enter". You can also query the time 

and date from anywhere on the Polaris MINI with "Space-T". You can Tab to 

display today's date.  

 

11.4 Wake up Alarm 

You can set a "Wake up alarm" to sound at a specified time every day. To open 

"Wake up alarm", from the "Utilities" menu, use "Space-1" or "Space-4" to 

navigate to "Wake up alarm", and press "Enter". You can launch the "Wake Up 

Alarm" from anywhere on the unit by pressing "F3-A" If you have not yet set the 

time or date in the Polaris MINI, the unit prompts, "Set time:" After you set the 

time, the Polaris MINI displays the "Wake up alarm" dialog. The "Wake up alarm" 

dialog contains: "Set time", "Bell", "Term", "Alarm duration", "Repeat interval", 

"Wake up call times", a "Confirm" button, and a "Cancel" button.  
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When the alarm sounds, the Braille display displays the message "Wake up call. 

Press Backspace-enter to stop the alarm".  

When you open the "Wake up alarm" dialog, the Polaris MINI displays the "Set 

time" field. The value is set to the current time or the time specified previously. 

Here you can directly type the time, or set the time using the shortcut keys, as 

explained in section 8.1.3.  

Tab to the next field and select from one of 3 alarm sounds, a vibration, a media 

file or an FM Radio frequency for the wake up alarm. Press "Space-1" or "Space-

4" to change the alarm sound. As you move among the sounds, the various alarm 

sounds are played. When you reach the 4th option, "Vibrate motor", the Polaris 

MINI produces a long vibration representing the one you would feel should you 

choose to use this option to alert you of your alarm.  

If you choose "Media File", Tab to the "File Name" button and press "enter" to 

browse for the file you wish to use as your alarm sound. You are placed in a File 

Manager control with the focus inside the 'Media" folder. Locate the file you wish 

to use, and press 'Enter". If you choose "FM Radio", tabbing once places you in 

an edit box in to which you can type the frequency of the radio station you wish to 

wake up to.  

When you have selected your desired alarm type, Tab to the next field. 

In the term field, you can set which days of the week the alarm sounds. There are 

four options: "Off", "Once", "Week days", and "Every day". If the "Term" is set to 

"Off", the alarm does not go off at the specified time, no matter how the other 

options in the dialog are set.  
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The duration option sets the amount of time that the alarm sounds. The options 

are 1 minute, 2 minutes, or 3 minutes. If you set the ringing duration to "1 minute", 

the alarm sounds for one minute, and then is silent. To stop the alarm before a 

minute has passed, press "Backspace-enter". 

The repeat interval defines the amount of time that is between the times that the 

alarm sounds. For example, if you set the repeat interval to three minutes, after 

the alarm has stopped sounding, it rings again in 3 minutes. The available settings 

are 1, 3, 5, 10, 15, or 20 minutes.  

If the alarm is not turned off by pressing "Backspace-enter", it repeats according 

to the number of times you set the Wake Up Call Time option. The available 

settings are 1 to 10.  

Press "Enter" to save your setting, or "Space-Z" to cancel setting the alarm. 

 

11.5 Stopwatch 

You can launch the "Stopwatch" from anywhere on the unit by pressing "F3-W". 

Or, you can navigate to it in the "Utilities" menu and press "Enter". 

"00:00:00" is displayed. Press "Enter", to start the stopwatch running. Press 

"Enter" again, to pause, and the Polaris MINI announces the elapsed time, and 

displays it in Braille. Pressing "Enter" again restarts the stopwatch running. 

If you press "Backspace" while the stopwatch is paused or running, The Polaris 

MINI announces the elapsed time and clears to "00:00:00". While the stopwatch 

is running, pressing "Space" gives you the elapsed time. As the stopwatch is still 
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running, the Braille display continues displaying the time second by second as it 

passes.  

Press "Space-F2" to stop displaying the time. If you press "Space-F2" once more, 

the time is displayed again. 

Tab to switch to the "Countdown timer". You are asked to type hours, minutes, 

and seconds. Type a two-digit number for the hour, minute, and the second using 

Computer Braille or grade 1. You do not need to use a number sign. If you press 

"Enter" without typing any numbers, the "Countdown timer" starts counting down 

by the default time, which is set to one minute. When started, the "Countdown 

timer" displays "countdown xx minute", and begins running. 

Press "Enter" on the "Countdown timer", and the Polaris MINI tells you the 

remaining time, and pauses countdown. Press "Enter" again to restart the timer. 

Pressing "Backspace" clears the "Countdown timer". If the timer reaches zero, a 

10-second alarm sounds, and the "Countdown timer" clears. If you press 

"Backspace-enter" while the alarm is sounding, the alarm stops and your timer 

clears, and is ready to accept a new time. 

To exit the "Stopwatch" program, press "Space-Z".  

 

11.6 Terminal for Screen Reader 

The "Terminal for screen reader" function allows the Polaris MINI to be used as a 

Braille display when connected to a computer or cell phone that uses a compatible 

screen reader such as JAWS, Supernova, Android’s TalkBack or Apple's 

VoiceOver. Before using this function, make sure that the Polaris MINI is 
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connected to your personal computer or smart phone via a Bluetooth serial 

connection, or to the USB client port. To turn on this function, from the "Utilities" 

menu, navigate to "Terminal for screen reader", and press "Enter". To launch 

"Terminal for Screen Reader" from anywhere on the unit, press "F3-S".  

The list of connection options is displayed: "Bluetooth serial port" and "USB port". 

Press "Enter" on your desired connection type, and the unit announces, "Terminal 

mode". If you are connecting using the Bluetooth serial connection and Bluetooth 

has not been activated, the unit automatically activates Bluetooth before entering 

terminal Mode. 

Once in Terminal Mode, the Polaris MINI no longer speaks as it is now simply 

acting as a Braille display for your computer or smart phone. If the connection 

fails, you are returned to the list of connection methods. 

You can connect a Bluetooth and USB device to the Terminal for Screen Reader 

simultaneously. Once you have established the first connection, press 

Backspace-Space-Enter-P to initiate the second connection. When 2 devices are 

connected, press Backspace-Space-Enter-C to toggle between the connections. 

To exit the "Terminal for Screen reader" press "Backspace-Space-Z".  

 

11.6.1 Terminal Clipboard 

Terminal Clipboard allows you to create and edit text on the notetaker before 

sending it via the Terminal for Screen Reader to the connected device. This can 

be useful in instances like when using VoiceOver on an i-device, in which 
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characters are translated as they are sent to the IPhone or iPad. Or, you may 

simply find it more comfortable to edit in the notetaker environment. 

As explained above, the Terminal Clipboard allows you to create and edit text on 

the notetaker, and send the completed text to the connected computer or 

SmartPhone via the Terminal for Screen reader. 

To enter "Terminal Clipboard", press "Space-Enter-I". The BrailleSense 

announces, "Terminal Clipboard". Type and edit your text using normal text entry 

and edit commands. In "Terminal Clipboard", the Braille display and keyboard are 

temporarily disabled from sending/receiving information to/from your connected 

computer or i-device, so that you may use them for creating/editing your text. For 

more information on text entry and editing, please see section 5 of this manual on 

the Word Processor. When you are finished typing the text you wish to send to 

your computer or mobile device, press "Enter-S" and the text is quickly inputted 

to the device via the Terminal for Screen reader, and your BrailleSense returns to 

sending/receiving information to and from the connected device. 

"Terminal Clipboard" can also be useful for transferring text from a document or 

e-mail in your notetaker, to a document or e-mail you are creating on your 

connected computer or SmartPhone. As the "Terminal Clipboard" is a standard 

edit box on the notetaker, you can paste text in to it from the notetaker's clipboard. 

(see the sections of this manual regarding selecting text as it applies to supported 

programs such as the Word Processor, E-mail, Web Browser, etc.) 

To send text from your notetaker:  

1) Press "Space-Enter-I" to activate "Terminal Clipboard". 
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2) Press "Enter-V" to paste the text from the notetaker's clipboard to the edit box. 

3) Press "Enter-S" to send the text via the Terminal for Screen Reader. 

 

11.7 Display Network Status 

This utility provides information about the current network connection type and 

status, the current IP of the unit, subnet mask, gateway, and MAC address. To 

check network status, press "Enter" on "Display Network Status". You can also 

query network status from the "program" menu by pressing "Space-N".  

The information about the current connection is displayed. You can Tab to a 

"Renew" button and a "Close" button. 

The first item in the information list (status) indicates whether the Polaris MINI is 

currently connected to the Internet (online/offline), and if so, the current 

connection type (LAN, Modem, ADSL, or Wireless LAN). The next item is the 

"current IP address", followed by "Subnet mask", and "Gateway", and finally "MAC 

address". You can move among these items by pressing "Space-4" or "Space-1". 

If the Polaris MINI is not currently connected to the Internet, the status information 

shows "offline", and the IP address, subnet mask, and gateway display 0's.  

 

11.8 Display Power Status 

Press "Enter" on "Display power status" from the "Utilities" menu. Or, query power 

status from anywhere on the Polaris MINI by pressing "Space-1-6". Two pieces 

of information are displayed: the percentage of charge remaining in the battery, 
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and whether the Polaris MINI is using the AC adapter or the battery to receive 

power. Exit by pressing "Space-Z". And you are returned to your previous location 

on the unit.  

 

11.9 Format 

WARNING!! The Polaris MINI makes it possible to format the flashdisk to solve 

corruption problems and/or start over with a clean internal drive. Formatting the 

flashdisk erases everything on the flashdisk. Be extremely cautious when 

executing this command. If you execute this command, you will lose all of your 

data. You will NOT be able to retrieve this data once the command is executed. 

To format the flashdisk, press and hold "Space-1-2-3". While holding down 

"Space-1-2-3," quickly press and release the reset button. Continue holding 

"Space-1-2-3" until you hear the "format start" announcement. 

You can also access the "format" function by pressing F from the "Utilities" menu. 

Or, you can launch it from anywhere on the Polaris MINI by pressing "F3-F".  

When you format any disk on the Polaris MINI, all information is erased. 

Therefore, before you format, you are advised to backup any important data if 

possible. 

 

1) From the Utilities menu, press "Enter" on "Format" and "flashdisk" is focused. 

Press "Enter", or choose another disk from the list, and press "Enter". 

2) You are prompted, "Format flashdisk?" Yes". Press "Enter" 



   190  

3) You are prompted, "All data will be lost. Continue? Yes". Press "Enter".  

4) The unit announces, "Now formatting flashdisk" and the format is started. 

5) When the format is complete, you are returned to the "Disk" list. 

To cancel the format, press "Space", or press "Enter" on "No" in step 2 or 3. 

 

11.10 Set Sleep Timer 

You can set the sleep timer to turn the Polaris MINI off after a specified amount 

of time regardless of what you are doing. 

To set the Sleep Timer, navigate to "Sleep Timer" in the Utilities" menu and press 

"Enter". Or press "Space-J" from anywhere on the unit.  

You are prompted, "Sleep timer: 0". Enter the number of minutes for the sleep 

timer in the edit box. The available settings range from 0 to 180. Press "Enter". 

When the sleep timer is set, even if the device is active, it powers off after the 

specified amount of time. If you set the sleep timer for "5" minutes and press 

"Space-J (dots 2-4-5)" after 2 minutes, "3" is displayed in the edit box, indicating 

the time remaining before the sleep timer powers the unit off.  

 

11.11 Upgrading Polaris MINI Firmware 

Using this utility, you can update the Polaris MINI either via an Internet connection 

or from external media containing the upgrade files. If you choose the "Online" 

method, be sure you have an active Internet connection before attempting the 

upgrade. When you update the Polaris MINI,settings are usually maintained. 
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However, if there are changes to setting values in the firmware, all settings will be 

initialized. Therefore, it is recommended that you back up your settings using the 

backup/restore utility in the “Settings” menu. Data in the flashdisk is protected. 

However, we recommend you backup your files before updating the Polaris MINI 

Firmware as unexpected problems can occur. 

 Note: You cannot cancel the update once it has started. You must not reset 

the unit during an upgrade. You must keep the unit connected to AC power 

throughout the upgrade process. We recommend you do not touch the 

Polaris MINI while it is updating. It may take up to 60 minutes to update the 

Polaris MINI, possibly even longer depending on the speed of your Internet 

connection.  

 Also note: the upgrade files are temporarily stored on the flashdisk for 

installation. If you do not have enough memory available on the flashdisk, 

the Polaris MINI is unable to update until you make room for the upgrade 

files. 

You can access the "Upgrade Firmware" option via the "Utilities" menu, or launch 

it from anywhere on the unit using "F3-U".  

When you have chosen your upgrade method, and the upgrade files are 

downloaded or detected, Polaris MINI will extract all of the necessary program 

files. There are about 40 files to extract, and progress is announced every few 

seconds. 
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Once done, the Polaris MINI will reboot, and the system files will be upgraded. 

During this process, there is no speech, but the progress will be shown in Braille 

as a percentage. 

When the system files have been upgraded, the software will load and boot. 

During this process, the Polaris MINI displays “Starting BrailleSense” in Braille, 

but no sound or speech is heard. This process can take many minutes; do not be 

surprised if nothing happens for 30 minutes or more. 

When the firmware boots, the unit will then proceed to upgrade any applications 

with updated programming, usually between 25 and 30 apps. Progress is spoken 

and displayed during this process. 

Finally, the system reboots again. If there are no new or changed setting values 

in the firmware, the Main Menu loads, and your settings are restored. If setting 

values have been changed, all Settings are initialized, and the system boots and 

runs the Quick Guide. 

 

11.11.1 Upgrading the Polaris MINI Firmware Using the Internet 

To upgrade the Polaris MINI Firmware via the Internet, follow these steps: 

1) Make sure you are connected to the Internet and plugged into AC power. Press 

"Enter" on "Upgrade Polaris MINI Firmware" in the "Utilities" menu.  

2) Press "Enter" on "Upgrade: Online". The Polaris MINI connects to the HIMS 

server, and your current software version is compared to the HIMS server version. 

You are prompted to continue with the upgrade. 
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3) The Polaris MINI begins downloading the upgrade files. The upgrade is around 

1.3 GB. Thus, depending on the speed of your Internet connection, it may take a 

long time to download. If the upgrade fails, you may receive the message, 

"Internet connection is not available. To try the upgrade again, press "Space-Z" 

to cancel, and activate "Upgrade Polaris MINI Firmware" again. If the connection 

is successful, the upgrade files are downloaded.   

4) After downloading the upgrade files, Polaris MINI automatically starts the 

upgrade process. Please remember you must not touch the Polaris MINI until the 

upgrade is complete, as pressing keys, resetting, or unplugging the unit can 

interrupt the upgrade process, thus resulting in an incomplete installation. When 

the upgrade is complete, you are returned to the "program" menu, and the unit 

announces, "File manager". 

5) After the upgrade is complete, check the software version by pressing "Space-

V" while in the "program" menu. 

 

11.11.2 Upgrading the Polaris MINI Firmware from a Disk 

To upgrade the Polaris MINI Firmware from a disk, follow these steps: 

1) Download the upgrade file from the HIMS website. Note: the file is a .bin file, however, some versions of 

Windows may rename it as a .zip file. Do not extract this file. Simply rename the extension back to .bin. Copy 

the file to the root of an external storage device such as an SD card or USB thumb drive.  

2) Connect the SD card or USB drive to the Polaris MINI, and be sure the Polaris 

MINI is connected to AC power. Then, press "Enter" on "Upgrade Polaris MINI 

Firmware" from the "Utilities" menu. 
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3) "Upgrade: Online" is displayed. Press "Space-4" to go to the "Upgrade: Offline" 

option. Press "Enter".  

4) If you are already running the latest version of the software, you are asked to 

continue with the upgrade. If you press "Enter" on "No", the upgrade is cancelled. 

Press "Space" to toggle between "Yes" and "No".  

5) The Polaris MINI starts the upgrade process. Please remember you must not 

touch the Polaris MINI until the upgrade is complete. When the upgrade is 

complete, you are returned to the "program" menu, and "File manager" is 

displayed. 

6) When the upgrade is complete, check the software version by pressing "Space-

V" while in the "program" menu. 
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12. Installing and Using Native Android Apps 

While the Polaris MINI has many powerful programs created specifically for the 

visually impaired, one of its most powerful features is the ability to install and use 

native Android applications directly from the Google Play Store. Before you can 

install native Android applications, you must have a Google Play Store account.  

You can run the Play Store by navigating to it from the Main menu, and pressing 

"Enter". You can also press the letter "P".  

When you first open the Play Store application, you will need to sign into your 

Google account. It is important to note: when you use the Google Play Store and 

any applications you install from there, you are utilizing native Android apps. Thus, 

you are no longer accessing the BrailleSense interface, and interaction and 

navigation is slightly different. 

BrailleSense Polaris MINI contains a mobile screen reader that is automatically 

executed when you use any native Android app. It is somewhat similar to 

TalkBack for Android with some notable enhancements. Because you must 

navigate the graphical Android screen, it can sometimes be difficult to locate what 

you need efficiently. For this reason, the Polaris MINI screen reader allows you to 

locate icons according to their first letter. So, if you're looking for a Search icon, 

press the letter S. Pressing a given letter will take you to the first icon that 

matches. Subsequent presses of the same letter will jump to additional icons on 

the screen beginning with that letter. 

Use "F3" and "Space-F3" to move among individual objects on the screen. The 

Control and Alt keys will often take you to different content areas on the screen. 
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In programs like Docs, Sheets, and Slides, keyboard shortcuts are available for 

QWERTY keyboards, and the Control and Alt keys allow you also to utilize these 

functions. 

Use "Space-1-2-3" to move to the top of the current content area, and "Space-4-

5-6" to move to the bottom of the current content area. Use "Enter" to select or 

run the current item, and “F4”, “Space-E”, or “Space-Z” to move back one screen. 

To type in an edit box, you must press "Enter" to activate Edit Mode before you 

can input text. To adjust slider controls, press “Backspace-Space-4” to increase 

the slider value, and “Backspace-Space-1” to decrease a slider value”. 

You can also navigate Android apps using the Media keys on the front panel. Use 

“Back” and “Next” to move to the previous and next object. “Record” serves as 

the android Back button. “Play” opens Recent Apps, and “Stop” returns you to the 

main Menu. 

If you prefer to use more traditional keystrokes for navigating objects, you can 

change the method of navigation to emulate Swipe gestures as does TalkBack, 

using Space-1 and Space-4. To turn on the gesture method, press Backspace-

Enter-H while using the Mobile Screen reader. Use the same keystroke to change 

back to the original mobile Screen Reader method. 

It is also possible to operate Android apps in a more traditional manner using a 

keyboard and/or mouse, or portable touch monitor. You can turn accessibility 

features on and off by pressing the “Stop” and “Next” media buttons together on 

the front panel of the device. When the Mobile Screen Reader is on, these 

accessories will operate similar to how they would when using TalkBack. When 
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the mobile Screen Reader is off, they will operate as they would traditionally 

operate in Android.  

Once you have signed into your Google account, you may search for applications 

using the "Search" function. If you have other Android devices, and have already 

purchased apps from the Play Store, open the Navigation drawer, and choose the 

"My Apps" option. By default, the Play Store displays only what is currently 

installed on this unit. Select the "All" button to show all apps you have purchased 

or downloaded.  

From an Apps list, press "Enter" to view the details of an app. If you wish to install 

it, locate the "Install" button and press "Enter". You are presented with a dialog 

showing the necessary app permissions. Locate the "Accept" button, or press the 

letter A to jump to it, and press "Enter". 

When apps are installed, they will appear in the "All Apps" list at the end of the 

main program menu. When Polaris MINI ships, this list contains stock Android 

apps and Google basics. The list is displayed in alphabetical order and can be 

navigated with first letter navigation. 

At the bottom of the Apps list is an "App Manager. The App Manager allows you 

to uninstall any native Android app on your Polaris MINI. You can also access the 

traditional Android Actions Menu for each app by pressing “Enter-I” when focused 

on the app you want to act on. 

When you install Android apps, you may begin to hear sounds and 

announcements related to these apps. Many apps send “Notifications” to your 
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Polaris MINI in realtime, just as happens on smartphones and tablets. Press 

“Space-1-2-3-4-5-6” from anywhere on the unit to see a list of these notifications. 

Press “Space-1” and “Space-4” to navigate the list, and press “Enter” on a 

notification to launch its associated application. Press “Space-D” to delete a 

notification from the list. * Note: Google does not allow the deletion of some 

notifications.  

 Note: While there are many native Android apps that work well, HIMS 

cannot and does not guarantee the accessibility or usability of any 

application that is not developed specifically for Polaris MINI. Apps should 

generally work well if they meet Google accessibility standards, however 

many apps are not made to meet these standards and are not easily usable 

on any Android device running a screen reader.  
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13. Using the Help Menu 

The help section consists of various text files that allow you to read about the 

many functions of the BrailleSense Polaris MINI. To access these help files, press 

"F1" to go to the "program" menu, and use "Space-4" repeatedly until you locate 

"Help". Or press the letter h to quickly jump to and open "Help". You can also 

launch "Help from anywhere on the unit using "F1-H".  

Use "Space-dot-4" to navigate to the section you wish to read. Press "Enter" on 

your desired section to open it. Keys for navigating are the same as those in the 

Word Processor. For a list of navigation keys, please see section 14.3.2.  

As you read the manual on the BrailleSense Polaris MINI, you can search for text 

in the various sections by pressing "Space-F". Type the text you wish to find, and 

press "Enter". You can find the next occurrence of the particular text you searched 

for by pressing "Enter-F".  

The section, "Help overview," gives a physical orientation to the BrailleSense 

Polaris MINI and an overview of its functionality.  

The section, "Basic Functions Help", gives a basic overview of the programming 

and operation of the BrailleSense Polaris MINI  

The section, "Settings Help" provides an explanation of time and date setup, 

internet Setup, Bluetooth connectivity, and the "Global Options" and how to use 

them to configure your BrailleSense Polaris MINI according to your preferences.  

Most of the remaining sections cover each of the functions of the BrailleSense 

Polaris MINI in detail.  
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The "Commands Summary" section is a quick reference of hot keys for all the 

programs on the BrailleSense Polaris MINI useful when you simply want to know 

the keystroke for performing an action without reading the entirety of the 

instructions on a given program. 

The "Information about the BrailleSense Polaris MINI" section provides the 

copyright and version of the BrailleSense Polaris MINI, as well as the operating 

system version, the version of the BrailleSense Polaris MINI firmware, and other 

useful items such as Mac address and Key number. When the "information" 

section is open, you can save the information about the BrailleSense Polaris MINI 

by pressing "tab (Space-4-5 or F3)", to navigate to the "Save" button and press 

"Enter". The unit displays "Successfully saved", and returns you to the "Save" 

button. The saved file is named "bs-information.txt", and is stored in "flashdisk" 

for easy access. 

You can also get help related to the specific task you are performing. Use "Space-

H" within any program to get a list of keystrokes available in that program. 
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14. Troubleshooting Guide 

If you are encountering problems with the BrailleSense Polaris MINI, please take 

a look at the following suggestions for solving many common problems:  

 

14.1 The BrailleSense Polaris MINI Will Not Turn On 

1) Check to make sure that the battery is inserted in to its compartment properly. 

2) If the battery is inserted properly, connect the AC adapter, and plug the AC 

adapter in to an electrical outlet. The battery may need to be charged. 

3) Or, Check the location of the keyboard lock switch. If this switch is placed in 

the "lock" position, the power switch is not functional. 

 

14.2 The Voice Cannot Be Heard 

1) Make sure the volume is loud enough to be heard. Press "backspace-F4" to 

raise the volume. 

2) Make sure the voice is turned on. Press "Backspace-F2" to toggle the voice 

on/off. 

 

14.3 The Voice is Too Fast to Understand 

1) Press "space-F1" to lower the voice rate. 
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14.4 The Voice Pitch Is Too Low or Too High to Understand 

1) Press "enter-F1" to lower the pitch, or press "enter-F4" to raise the pitch of the 

voice. 

 

14.5 You Don't Know Where You Are 

1) If you have become disoriented as to your location on the BrailleSense Polaris 

MINI, and cannot remember where you are, press "F1" to access the "program" 

menu. Then, press "F2-F3" to switch among the open programs. If you are in the 

Word Processor, pressing "space1-5-6" gives you your current location in the 

open document. 

 

14.6 No Internet Connection 

1) If you are using a Wi-Fi connection, ensure wireless is turned on. Use 

"Backspace-dots-1-4-5-6" to toggle wireless on/off.  

2) If using an Ethernet connection, check to ensure that the Ethernet cable is 

connected securely with the USB to Ethernet adapter, and that the network 

settings are correct.  

 

14.7 E-mail 

1) If you are having trouble downloading email, please contact your Internet 

service provider to make sure that you have the correct POP3/IMAP and SMTP 

settings. 
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2) If you cannot send or receive mail, make sure you have an active connection 

to the Internet. 

 

14.8 The Braille display Does Not Display Braille 

1) If the Braille display does not display Braille, make sure that the Braille display 

is turned on. Use "Backspace-F3" to toggle the Braille display on/off. 

14.9 The BrailleSense Polaris MINI Does Not Speak when 

using Play store or Android Apps 

If you do not have speech when you open the Play Store, or an Android app in 

your All Apps list, make sure the Mobile Screen Reader is on. You can toggle the 

mobile Screen Reader on and off by pressing the “Stop” and “Next” media buttons 

on the front panel of the unit.  

 

14.10 The BrailleSense Menus are Not Displayed or Spoken 

At times, you may receive a prompt to set the default launcher between Google 

Now and the Polaris MINI Launcher. If it is accidentally set to use the Google Now 

Launcher, the Polaris MINI menus are not displayed, and accessibility features 

are not activated. In this case, System notifications may still be heard, but no 

Braille will appear, and no speech is heard. 

To reset the Polaris MINI Launcher, press “F2-F3-1-2-3-4-5-6-7-8”.  
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14.11 The BrailleSense Polaris MINI Does Not Respond 

1. If the BrailleSense Polaris MINI does not respond to keystrokes or commands, 

it may be necessary to reset the unit. To reset the BrailleSense Polaris MINI, press 

"1-2-3-4-5-6-F2-F3."  

2) If the soft reset does not revive the BrailleSense Polaris MINI, you may need 

to completely shut down the unit. The easiest way to do this is to remove the 

battery, leave it out for a few seconds, re-insert it, and power on the unit.  

3) Initializing Polaris MINI Options: if you are not able to solve your problem with 

the above methods, you may need to reset your Polaris MINI options back to 

factory defaults. You can do this in two ways: if your unit is operational, you can 

launch the “Initialize Polaris MINI options” item in the “Settings” menu. You may 

also hold the Forward Media key while pressing the Power On Button. Continue 

to hold Forward until “HIMS” is displayed on the braille display. 

4: Hard resetting the Android system: In very serious cases, it may be necessary 

to perform a full system reset. However, this should not be attempted unless all 

other options have been exhausted, or unless you wish to completely erase all 

data, applications and settings. In addition, this process is complex and unique, 

and should only be done under the direction of an authorized support staff 

member. If you believe a system reset is necessary, please contact technical 

support for consultation and full instructions.  
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14.12 USB or SD Files Seem to Contain 0 Bytes 

The Android operating system requires that drives are ejected properly before 

removing them. If not done, inserting them in to the Polaris MINI or other devices 

may result in all files appearing as though they have no data, or have a size of 0 

bytes. Before disconnecting a USB drive or SD card, press “Backspace-Enter-U” 

or “Backspace-Enter-3-6” to unmount it properly. If your drive is showing files with 

no data, please re-insert it in to the Polaris MINI, and press the Unmount key. 
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15. Command Summary 

 

15.1 Common Combination Keys 

Open the main program menu: F1 

Open the Running Tasks list: F1-F4 

Switch to next running task: F2-F3 

Switch to previous running task: Space-F2-F3 

Open program specific menu: Space-m (dots 1-3-4) or F2 

Exit: Space-z (dots 1-3-5-6) 

Escape: Space-e (Space-1-5) or F4 

Move to the next control in a dialog box: Tab (Space-4-5 or F3) 

Move to the previous control in the dialog box: Shift-tab (Space-1-2 or Space-F3) 

Move to the previous character: Space-3 

Move to the next character: Space-6 

Move to the previous line/item: Space-1 

Move to the next line/item: Space-4 

Move to the beginning of line/item: Space-1-3  

Move to the end of line/item: Space-4-6  

Move to the top of a document or list: Space-1-2-3  

Move to the bottom of a document or list: Space-4-5-6  

Move to the previous page or to the first item of the previous 20-item group: 

Space-1-2-6 or F1-F2 

Move to the next page or to the first item of the next 20-item group: Space-3-4-5 

or F3-F4 
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Scroll back: Up scroll button 

Scroll forward: Down scroll button 

Move the cursor to a specific cell or list item: press the corresponding cursor 

routing key 

Find: Space-f (dots 1-2-4) 

Upper case: Space-u (dots 1-3-6) 

Repeat current item: Space-r (dots 1-2-3-5) 

Open web Page: Space-w (dots 2-4-5-6) 

Say current time: Space-t (dots 2-3-4-5) 

Display power status: Space-1-6 

Open "Global options": Space-o (dots 1-3-5) 

Online help: Space-h (dots 1-2-5) 

Check software version: Space-v (dots 1-2-3-6) only from Main menu 

Display network status: Space-n (dots 1-3-4-5) from Main menu 

Display flash disk empty space: Space-i (dots 2-4) from Main menu 

Voice on/off: Backspace-F2 

Braille on/off: Backspace-F3 

Increase voice volume: Backspace-F4 

Decrease the voice volume: Backspace-F1 

Increase the voice rate: Space-F4 

Decrease the voice rate: Space-F1 

Increase the voice pitch: Enter-F4 

Decrease the voice pitch: Enter-F1 

Increase the main volume: Backspace-Space-F4 
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Decrease the main volume: Backspace-Space-F1 

One-handed mode on/off: Backspace-1-2-3 

Bluetooth on/off: Backspace-3-4-5-6 

Wireless LAN on/off: Backspace-1-4-5-6 

Typing mode on/off: Backspace-Enter-c (dots 1-4) 

Change Braille Code: Backspace-Enter-b (dots 1-2) 

Scroll voice on/off: F3-up scroll button 

Eight dot mode on/off: F1-down scroll button 

Select Braille cursor type: F4-up scroll button 

Change TTS Voice: F3-V (dots-1-2-3-6) 

Select display of control information: F2-down scroll button 

Unmount USB or SD: Backspace-Enter-u (dots 1-3-6) or Backspace-Enter-3-6 

 

15.2 Quick Launch Commands 

Use the following commands to launch their associated applications from 

anywhere on the BrailleSense Polaris MINI. 

 

Use F1 in combination with each letter to launch the following applications: 

Address Manager: A (dot 1) 

Web Browser: B (dots 1-2) 

DAISY Player: D (dots 1-4-5) 

Email: E (dots 1-5) 

File Manager: F (dots 1-2-4) 

Help: H (dots 1-2-5) 



   209  

Media Player: M (dots 1-3-4)  

FM Radio: R (dots 1-2-3-5) 

Schedule Manager: S (dots 2-3-4) 

Word Processor: W (dots 2-4-5-6) 

Word Processor 2: Backspace-w (dots 2-4-5-6) 

Excel Viewer: X (dots 1-3-4-6) 

Online DAISY: Z (dots 1-3-5-6) 

 

Use F3 in combination with each letter to launch the applications below: 

Wake up alarm: A (dot 1) 

Bluetooth Manager: B (dots 1-2) 

Calculator: C (dots 1-4) 

Format: F (dots 1-2-4) 

Setup Internet: I (dots 2-4) 

Backup/Restore Personalized Settings: K (dots 1-3) 

Password Protection: N (dots 1-3-4-5) 

Terminal for Screen Reader: S (dots 2-3-4) 

Set Time & Date: T (dots 2-3-4-5) 

Upgrade BrailleSense: U (dots 1-3-6) 

Stopwatch: W (dots 2-4-5-6) 

 

Other Quick Commands: 

Display time and date: Space-t (dots 2-3-4-5) 

Display network status: Space-n (dots 1-3-4-5) 
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Display power status: Space-dots-1-6 

Display compass heading: Enter-dots 5-6 

Change device name: Backspace-Enter-e (dots 1-5) 

Open sleep Timer: Space-j (dots 2-4-5) 

Open Global Options: Space-o (dots 1-3-5) 

Open Sense Dictionary: Backspace-Enter-d (dots 1-4-5) 

 

15.3 File Manager 

15.3.1 Navigation Keys for the File and Menu List 

Move to previous item: Space-1 or up scroll button 

Move to next item: Space-4 or down scroll button 

Move to the beginning of the list: Space-1-2-3 or Space-1-3 

Move to the end of the list: Space-4-5-6 or Space-4-6 

 

15.3.2 Navigation Keys for the File List 

Jump to folder list or file list: Space-5-6 

Move between file list and address window: Tab (Space-4-5 or F3) / shift-tab 

(Space-1-2 or Space-F3) 

Enter selected folder or open selected file: Enter 

Move up one folder level: Backspace 

Jump to the top level of the disk: Space-1-2-5-6 

Move up 20 items: Space-1-2-3 or F1-F2 

Move down 20 items: Space-3-4-5 or F3-F4 
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15.3.3 Selection Commands 

Select individual item: Space 

Continuous selection: Enter-b (dots 1-2) 

Select all: Enter-a (dot 1) 

 

15.3.4 File Menu Commands 

Open: Enter-o (dots 1-3-5) 

Open with: Enter-e (dots 1-5) 

Open in Second Word Processor: Backspace-W (dots 2-4-5-6) 

Zip: Enter-z (dots 1-3-5-6) 

Unzip: Enter-u (dots 1-3-6) 

Send To: Enter-s (dots 2-3-4) 

Rename: Enter-r (dots 1-2-3-5) 

New document: Enter-n (dots 1-3-4-5) 

New folder: Enter-f (dots 1-2-4) 

File conversion: Enter-t (dots 2-3-4-5) 

Find file: Space-f (dots 1-2-4) 

Find Text: Backspace-f (dots 1-2-4) 

 Merge files: Enter-m (dots 1-3-4) 

Split files: Enter-p (dots 1-2-3-4) 

Information: Enter-i (dots 2-4) 

 

15.3.5 Edit Menu Commands 

Copy: Enter-c (dots 1-4) 
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Cut: Enter-x (dots 1-3-4-6) 

Paste: Enter-v (dots 1-2-3-6) 

Delete: Enter-d (dots 1-4-5) 

Select all: Enter-a (dot 1) 

 

15.3.6 View Menu Commands 

Sort files by: Enter-g (dots 1-2-4-5) 

Set file info: Enter-l (dots 1-2-3) 

Display only files of type: Enter-w (dots 2-4-5-6) 

Hide system folders: Enter-h (dots-1-2-5) 

 

15.4 Word Processor 

15.4.1 File Menu Commands 

New document: Enter-n (dots 1-3-4-5) 

Open: Enter-o (dots 1-3-5) 

New Word Processor: Backspace-n (dots-1-3-4-5) 

Save: Enter-s (dots 2-3-4) 

Save as: Space-s (dots 2-3-4) 

Close current document: Space-q (dots 1-2-3-4-5) 

Print: Space-p (dots 1-2-3-4) 

Settings: Enter-e (dots 1-5) 

Set File open method: Backspace-Enter-O (dots-1-3-5) 

Dictionary: Backspace-Enter-d (dots 1-4-5) 

Exit: Space-z (dots 1-3-5-6) 
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15.4.2 Edit Menu Commands 

Start selection: Enter-b (dots 1-2) 

Copy: Enter-c (dots 1-4)  

Add to the clipboard: Enter-p (dots 1-2-3-4) 

Clear clipboard: Enter-d (dots 1-4-5) 

Delete: Space-d (dots 1-4-5)  

Cut: Enter-x (dots 1-3-4-6)  

Paste: Enter-v (dots 1-2-3-6) 

Delete blank lines: Backspace-e (dots 1-5) 

Select all: Enter-a (dot 1) 

Check spelling: Enter-k (dots 1-3) 

Check spelling of the current word: Backspace-k (dots 1-3) 

 

15.4.3 Insert Menu Commands 

Set Mark: Enter-m (dots 1-3-4)  

Jump to mark: Enter-j (dots 2-4-5) 

Delete Mark: Backspace-d (dots 1-4-5) 

Insert from file: Enter-i (dots 2-4) 

Insert date: Enter-w (dots 2-4-5-6) 

Insert time: Backspace-w (dots 2-4-5-6) 

 

15.4.4 Go To Commands 

Find: Space-f (dots 1-2-4)  
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Find next: Enter-f (dots 1-2-4) 

Find previous: Backspace-f (dots-1-2-4) 

Find and Replace: Enter-r (dots 1-2-3-5)  

Go to location: Enter-l (dots 1-2-3) 

Go To Previous Sentence: Space-2-3-6 

Go To Next Sentence: Space-3-5-6 

Go to previous page: Space-1-2-6 or F1-F2 

Go to next page: Space-3-4-5 or F3-F4 

Go to previous document: Tab (Space-1-2 or Space-F3) 

Go to next document: Shift-tab (Space-4-5 or F3) 

  

15.4.5 Read Commands 

Read selected text: Backspace-b (dots 1-2)  

Read beginning of selected text: Enter-u (dots 1-3-6) 

Read from beginning to cursor: Backspace-g (dots 1-2-4-5) 

Read from cursor to end: Enter-g (dots 1-2-4-5) 

Auto scroll: up-down scroll buttons 

Read current paragraph: Space-2-3-5-6 

Read Current Sentence: Space-1-4-5-6 

Read current line: Space-1-4 

Read current word: Space-2-5 

Read current character: Space-3-6 

Read status: Space-3-4 

Read current cursor position: Space-1-5-6) 
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Read character and space count: Enter-3-4 

Read Font info: Backspace-Enter-N (dots-1-3-4-5) 

 

15.4.6 Layout Commands 

Set font: Enter-backspace-f (dots 1-2-4) 

Braille document layout: Backspace-p (dots 1-2-3-4) 

Braille paragraph layout: Backspace-1-2-4-6 

Print document layout: Backspace-t (dots 2-3-4-5) 

Print paragraph layout: Backspace-2-3-4-6 

 

15.4.7 Miscellaneous Hot Keys 

Move forward by double Enter: Space-Enter-5-6 

Move back by Double Enter: Backspace-Space-2-3 

Delete current paragraph: Backspace-2-3-5-6 

Delete current line: Backspace-1-4 

Delete current word: Backspace-2-5 

Delete current character: Space-d (dots 1-4-5) 

Set view format characters: Space-1-4-6 

Set reading unit: Space-2-4-6 

Set read only: Space-3-4-6 

Move back one slide in PPT: Backspace 

Move forward one slide in PPT: Space 

Go to Slide: Enter-L (dots-1-2-3) 

Insert page break: Backspace-space-Enter-p (dots 1-2-3-4) 
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Insert tab: Backspace-Space-Enter-I (dots 2-4) 

Center line: Backspace-Space-Enter-c (dots 1-4) 

Toggle Math Mode on/off: Backspace-m (dots 1-3-4)  

 

15.5 E-mail 

15.5.1 Hot Keys for the Inbox 

Open "Accounts Manager”: Enter-m (dots 1-3-4) 

Switch from Offline to Online mode (IMAP): Enter-dots1-2-3 

Check for new mail: Enter-n (dots 1-3-4-5) 

Receive old mail (IMAP): Backspace-p (dots1-2-3-4) 

Move to previous account: Backspace-dots 1-2-6 

Move to next account: Backspace-dots 3-4-5 

Move to previous mailbox: Enter-dots 1-2-6 

Move to next mailbox: Enter-dots 3-4-5 

Write new message: Enter-w (dots 2-4-5-6) 

Reply: Enter-r (dots 1-2-3-5) 

Reply all: Backspace-r (dots 1-2-3-5) 

Forward: Enter-f (dots 1-2-4) 

Forward as attachment: Backspace-w (dots 2-4-5-6) 

Open Set Path: Enter-p (dots 1-2-3-4) 

Open Set Options: Enter-o (dots 1-3-5) 

Open Set Spam: Enter-e (dots 1-5) 

Find: Space-f (dots 1-2-4) 

Find again: Backspace-f (dots 1-2-4) 
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Move to unread message: Enter-u (dots 1-3-4) 

Move to mailbox: Backspace-x (dots 1-3-4-6) 

Copy to mailbox: Backspace-c (dots 1-4) 

Add a sender to the address list: Enter-i (dots 2-4) (This is valid only at the "from" 

item of the "inbox") 

Delete current message: Space-d (dots 1-4-5) (valid only from the Subject and 

Date fields of the Inbox. 

Empty Trash: Enter-Backspace-q (dots 1-2-3-4-5) 

Save current message as text file: Space-s (dots 2-3-4) 

Print e-mail: Space-p (dots 1-2-3-4) 

Cancel: Space-e (dots 1-5) 

Cancel and exit e-mail program: Space-z (dots 1-3-5-6) 

 

15.5.2 Hot keys for Sending E-mail 

 Search address list: Enter-l (dots 1-2-3) 

Attach file: Enter-f (dots 1-2-4) 

Send e-mail: Enter-s (dots 2-3-4) 

Save to Outbox: Space-s (dots 2-3-4) 

Cancel: Space-e (dots 1-5) 

Cancel and exit e-mail program: Space-z (dots 1-3-5-6) 

 

15.5.3 Hot Keys for Reading/Writing an E-mail Message 

Start selection: Enter-b (dots 1-2) 

Select all: Enter-a (dot 1) 
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Copy to the clipboard: Enter-c (dots 1-4) 

Cut to the clipboard: Enter-x (dots 1-3-4-6) (Only available when writing a 

message) 

Paste from the clipboard: Enter-v (dots 1-2-3-6) (only available when writing a 

message) 

Delete selection/delete current character: Space-d (dots 1-4-5)  

Cancel selection: Space-e (dots 1-5) 

 

15.6 Media  

15.6.1 Media Player 

 

15.6.1.1 File Commands 

Open file: Enter-o (dots 1-3-5) 

Open folder: Enter-f (dots 1-2-4) 

Add file: Backspace-o (dots 1-3-5) 

Add folder: Backspace-f (dots 1-2-4) 

Save playlist: Enter-i (dots 2-4) 

Save as playlist: Space-s (dots 2-3-4) 

Delete item: Space-d (dots 1-4-5) 

Open URL: Enter-u (dots 1-3-6) 

Get tag information: Enter-t (dots 2-3-4-5) 

 

15.6.1.2 Playback Commands 

Play: Enter, Play button 

Pause/play: Space, Play button 
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Stop: Backspace, Stop button 

Previous track: Dot 3, Previous button 

Next track: Dot 6, Next button 

Back 5 tracks: Dots 2-3 

Forward 5 tracks: Dots 5-6 

First track: Dots 1-3 

Last track: Dots 4-6 

Volume up: Space-Up Scroll button 

Volume down: Space-Down Scroll button 

Speed up: Dots 3-4-5 

Slow down: Dots 1-2-6 

Change time index: Dot 2 or Dot 5 

Move to next position by time index: Dot 4 

Move to previous position by time index: Dot 1 

Delete playlist: Space-d (dots 1-4-5) 

Set marked position: Enter-m (dots 1-3-4) 

Delete marked position: Enter-d (dots 1-4-5) 

Jump to marked position: Enter-j (dots 2-4-5) 

Go to position: Enter-g (dots 1-2-4-5) 

Set mark: Backspace-m (dots 1-3-4) 

Move to mark: Backspace-j (dots 2-4-5) 

Move to previous mark: Backspace-dot 3 

Move to next mark: Backspace-dot 6 

Delete mark: Backspace-d (dots 1-4-5) 
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Mark manager: Backspace-k (dots 1-3) 

Configuration dialog: Backspace-c (dots 1-4) 

Playback settings dialog: Enter-s (dots 2-3-4) 

Record settings dialog: Backspace-s (dots 2-3-4) 

Effect settings dialog: Enter-e (dots 1-5) 

 

15.6.1.3 Recording Commands 

Open the Record dialog: Enter-r (dots 1-2-3-5), Record button 

Record: Record button 

Pause/Continue recording: Space, Record button 

Play: Play button 

 

15.6.1.4 Hot Keys in the Play Information Tab 

Move to the next item: Space-dot-4 

Move to the previous item: Space-dot-1 

Open menu: F2 or Space-m (dots 1-3-4) 

Open help: Space-h (dots 1-2-5) 

Move to Playlist tab: Space-4-5/Space-1-2 

Exit Media Player: Space-z (dots 1-3-5-6) 

 

15.6.1.5 Hot Keys in the Playlist Tab 

Move to the next file: Space-4 

Move to the previous file: Space-1 

Move to the last file: Space-4-6 
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Move to the first file: Space-1-3 

Play current file: Space 

Start file selection: Enter-b (dots 1-2) 

Start playing the selected files: Enter 

Stop playing: Backspace 

Delete the selected files from the playlist: Space-d (dots 1-4-5) 

Move to "playback information" tab: Space-4-5/Space-1-2 

 

15.6.2 FM Radio 

Open the Presets dialog: Enter-e (dots 1-5) 

Open the menu: Space-m (dots 1-3-4) or F2 

Internal speakers on/off: Space-x (dots 1-3-4-6)  

Move to next frequency: Dot 6 

Move to previous frequency: Dot 3 

Autoscan backward: Dot 2, short press Previous button 

Autoscan forward: Dot 5, short press Next button  

Go to frequency: Space-f (dots 1-2-4) 

Move to previous preset: Dot 1, long press Previous button  

Move to next preset: Dot 4, long press Next button 

Save preset: Enter-s (dots 2-3-4) or long press Record button 

Delete preset: Space-d (dots 1-4-5) or long press Stop button 

Open Record dialog: Enter-r (dots 1-2-3-5) 

Record pause/resume: short press Record button 

Stop recording: short press Stop button 
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Mute on: short press Stop button, Space 

Mute off: short press Play button, Space 

Volume up: Space-Up Scroll button 

Volume down: Space-Down Scroll button 

 

15.6.3 DAISY Player 

Read title: Space-dots 1-2-5-6 

Open DAISY book: Enter-o (dots 1-3-5) 

Voice settings: Enter-s (dots 2-3-4) 

Check book-info: Enter-i (dots 2-4) 

Exit: Space-z (dots 1-3-5-6) 

Play/Pause: Space 

Go to beginning: Space-1-3 or Space-1-2-3 

Go to end: Space-4-6 or Space-4-5-6 

Increase volume: Backspace-dot-4 

Decrease Volume: Backspace-dot-1 

Increase Speed: Backspace-dot-5 

Decrease Speed: Backspace-dot-2 

Increase Pitch: Backspace-dot-6 

Decrease Pitch: Backspace-dot-3 

Move to the next page: Space-3-4-5 

Move to the previous page: Space-1-2-6 

Go to page: Enter-g (dots 1-2-4-5) 

Select previous text/time unit: Dot 1 
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Select next text/time unit: Dot 4 

Move to previous text/time unit: Dot 2 

Move to next text/time unit: Dot 5 

Select previous movement unit: Dots 2-3 

Select next movement unit: Dots 5-6 

Move to the previous unit: Dot 3 or short press Previous button 

Move to the next unit: Dot 6 or short press Next button 

Move to the next heading: Space-5 or long press Next button 

Move to the previous heading: Space-2 or long press Previous button 

Move to the last heading: Space-4-6 

Move to the first heading: Space-1-3 

Check the current-reading level and heading: Enter-w (dots 2-4-5-6) 

Scan the heading list from the present to the end: Enter-n (dots 1-3-4-5) 

Find heading: Space-f (dots 1-2-4) 

Headings list: Enter-h (dots 1-2-5) 

Find again: Enter-f (dots 1-2-4) 

Set mark at current position: Enter-m (dots 1-3-4) 

Move to the next mark: Space-dot 6 

Move to the previous mark: Space-dot 3 

Delete mark: Space-d (dots 1-4-5) 

Create memo: Backspace-m (dots-1-3-4) 

Read memo: Backspace-r (dots-1-2-3-5) 

Read previous memo: Backspace-p (dots-1-2-3-4) 

Read Next Memo: Backspace-n (dots-1-3-4-5) 
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Delete Memo: Backspace-d (dots-1-4-5) 

Exit and erase position without prompt: Enter-z (dots-1-3-5-6) 

Exit and erase marks without prompt: Backspace-z (dots-1-3-5-6) 

 

15.7 Organizer 

15.7.1 Address Manager 

 

15.7.1.1 Navigation When Adding an Address 

Move to the previous field or menu item: Space-1 or Up Scroll button 

Move to the next field or menu item: Space-4 or Down Scroll button 

Move to the first field or menu item: Space-1-2-3 

Move to the last field or menu item: Space-4-5-6 

 

15.7.1.2 Navigation in Search Results List 

Move to the previous record: Space-1 or Up Scroll button 

Move to the next record: Space-4 or Down Scroll button 

Move to the first record: Space-1-2-3 

Move to the last record: Space-4-5-6 

Move to Record information: F3 

 

15.7.1.3 General Commands 

Add address: Enter-i (dots 2-4) 

Find address: Enter-s (dots 2-3-4) 

Edit address: Enter-m (dots1-3-4) 

Delete address: Space-d (dots 1-4-5) 
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Select all: Enter-a (dot 1) 

Save as a file: Enter-t (dots 2-3-4-5) 

Print address: Space-p (dots 1-2-3-4) 

Backup address list: Enter-u (dots 1-3-6) 

Restore address list: Enter-r (dots 1-2-3-5) 

Set backup options: Enter-e (dots 1-5) 

Setting add/searching address fields: Enter-o (dots 1-3-5) 

Import from CSV: Backspace-i (dots 2-4) 

Export to CSV: Backspace-x (dots 1-3-4-6) 

 

15.7.2 Schedule Manager 

 

15.7.2.1 General Commands 

Move to the next field: Space-4-5 or F3 

Move to the previous field: Space-1-2 or Space-F3 

Add appointment: Enter-i (dots 2-4) 

Search appointments: Enter-s (dots 2-3-4) 

Modify appointment: Enter-m (dots 1-3-4) 

Delete appointment: Space-d (dots 1-4-5) 

Delete all appointments: Backspace-Enter-q (dots1-2-3-4-5) 

Backup appointments: Enter-u (dots 1-3-6) 

Restore appointments: Enter-r (dots 1-2-3-5) 

Set backup options: Enter-e (dots 1-5) 

Alarm options: Enter-o (dots 1-3-5) 
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Save appointments as file: Enter-t (dots 2-3-4-5) 

Print appointments: Space-p (dots 1-2-3-4) 

 

15.7.2.2 Navigating Search Results 

Move to the previous appointment: Space-2 

Move to the next appointment: Space-5 

Move to the first appointment: Space-2-3 or Space-1-2-3 

Move to the last appointment: Space-5-6 or Space-4-5-6 

Move to the previous appointment on the same day: Space-1 or Up Scroll button 

Move to the next appointment on the same day: Space-4 or Down Scroll button 

Move to the first appointment on the same day: Space-1-3 

Move to the last appointment on the same day: Space-4-6 

 

15.8 Web tools 

15.8.1 Web Browser 

 

15.8.1.1 General Commands 

Open URL: Enter-u (dots 1-3-6) 

Open: Enter-o (dots 1-3-5) 

Save as: Space-s (dots 2-3-4) 

Information: Enter-i (dots 2-4) 

File Download Dialog: Backspace-3-4 

Exit: Space-z (dots 1-3-5-6) 

Read from beginning to cursor: Backspace-g (dots 1-2-4-5) 

Read from cursor to end: Enter-g (dots 1-2-4-5) 
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Auto scroll: Up Scroll button-Down Scroll button 

Start selection: Enter-b (dots 1-2) 

Copy: Enter-c (dots 1-4) 

Add to clipboard: Enter-p (dots 1-2-3-4) 

Copy URL: Backspace-d (dots 1-4-5) 

Copy link: Backspace-l (dots 1-2-3) 

Go to home page: Backspace-h (dots 1-2-5) 

Go to previous page: Backspace-Space-3 or Backspace-p (dots 1-2-3-4) 

Go to next page: Backspace-Space-6 or Backspace-n (dots 1-3-4-5) 

Go to previous heading: Backspace-b (dots 1-2) 

Go to next heading: Backspace-f (dots 1-2-4) 

Go to previous text chunk: Space-2-4-6 

Go to next text chunk: Space-1-2-4-5-6 

Go to previous visited link: Space-2-3-6 

Go to next visited link: Space-3-5-6 

Refresh: Enter-r (dots 1-2-3-5) 

Open the history list: Enter-h (dots 1-2-5) 

Check the address of the selected title in the history list: Space-i (dots 2-4) 

Find: Space-f (dots 1-2-4) 

Find again: Enter-f (dots 1-2-4) 

Links list: Backspace-i (dots 2-4) 

RSS Feed List: Enter-j (dots 2-4-5) 

Set current as your home page: Enter-s (dots 2-3-4) 

Add to favorites: Backspace-a (dot 1) 
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Favorites list: Enter-l (dots 1-2-3) 

Option settings: Backspace-o (dots 1-3-5) 

 

15.8.1.2 Hot Keys When Playing Audio Files in Web Browser 

Turn up the volume: Space-Up Scroll button 

Turn down the volume: Space-Down Scroll button 

Play: Play button on the front panel 

Stop: Stop button on the front panel 

 

15.8.1.3 Hot Keys for Reading Web Pages 

Move to the previous control: Shift-tab (Space-1-2) 

Move to the next control: Tab (Space-4-5) 

Select the next item in a combo box (list box): Backspace-Space-4 

Select the previous item in a combo box (list box): Backspace-Space-1 

Move to previous form control: Space-1-2-3-4-6 

Move to next form control: Space-1-3-4-5-6 

Move to previous table: Space-3-4-5-6 

Move to next table: Space-1-4-5-6 

Move to previous cell: Space-2-3 

Move to next cell: Space-5-6 

Move to upper cell: Space-3-5 

Move to lower cell: Space-2-6 

Read current cell: Space-2-3-5-6 

Move to previous cell of upper level table: Backspace-2-3 
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Move to next cell of upper level table: Backspace-5-6 

Move to upper cell of upper level table: Backspace-3-5 

Move to lower cell of upper level table: Backspace-2-6 

Check current position: Space-1-5-6 

Move to previous frame: Space-3-4-6 

Move to next frame: Space-1-4-6 

Read current line: Space-r (dots 1-2-3-5) 

 

15.9 Extras 

15.9.1 Excel Viewer 
 

15.9.1.1 Navigation Commands 

Move to next row: Space-Dot 4 

Move to previous row: Space-Dot 1 

Move to next column: Space-Dot 6 

Move to previous column: Space-Dot 3 

Move to beginning of row: Space-Dots 1-3 

Move to end of row: Space-Dots 4-6 

Move to top of column: Space-Dots 2-3 

Move to bottom of column: Space-Dots 5-6 

Move to top of worksheet: Space-1-2-3 

Move to bottom of worksheet: Space-4-5-6 

Move to next worksheet: Space-3-4-5 

Move to previous worksheet: Space-1-2-6 
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Move to next group: Backspace-Dots 5-6 

Move to previous group: Backspace-Dots 2-3 

Move to next group in row: Space-Dot 5 

Move to previous group in row: Space-Dot 2 

Move to next group in column: Space-Dots 5-6 

Move to previous group in column: Space-Dots 2-3 

 

15.9.1.2 File Commands 

Open: Enter-o (dots 1-3-5) 

Open Hyperlink: Enter-h (dots 1-2-5) 

Set User table: Enter-t (dots 2-3-4-5) 

Cell properties: Enter-i (dots 2-4) 

Quick Setup: Enter-x (dots 1-3-4-6) 

Save as: Space-s (dots 2-3-4) 

 

15.9.1.3 Go To Commands 

Find: Space-f (dots 1-2-4) 

Find Next: Enter-f (dots 1-2-4) 

Find Previous: Backspace-f (dots 1-2-4) 

Move to cell: Enter-j (dots 2-4-5) 

Next sheet: Space-3-4-5 

Previous sheet: Space-1-2-6 

Sheet list: Enter-l (dots 1-2-3) 

Set Mark: Backspace-m (dots 1-3-4) 
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Go to Mark: Backspace-j (dots 2-4-5) 

Delete Mark: Backspace-d (dots 1-4-5) 

 

15.9.1.4 Read Commands 

Set Options: Backspace-o (dots 1-3-5) 

Sheet title: Space-1-5-6 

Read from top of column to cursor: Backspace-Dot 1 

Read from cursor to bottom of column: Backspace-Dot 4 

Read from beginning of row to cursor: Backspace-Dot 3 

Read from cursor to end of row: Backspace-Dot 6 

Read current row: Space-c (dots 1-4) 

Read current column: Space-y (dots 1-3-4-5-6) 

Read header cell of row: Backspace-c (dots 1-4) 

Read header cell of column: Backspace-y (dots 1-3-4-5-6) 

Read from beginning to cursor: Backspace-g (dots1-2-4-5) 

Read from cursor to end: Enter-g (dots 1-2-4-5) 

Read One character (When in Cell Activation): Space-Dots 3-6 

Read Current Cell: Space-Dots 3-6 

Read File Name: Space-Dots 3-4 

Read Selected Text: Backspace-b (dots 1-2) 

 

15.9.1.5 View Commands 

View Hide Sheet: Enter-s (dots 2-3-4) 

View Hide Row: Enter-r (dots 1-2-3-5) 
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View Hide Column: Enter-y (dots 1-3-4-5-6) 

Cell Activation: Enter  

Activation Cancel: Backspace 

Set Time and Date: Enter-d (dots 1-4-5) 

 

15.9.1.6 Edit Commands 

Start Selection: Enter-b (dots 1-2) 

Select All: Enter-a (dot 1) 

Copy Selected Text: Enter-c (dots 1-4) 

 

15.9.2 Online DAISY 

Move between category and booklist: F3 and Space-F3 

Move among list items: Space-1 and Space-4 

Download book: Enter 

Return book: Enter-r (dots 1-2-3-5) 

 

15.10 Utilities 

15.10.1 Calculator 

Clear calculator: Backspace-c (dots 1-4) 

Delete numbers or operators: Backspace 

Calculation history: Enter-h (dots 1-2-5) 

General functions: Enter-g (dots 1-2-4-5) 

PI: Enter-p (dots 1-2-3-4) 

Exp: Enter-e (dots 1-5) 

Trigonometric Functions: Enter-s (dots 2-3-4) 
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Sine: Enter-s (dots 2-3-4), s (dots 2-3-4) 

Arc Sine: Enter-s (dots 2-3-4), a (dot 1) 

Hyperbolic Sine: Enter-s (dots 2-3-4), h (dots 1-2-5) 

Cosine: Enter-i (dots 2-4), i (dots 2-4) 

Arc Cosine: Enter-c (dots 1-4), a (dot 1) 

Hyperbolic Cosine: Enter-c (dots 1-4), h (dots 1-2-5) 

Tangent: Enter-t (dots 2-3-4-5), t (dots 2-3-4-5) 

Arc Tangent: Enter-t (dots 2-3-4-5), a (dot 1) 

Hyperbolic Tangent: Enter-t (dots 2-3-4-5), h (dots 1-2-5) 

Logarithm Function: Enter-l (dots 1-2-3) 

Natural Logarithm: Enter-l (dots 1-2-3), e (dots 1-5) 

Common Logarithm: Enter-l (dots 1-2-3), n (dots 1-3-4-5) 

Recall Items: Backspace-r (dots 1-2-3-5) 

Delete all saved items: Enter-d (dots 1-4-5) 

Save Items: Backspace-s (dots 2-3-4) 

Convert Unit: Enter-u (dots 1-3-6) 

Copy to Clipboard: Enter-c (dots 1-4) 

Option Settings: Enter-o (dots 1-3-5) 

Fraction options: Space-dots 3-4 

Return formula: Enter-r (dots1-2-3-5) 

Change Braille code: Space-g (dots1-2-4-5) 

 

15.10.2 Display Compass Heading 

Open Display Compass Heading: Space-F3-F4 
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Move to the next control: Space-4-5 or F3 

Move to the previous control: Space-1-2 or Space-F3 

Change compass display type: Backspace or Space 

Exit: Space-z (dots 1-3-5-6) or Space-e (dots 1-5) 

 

15.10.3 Stopwatch 

Stopwatch start, pause, restart: Enter 

Check the elapsed time: Backspace 

Stop and restart Braille display: Space-F2 

Switch between stopwatch and countdown timer: Space-4-5 or Space-1-2 

Count down timer pause or restart: Enter 

Count down timer Initialize: Backspace 

Exit stopwatch or countdown timer: Space-z (dots 1-3-5-6) 

 

15.10.4 Terminal for Screen Reader 

Enter terminal Clipboard: Space-Enter-i (dots 2-4)  

Send Terminal Clipboard content: Enter-s (dots 2-3-4)  

Exit terminal for Screen reader: Space-Backspace-z (dots 1-3-5-6)  

 

15.11 Settings 

15.11.1 Setting Time and Date 

Move to the next day: Space-6 

Move to the previous day: Space-3 

Move to the next week: Space-5 

Move to the previous week: Space-2 
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Move to the next month: Space-4 

Move to the previous month: Space-1 

Move to the next year: Space-5-6 

Move to the previous year: Space-2-3 

Move to 1 hour after: Space-4 

Move to 1 hour before: Space-1 

Move to 10 minutes after: Space-5 

Move to 10 minutes before: Space-2 

Move to 1 minute after: Space-6 

Move to 1 minute before: Space-3 

Switch between A.M. and P.M.: Space-x (dots 1-3-4-6) 

 

15.11.2 Bluetooth Manager 

Rescan for Bluetooth devices: Enter-r (dots 1-2-3-5) 

Connect device: enter on the device name 

Connect service: enter on the service name 

Disconnect the service in Bluetooth service list: Enter-d (dots 1-4-5) 

Move to Bluetooth device list in service list: Backspace 

Remove device settings in Bluetooth device list: Space-d (dots 1-4-5) 

 

15.11.3 Backup/Restore Personalized Settings 

Move to previous item: Space-1 or up scroll button 

Move to next item: Space-4 or down scroll button 

Move to previous control: Shift-tab (Space-1-2 or Space-F3) 
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Move to next control: Tab (Space-4-5 or F3) 

Select/unselect check box: Space 

Backup: Enter-b (dots 1-2) 

Restore: Enter-r (dots1-2-3-5) 

 

15.11.4 Password Protection. 

Set password: Enter-i (dots 2-4) 

Modify password: Enter-m (dots 1-3-4) 

Password configuration: Enter-c (dots 1-4) 

Reset to factory defaults: i (dots 2-4) 

 

15.12 Screen Reader Commands 

15.12.1 Moving Focus 

Move to next object: Space-4-5 or F3 

Move to previous object: Space-1-2 or Space-F3 

Move to top of screen: Space-1-2-3 

Move to bottom of screen: Space-4-5-6 

Scroll down one screen: Space-3-4-5 

Scroll up one screen: Space-1-2-6 

Execute current item: Enter or Cursor routing key 

Back button: Space-e, F4 or Space-Z 

Move to specific object: press first letter of object name 

Go to Home screen: F1 

Activate App Actions Menu: Enter-I on focused app 
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Open Notification Shade: Space-1-2-3-4-5-6 

Activate Notification: Enter 

Delete notification: Space-D (dots-1-4-5) 

Activate Edit Box: Enter 

Increase Slider Value: Backspace-Space-4 

Decrease Slider Value: Backspace-Space-1 

Reset Polaris MINI Launcher: F2-F3-1-2-3-4-5-6-7-8 

Change object navigation method: Backspace-Enter-H (dots-1-2-5) 

 

15.12.2 When Editing Text 

Go to next character: Space-6 

Go to previous character: Space-3 

Go to next word: Space-5 

Go to previous word: Space-2 

Go to next line: Space-4 

Go to previous line: Space-1 

Go to next paragraph: Space-5-6 

Go to previous paragraph: Space-2-3 

Go to beginning of paragraph: Space-1-3 

Go to end of paragraph: Space-4-6 

Go to top of document: Space-1-2-3 

Go to bottom of document: Space-4-5-6 

Delete current character: Space-1-4-5 

Delete previous character: Backspace 
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Delete current word: Backspace-2-5 

Delete current line: Backspace-1-4 

Delete current paragraph: Backspace-2-3-5-6 

Move to next display length: Down Scroll 

Move to previous display length: Up Scroll 

 

15.12.3 Media Key Functions when in "App Mode" 

Open Main menu: Stop button 

Recent Apps: Play button 

Back: Record button 

Move to previous object: Previous button 

Move to next object, Next button 

Mobile Screen Reader on-off: Stop and Next buttons 

Call Google Voice Assistant: Record and Play buttons 


